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Preface

Revised: April 2014

This preface describes the purpose, audience, organization, and conventions of the Cisco WebEx
Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29 and provides
information about new features and how to obtain related documentation.

This preface describes the following topics:
e General Description, page 1
¢ Audience and Scope, page 1
e (Cisco WebEx Features and Important Notes, page 2
e Prerequisites, page 4
e Document Organization, page 5
e Related Documents, page 6

e Obtaining Documentation and Submitting a Service Request, page 7

General Description

This document describes how to configure Cisco TelePresence applications for

Cisco WebEx-to-Cisco Telepresence interoperability. The Cisco WebEx Enabled TelePresence
Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29 describes how to manage and
monitor scheduled meeting interoperability between Cisco TelePresence System (CTS), Cisco
TelePresence Server or MCU multipoint meetings, Cisco TMS, Cisco Unified Communications
Manager (Cisco Unified CM), Cisco Video Communication Server (VCS) and the Cisco WebEx
Meeting Center.

Audience and Scope

The Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center
WBS29 is directed to administrators who will be configuring the TelePresence Server, MCU, Cisco TMS,
Cisco VCS and/or the Cisco Unified CM to use Cisco WebEx features in Cisco TelePresence meetings.

[ oL-21352-02
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Cisco WebEx Features and Important Notes

This section contains the following feature information:
e Supported Features, page 2

e Feature Limitations, page 3

Supported Features

Cisco WebEx Enabled TelePresence provides the following key features:

e Two-way video sharing with up to 720p screen resolution between the WebEx client and
TelePresence endpoints

e Integrated audio and presentation sharing — including application and desktop content sharing
capability for all users in a meeting

¢ Integrated meeting scheduling using TelePresence Management Suite (Cisco TMS), which allows
you to easily schedule Cisco WebEx Enabled TelePresence meetings

e Secure call control and connectivity enabled by media encryption provided by Cisco VCS
Expressway

¢ Interoperability with third-party telepresence endpoints
Table 1 lists Cisco WebEx Enabled TelePresence features.

Table 1 Cisco WebEx Enabled TelePresence Features

Supported Feature  |Description

Audio CTS participants have two-way audio with the Cisco WebEx meeting participants using G.711.

Note  No presentation audio is sent from the Cisco WebEx side.

Host All Cisco TelePresence participants and the meeting organizer can be the default hosts. The
MCU/TelePresence Server dials in at the meeting start time automatically to connect all TelePresence
participants. The MCU/TelePresence Server becomes the host if the meeting organizer has not joined
on WebEx yet. If the meeting organizer joins the meeting before the scheduled start time, they become
the host.

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
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Table 1 Cisco WebEx Enabled TelePresence Features

Supported Feature  |Description

Scheduling Use Cisco TMS, the WebEx and TelePresence Integration to Outlook, Smart Scheduler, or WebEx
Scheduling Mailbox to schedule a Cisco TelePresence meeting with WebEx. Start your meeting either
using One-Button-to-Push (OBTP) from scheduled Cisco TelePresence endpoints or using the
Automatic Connect feature of Cisco TMS to connect all scheduled endpoints at the start time of your
meeting.

You can start the WebEx portion of a Cisco WebEx Enabled TelePresence meeting earlier than the
scheduled time if you are the WebEx host. WebEx participants who try to join the WebEx meeting
before the host, receive a message that the meeting has not started and they must wait to join until the
scheduled start time or until after the WebEx host joins.

Note  Only scheduled meetings are supported for Cisco WebEx Enabled TelePresence
Interoperability; non-scheduled TelePresence participants who want to join a Cisco WebEx
enabled TelePresence meeting, must manually dial into the conference (MCU/TelePresence
Server) bridge. The meeting organizer can reserve ports for video dial-in participants when
scheduling the meeting.

See the Cisco TelePresence Management Suite Administrator Guide for meeting scheduling
information.

Sharing Cisco TelePresence users can share a presentation by connecting the video display cable of the
TelePresence endpoint to their computer. Supported video display interfaces include VGA, DVI,
HDMI, DisplayPort and Mini DisplayPort.

Cisco WebEx Meeting Center clients can share the desktop or a selected application. Endpoints view
and share Cisco WebEx presentation at 1024 x 768 (XGA) resolution.

The resolution that endpoints are capable of sending may vary depending on the endpoint model, but
the TelePresence Server/MCU will transcode the presentation and send it to the WebEx cloud at
1024x768 resolution.

Note The Cisco TelePresence user that is sharing with the video display cable must exit the
Cisco WebEx Meeting Center client on their laptop before connecting the video display cable.
If they do not, a window cascading effect can occur. For more information, refer to Chapter 12,
“Managing the Cisco WebEx Video View Window”.

Two-way Video Video quality is sent best effort from the Cisco TelePresence endpoint to Cisco WebEx and from
Cisco WebEx to the Cisco TelePresence endpoint.

The video from the CTS participants in the meeting are forwarded to the Cisco WebEx network, where
they will be seen by Cisco WebEx participants along with other Cisco WebEx participants. Live video
can be sent at minimum in Common Intermediate Format (CIF) format at 30 frames per second, at
approximately 300-450 kbps up to a maximum of 720p.

Presentations from the Cisco WebEx client are displayed on the local CTS projector, presentation
display or with Presentation-in-Picture (PiP), depending on the capabilities of your CTS.

Note  All Cisco WebEx-enabled TelePresence meetings require the use of a Cisco TelePresence
Server or MCU.

Feature Limitations

For a complete list of limitations and known issues for Cisco WebEx Enabled TelePresence, refer to the
Cisco WebEx Enabled TelePresence release notes.

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
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Prerequisites

Table 2 lists Cisco WebEx Enabled TelePresence feature prerequisites.

Table 2 Cisco WebEx with the Cisco TelePresence System Prerequisites

Requirement Description

Cisco TelePresence Management |Cisco TMS is required for scheduling Cisco WebEx Enabled TelePresence meetings.

Suite (Cisco TMS) Release 14.3.1 or later is required. (Release 14.3 or later is also required for support of

TSP audio with Cisco TelePresence Server.)

Cisco TelePresence Management |Cisco TMSXE is required for scheduling Cisco WebEx Enabled TelePresence meetings
Suite Extension for Microsoft through Microsoft Outlook using either the WebEx Productivity Tools Plug-in or WebEx
Exchange (Cisco TMSXE) Scheduling Mailbox Scheduling.

Release 3.1 or later is required.

Cisco TelePresence Management |Cisco TMSPE is required for scheduling Cisco WebEx Enabled TelePresence meetings
Suite Provisioning Extension using Smart Scheduler.

(Cisco TMSPE) Release 1.1 or later is required.

Note Use of Smart Scheduler does not require the TMS provisioning option key.

Cisco TelePresence Video VCS Control and Expressway are a required as the call control solution.

Communication Server (VCS) Release X7.2.2 or later is required.

A

Caution  Customers using Static NAT on VCS Expressway X7.2.2 are highly
recommended to not upgrade to X8.1. Because VCS Expressway X8.1 uses
the Ethernet 2 IP address for the media part in SDP, the media part of calls
will fail. If you are already using static NAT with X8.1, refer to the
recommended workarounds in Chapter 5, “VCS Expressway X8.1 Encryption
Issue and Workarounds”.

Cisco Unified Communications Unified CM is an optional call control solution that can be used with VCS for
Manager (Unified CM) deployments with endpoints registered to Unified CM.

Release 8.6.2 or higher is required. 9.1.1 is recommended.

Cisco TelePresence Server TelePresence Server can be used as a conference bridge for Cisco WebEx Enabled
TelePresence meetings.

Release 3.0 or later is required. Release 3.1 or later with a Third-Party Interop key is
required for support of TSP audio.

Cisco TelePresence MCU Cisco TelePresence MCU can be used as a conference bridge for Cisco WebEx Enabled
TelePresence meetings.

Release 4.4 or later is required.

Provisioning—Cisco TelePresence | 1. The Cisco WebEx Meeting Center site must be running release T28.10 or higher
with Cisco WebEx. with the latest service pack.

2. The Cisco WebEx site must be configured to support Cisco TelePresence
Integration. See Chapter 10, “Integrating Cisco TelePresence with Your
Cisco WebEx Site Administration Account” for more information.

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
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Table 2

Cisco WebEx with the Cisco TelePresence System Prerequisites

Requirement

Description

Supported Endpoints

Any endpoint supported by TelePresence Server or MCU can join a Cisco WebEx
Enabled TelePresence meeting.

Account Validation—Meeting
scheduler's Cisco WebEx account.

Each user who is scheduling Cisco WebEx Enabled TelePresence meetings in Cisco
TMS, must have a host account on the WebEXx site.

1. The WebEx account username and password must be added into to each meeting
scheduler’s user profile in Cisco TMS, along with the WebEx site they will use for
scheduling.

2. Cisco TMS validates authorized Cisco WebEx account holders.

Note  WebEx password is not required if Single-Sign-On (SSO) is configured in TMS.
See Chapter 6, “Configuring Cisco TelePresence Management Suite” for more

information.

Bandwidth and CPU
power—Recommendation for
good video quality and integrating
the Cisco TelePresence network
with Cisco WebEx.

Network bandwidth should be at least 1.1 Mbps upstream between the
MCU/TelePresence Server and WebEx. For example, if you are anticipating 5
simultaneous Cisco WebEx calls, you will need to have five 1.1 Mbps bandwidth
instances.

Suggested CPU power (depends on running applications) is dual core CPU, 2.5 GHz
memory running at least 2G.

Cisco WebEx Client Resource
Requirements—Expected resource
allocation per meeting.

For detailed requirements, refer to the Cisco WebEx Enabled TelePresence release notes.

Document Organization

Information about configuring and using the Cisco WebEx Enabled TelePresence is provided in the
following chapters:

e Chapter 1, “Information About the Cisco WebEx Enabled TelePresence Feature”

e Chapter 2, “First-Time Configuration Checklist”

e Chapter 3, “Configuring Cisco MCU and TelePresence Server”

e Chapter 4, “Configuring Call Control”

e Chapter 5, “Configuring Certificates on Cisco VCS Expressway”

e Chapter 6, “Configuring Cisco TelePresence Management Suite”

e Chapter 7, “Configuring Cisco TelePresence Management Suite Extension for Microsoft Exchange”

e Chapter 8, “Configuring Cisco TelePresence Management Suite Provisioning Extension”

e Chapter 9, “Configuring Audio”

e Chapter 10, “Integrating Cisco TelePresence with Your Cisco WebEx Site Administration Account”

e Chapter 11, “Scheduling Cisco WebEx Enabled TelePresence Meetings”

e Chapter 12, “Troubleshooting”

[ oL-21352-02
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Related Documents

Related Topic Document Link

Cisco TelePresence Documentation

Cisco TelePresence Management Suite e Cisco TelePresence Management Suite

Cisco TelePresence Video Communication Server | ® Cisco TelePresence Video Communication Server
(VCYS)

Cisco Unified Communications Manager (Unified | ® Cisco Unified Communications Manager
CM)

Cisco TelePresence Server e Cisco TelePresence Server
Cisco TelePresence MCU e MCU 5300 Series
e MCU 4501 Series
e MCU 4500 Series
e MCU 4200 Series
e MCU MSE Series

Cisco WebEx Documentation

Information about how to use Cisco WebEx e Go to your Cisco WebEx site home page.

meeting features. ¢ Log into your Cisco WebEx Meeting Center account and click on

Support > User Guides in the left navigation pane.

Specifying Cisco TelePresence Integration e Refer to Integrating Cisco TelePresence with Your Cisco WebEx
options and managing your Cisco WebEx Site. Site Administration Account.

Cisco WebEx Enabled TelePresence Documentation

Information for meeting organizers on how to e http://www.cisco.com/en/US/products/ps11338/products_user_guide_
schedule WebEx Enabled TelePresence meetings list.html
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Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and
revised Cisco technical documentation, at the following URL:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free
service and Cisco currently supports RSS version 2.0.

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
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CHAPTER 1

Information About the Cisco WebEx Enabled
TelePresence Feature

Revised: August 2014

Contents

This chapter provides an overview of the Cisco WebEx Enabled TelePresence solution. It contains the
following sections:

¢ Cisco WebEx Enabled TelePresence Experience, page 1-1

e Understanding How Cisco WebEx Enabled TelePresence is Deployed, page 1-6
e Understanding Cisco WebEx Enabled TelePresence Scheduling Flow, page 1-10
¢ Understanding Cisco WebEx Enabled TelePresence Call Flow, page 1-16

Cisco WebEx Enabled TelePresence Experience

This section contains the following information about the Cisco WebEx Enabled TelePresence meeting
experience:

e Scheduling the Meeting, page 1-1
e Starting/Joining the Meeting, page 1-2
e Cisco TelePresence Meeting Experience, page 1-2

e (Cisco WebEx Meeting Experience, page 1-2

Scheduling the Meeting

The meeting organizer can schedule the meeting using the Cisco WebEx and TelePresence Integration
to Outlook, Cisco Smart Scheduler, Cisco TelePresence Management Suite (Cisco TMS) or Cisco
WebEx Scheduling Mailbox.

For more information about how to schedule a meeting using the different scheduling options, refer to
Chapter 11, “Scheduling Cisco WebEx Enabled TelePresence Meetings”.
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Starting/Joining the Meeting

The meeting is started the following way:
e At the scheduled start time of the meeting, the MCU/TelePresence Server calls into WebEx.

— If the WebEx host has not joined the meeting, the MCU/TelePresence Server becomes the
default WebEx host.

— If the WebEx host joins before the scheduled start time of the meeting, he/she becomes the
WebEx host.

e TelePresence participants join the meeting.

— If meeting was scheduled using Auto Connect, Cisco TMS dials and connects each supported
endpoint.

— If meeting was scheduled using One-Button-to-Push (OBTP), participants using endpoints that
support OBTP press the button on their endpoint to join the meeting.

- Participants using endpoints that don’t support either Auto Connect or OBTP, join the meeting
by dialing the video dial-in number listed in the meeting invitation.

e WebEx Participants join the meeting using the link in the meeting invitation.

Cisco TelePresence Meeting Experience

Cisco TMS is used to configure and manage the Cisco WebEx bridging feature in Cisco TelePresence
meetings. During the meeting, telepresence participants see live video of both WebEx participants and
telepresence participants.

The Cisco WebEx bridging feature integrates the Cisco WebEx conferencing server with multipoint
meetings on the Cisco TelePresence MCU or Cisco TelePresence Server. Cisco Telepresence callers
connect to meetings using One-Button-to-Push (OBTP) or Automatic Connect technology. The
MCU/TelePresence Server connects at the meeting start time, automatically connects with the
Cisco WebEx conference and joins the two meetings. Upon connecting with Cisco WebEx, the
Cisco Telepresence presentation screen shows a Welcome page.

For presentation sharing, the TelePresence user connects the video display cable to their computer and
(if required) presses a button to start sharing their presentation to TelePresence and WebEx participants.
Video of the active speaker in the Cisco TelePresence system is streamed to the Cisco WebEx Web client.

Cisco WebEx Meeting Experience

Remote participants join the Cisco WebEx meeting by logging in to the Cisco WebEx Meeting Center
Web and/or mobile clients*. Content shared from the Cisco TelePresence endpoint is displayed
automatically in the Cisco WebEx Meeting Center clients and Cisco WebEx participants can share their
desktop or application with Cisco Telepresence endpoints. Cisco WebEx users see the live video of the
actively speaking Cisco TelePresence participant or WebEx participant. WebEX participants can go into
Full Screen view to see all the other WebEx and TelePresence participants in the meeting. When in full
screen mode, WebEx participants can see all WebEx participants who have their video turned on. While
in full-screen mode, participants will see video sent from TelePresence when a TelePresence participant
is the active speaker. Cisco WebEx users also see an integrated list of all Cisco WebEx meeting
participants. The WebEx annotation feature is supported. WebEx participants can annotate using the
standard WebEx Meeting Center client annotations tools and both WebEx and TelePresence participants
can see the annotations. The annotation tools are not available, however, for TelePresence participants.
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When the first WebEx participant joins, “TelePresence systems” appears in the list of WebEx
participants (Figure 1-1 on page 1-4) and in the row of WebEx participants in Full Screen vview
(Figure 1-2 on page 1-5). This indicates that it is a Cisco WebEx Enabled TelePresence meeting.
individual TelePresence users are not listed in the WebEx participants list. Instead, only “TelePresence
systems” is listed and is displayed in the active speaker window when a TelePresence participant is the
active speaker.

For Cisco WebEx participants to share their presentation with TelePresence participants, they must do
the following:

1. Log into the Cisco WebEx Web client on their laptops.
2. Grab the ball or be designated as presenter by the WebEx host.
3. Start application or desktop sharing.

* For a list supported mobile clients, refer to the Cisco WebEx Enabled TelePresence release notes.

Recommended Screen Resolutions for Presentation Sharing
To utilize the full screen while presenting, Cisco recommends setting your computer to a 4:3 aspect ratio
screen resolution. The following screen resolutions are recommended:
e 1024 x 768
e 1152 x 864
e 1280 x 1024
e 1600 x 1200

Passing the Ball

WebEx users share a presentation by taking the ball and then selecting the content to present. If the
WebEx site does not allow WebEx participants to take the ball, the WebEx host must pass the ball to the
WebEx participant. Alternately, an attendee can use the host key to become the new host. Then this new
host can assign the presenter ball to him/herself to present. For more information about using

Cisco WebEx meeting functions, log into your Cisco WebEx Meeting Center account and click Support
in the left navigation pane.

Viewing the Meeting in WebEx
When attending the meeting using the WebEx Meeting Center web client (Windows or Mac), you have
two basic ways to experience the meeting:
e Default View, page 1-3
e Full Screen View, page 1-4

Default View

When you log in to the meeting, the WebEx client displays the default view (see Figure 1-1). The default
view displays a video window and participant list on the right and the presentation being shared on the
left. The video window shows the current active speaker (either TelePresence or Webex).
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Figure 1-1 Cisco WebEx Meeting - Default View
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Full Screen View

Full Screen view displays the active speaker in a large image at the top of the window and WebEx
participants at the bottom of the window (see Figure 1-2). When in Full Screen mode, the presentation
is not visible.

To go into Full Screen mode, click the Full Screen button in the video window in the default view.

Cisco TelePresence Server or MCU can be configured to display other TelePresence participants in the
active speaker window. See Figure 1-3 for an example of Active Presence enabled by default on the
TelePresence Server. MCU sends a full screen layout.
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Figure 1-2 Cisco WebEx Meeting - Full Screen View
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Figure 1-3 Cisco WebEx Meeting - Full Screen View with Cisco TelePresence Server in Active Presence Mode
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Understanding How Cisco WebEx Enabled TelePresence is
Deployed

There are three possible network topologies for Cisco WebEx Enabled TelePresence:
e SIP Video, Presentation and Audio, page 1-6
e SIP Video, Presentation and PSTN Audio, page 1-7:
- Using a gateway registered to Unified CM
— Using a gateway registered to Cisco VCS Control

SIP Video, Presentation and Audio

WebEx is deployed using WebEx Audio. Main video, content, and audio to and from the WebEx cloud
is negotiated between the Cisco VCS Expressway on the customer site and the WebEx Cloud. All media
(main video, content, and audio) flows over IP negotiated using SIP. Blue and green balls symbolize
WebEx-enabled endpoints (ball displayed on endpoint display) (OBTP).
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Figure 1-4 Network Topology - SIP Video, Audio and Presentation
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SIP Video, Presentation and PSTN Audio

WebEx is deployed using WebEx Audio using PSTN. Only main video and content is negotiated through
the VCS Expressway on the customer site and WebEx cloud (SIP/IP).

At the time of scheduling, Cisco TMS provides the MCU PSTN access information (Dial number,
Conference ID, Attendee ID). The Cisco MCU calls out and sets up the audio-only call over PSTN to
the WebEx cloud, passing the conference ID and attendee ID using DTMF.

This deployment can be set up either of the following ways:
e Using a PSTN gateway registered to Unified CM - See Figure 1-5.
e Using a PSTN gateway registered to VCS - See Figure 1-6.

Note  This deployment type is not supported with Cisco TelePresence Server.
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Figure 1-5 Network Topology - SIP Video and Presentation with PSTN Audio Using Unified CM
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Figure 1-6 Network Topology - SIP Video and Presentation with PSTN Audio Using VCS Control
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Cisco TMS Scheduling Role

Cisco TMS provides a control link to the Cisco WebEx site. This interface allows Cisco TMS to book a
WebEx enabled meeting on behalf of the WebEx Host, and to obtain Cisco WebEx meeting information
that is distributed to meeting participants. Cisco TMS then pushes Cisco WebEx meeting details to the
TelePresence Server/MCU.

TelePresence Server and MCU Roles

Cisco TelePresence Server/MCU will send/receive two-way main video with up to 720p30 between
WebEx Meeting Center clients and TelePresence endpoints. The MCU/TelePresence Server sends a
single transcoded video stream to the WebEx Meeting Center client.

The MCU/TelePresence Server will send a single mixed audio stream of the TelePresence meeting
participants to the WebEx cloud. Likewise, the MCU/TelePresence Server will receive a single mixed
audio stream from all WebEx participants, including WebEx Meeting Center participants joined over
PSTN or VolIP.

Support for two-way content share XGA (1024x768) resolution between telepresence endpoints and
WebEx clients.

Each meeting creates its own SIP connection to avoid Transmission Control Protocol (TCP) congestion
and potential TCP windowing issues.

Presentation Display Details for Multiple Presenters

Note

For TelePresence users to present, the presenter connects the video display cable to the endpoint and (if
necessary) presses a presentation button on the endpoint. When multiple TelePresence users are
presenting at the same time, the endpoint that started presenting last is the one that is displayed. As
cables are unplugged, the next presenter must start presenting again.

For WebEx users to present, they grab the ball and then select the content to present. If a WebEx user
cannot grab the ball, the host must pass it to them. Alternatively, they can use the host key to become the
new host.

The WebEx site can be provisioned so that any WebEx attendee can grab the ball to present without the
host passing them the ball or using the host key.

Meeting Participant List

The TelePresence participant list, a roster of endpoint names currently connected to the TelePresence
Server (if used), is displayed on the TelePresence endpoint display device. MCU and certain endpoint
models do not support this feature.

The TelePresence participant list is not, however, displayed in the participant list available to WebEx
users. WebEx users see only other WebEx participants and one participant called “TelePresence
systems” that identifies all TelePresence participants in the meeting.

| oL-21352-02
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Ports and Protocols Used in WebEx Enabled TelePresence

The following ports and protocols are used between different components of the WebEx Enabled
TelePresence solution.

Table 1-1 Ports and Protocols Used in WebEx Enabled TelePresence

Component Communication Port and Protocol Used

TMS to WebEx cloud Ephemeral port using TLS.443

WebEx and TelePresence Integration to Outlook |Ephemeral port using TLS.443

to TMSXE

VCS Expressway to WebEx cloud TLS and UDP ports 9000 and 9001 for media

Understanding Cisco WebEx Enabled TelePresence Scheduling
Flow

This section describes what takes place when a Cisco WebEx Enabled TelePresence Meeting is
scheduled using the following:

e Scheduling with the Cisco WebEx and TelePresence Integration to Outlook, page 1-11
e Scheduling with the Cisco Smart Scheduler, page 1-13
e Scheduling with the Cisco WebEx Scheduling Mailbox, page 1-15

Note  Multiple deployments are possible at the same time. For example, when using Smart Scheduler, if

Microsoft Exchange is deployed, the calendar of any rooms booked for a meeting is updated with the
meeting details.
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Scheduling with the Cisco WebEx and TelePresence Integration to Outlook

Figure 1-7 Cisco WebEx and TelePresence Integration to Outlook Scheduling Flow
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Table 1-2 Cisco WebEx and TelePresence Integration to Outlook Scheduling Steps
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Step # Description

1 User books meeting with Cisco WebEx and TelePresence Integration to Outlook.
e Adds users
¢ Adds rooms

e Meeting request is sent to WebEx and books the WebEx portion of meeting.

2 WebEx responds with meeting information:
e Date and time of meeting

e Meeting subject

¢ Audio dial-in information

— If TSP audio, then the audio will contain additional info for the MCU to dial
the TSP provider.

e SIP video and audio (if SIP audio) dial-in information for the bridge to dial into

WebEx
e Meeting URL for participants to click
3 Cisco WebEx and TelePresence Integration to Outlook contacts TMSXE and does a
booking request which includes the WebEx info from step 2.
4 TMSXE sends a booking request with the same information to TMS.
TMS confirms the meeting and returns the meeting details to TMSXE.
6 TMSXE sends the meeting confirmation to the Cisco WebEx and TelePresence
Integration to Outlook.
7 Outlook invitation is sent back to Exchange to book the rooms and to also any added
participants.
8 TMSXE monitors the room mailbox to make sure the rooms accept the meeting.
9 If user invited TelePresence rooms, TMS One-Button-to-Push information is sent to

the TelePresence endpoints.
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Scheduling with the Cisco Smart Scheduler

Figure 1-8 Cisco WebEx Smart Scheduler Scheduling Flow
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Table 1-3 Cisco Smart Scheduler Scheduling Steps

Step # Description

1 User books meeting with Smart Scheduler.
e Adds rooms
e Adds WebEx

¢ Clicks Save.
2 e TMSPE sends a booking request to TMS.

e TMS sends booking request to WebEx.

¢ WebEx books WebEx portion of meeting.
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Step # Description

4 WebEx sends meeting details in response to the booking request from TMS:
e Date/time of the meeting

e Meeting subject

¢ Audio dial-in information

— if TSP audio, then the audio will contain additional info for the MCU to dial
the TSP provider.

e SIP video and audio (if SIP audio) dial-in information for the bridge to dial into
WebEx

e Meeting URL for participants to click

TMS responds to TMSPE with booking confirmation information.

TMS sends confirmation email to user.

User sends meeting invitation with meeting details to invitees.

0| | N W

If user invited TelePresence rooms, TMS sends One-Button-to-Push information to
the TelePresence endpoints.
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Scheduling with the Cisco WebEx Scheduling Mailbox

Figure 1-9 Cisco WebEx Scheduling Mailbox Scheduling Flow
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Table 1-4 Cisco WebEx Scheduling Mailbox Scheduling Steps
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Step # Description

1 User books meeting in email/calendar client supported by Microsoft Exchange:
e Adds rooms

e Adds WebEx Scheduling Mailbox (e.g. webex @example.com)

e Adds participants

¢ Clicks Send

e Meeting request is sent to Exchange.

2 TMSXE monitors mailboxes for the rooms and the WebEx Scheduling Mailbox.
TMSXE communicates with the booking API on TMS to request a WebEx Enabled
meeting.

4 TMS requests WebEx to book the WebEx portion of the meeting.

WebEx sends meeting details in response to the booking request from TMS:
e Date/time of the meeting
e Meeting subject
¢ Audio dial-in information

— if TSP audio, then the audio will contain additional info for the MCU to dial
the TSP provider.

e SIP video and audio (if SIP audio) dial-in information for the bridge to dial into

WebEx
e Meeting URL for participants to click.
6 TMS responds to TMSXE with booking confirmation information.
7 TMSXE sends email confirmation to meeting organizer.
8 If user invited TelePresence rooms, TMS sends One-Button-to-Push information to

the TelePresence endpoints.

Understanding Cisco WebEx Enabled TelePresence Call Flow

This section describes the call flow of the following Cisco WebEx Enabled TelePresence Meetings:
e SIP Audio Call Flow, page 1-17
e TSP Audio Call Flow with API Command to Unlock Waiting Room, page 1-19
e TSP Audio Call Flow with Waiting Room and MCU/TelePresence Server as Host, page 1-21
e WebEx Audio (PSTN) Call Flow, page 1-23
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SIP Audio Call Flow

Figure 1-10 SIP Audio Call Flow
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Table 1-5 SIP Audio Call Flow Steps

Step # Description

1 MCU calls WebEx using SIP URI and the call is routed through VCS Control
2 VCS control sends call to VCS-E through the traversal zone.

3 VCS Expressway does a DNS lookup for example.webex.com.

4 DNS resolves example.webex.com to the CUSP servers.

5

VCS Expressway sends call to CUSP. This step is always encrypted (mandatory)
(encryption is optional on previous steps).

- VCS Expressway and the CUSP server verify each other's certificates.
6 CUSP forwards the call to VCS Expressway inside the WebEx dmz.

- This leg is encrypted also (mandatory).

7 Media is connected.
- Media is encrypted between the two VCS Expressways (across the Internet)

- It's optional whether it's encrypted between the MCU and the VCS Expressway in
the customer's site.
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TSP Audio Call Flow with APl Command to Unlock Waiting Room

Figure 1-11 TSP Audio Call Flow with APl Command to Unlock Waiting Room
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Table 1-6 TSP Audio Call Flow with API Command to Unlock Waiting Room Steps

Step # Description

1 TMS starts the conference on MCU/TelePresence Server, providing it with the SIP URI,
telephone number (if using PSTN audio) and DTMF String (if using PSTN audio) to dial
into WebEx

2a MCU/TelePresence Server dials WebEx via SIP. (refer to Figure 1-10 for details).

2b At the same time as step 2a, MCU/TelePresence Server dials PSTN call-in number for
WebEx.
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Step # Description

3a WebEx notifies TSP provider using API command to start the audio conference, and as
part of that, Webex tells the TSP provider that the conference type = telepresence and that
it should unlock the waiting room.

3b At the same time as step 3a, TSP provider prompts the MCU/TelePresence Server for the
meeting access number.

4a TSP provider unlocks waiting room, in response to step 3a.

4b At the same time as step 4a, MCU/TelePresence Server sends DTMF tones it was
prompted for in step 3b to TSP.

5 TSP provider receives the DTMF tones.

6 TSP provider places MCU/TelePresence Server into the audio conference.
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TSP Audio Call Flow with Waiting Room and MCU/TelePresence Server as Host

Figure 1-12 TSP Audio Call Flow with Waiting Room and MCU/TelePresence Server as Host
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Table 1-7 TSP Audio Call Flow with Waiting Room and MCU/TelePresence Server as Host Steps

Step # Description

1 TMS starts conference on MCU/TelePresence Server, providing it with the SIP URI,
telephone# (if using PSTN audio) and DTMF String (if using PSTN audio) to dial into
WebEx

2a MCU/TelePresence Server dials webex via SIP. (refer to Figure 1-10 for details).

2b At the same time as step 2a, MCU/TelePresence Server dials PSTN call-in number for
WebEx.

3 TSP provider prompts the MCU/TelePresence Server for the meeting access number and
host key.
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Step # Description

4 MCU/TelePresence Server sends DTMF tones and host key it was prompted for in step 3.

5 TSP provider receives the DTMF tones.

6 TSP provider unlocks the waiting room and places the MCU/TelePresence Server into the
audio conference.
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WebEx Audio (PSTN) Call Flow

Figure 1-13 WebEx Audio (PSTN) Call Flow
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Table 1-8 WebEx Audio Call Flow Steps
Step # Description
1 TMS starts conference on MCU, providing it with the SIP URI, telephone number
and DTMF string to dial into WebEx.
2a MCU dials WebEx via SIP. (refer back to Figure 1-10 for details).
2b At the same time as step 2a, MCU dials PSTN call-in number for WebEx.

WebEx prompts the MCU for the meeting access number.

4 MCU sends DTMF tones it was prompted for in step 3 to TSP.
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Step # Description
5 WebEx receives the DTMF tones.
6 WebEx places the MCU into the audio conference.
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First-Time Configuration Checklist

Revised: December 2013

Contents

This chapter describes items and configuration tasks required to deploy Cisco WebEx Enabled
TelePresence. It contains the following sections:

e Server and Site Access Checklist, page 2-1
e Configuration Task Checklist, page 2-3

Server and Site Access Checklist

Table 2-1 describes information you must have before you can configure Cisco WebEx Enabled
TelePresence for the first time.

Table 2-1 Make Sure You Have the Following
What You Need Description and Source v
WebEx Site URL URL for the Cisco WebEx site.

Source—Provided by the Cisco WebEx Account Team.
Example—nhttps://example.webex.com/example

Detailed Instructions—Configuring Cisco TelePresence
Management Suite.

WebEx Site Hostname Hostname of WebEXx site used by the customer.
Source—Provided by the Cisco WebEx Account Team.
Example—“example.webex.com”

Detailed Instructions—Configuring Cisco TelePresence
Management Suite
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Table 2-1 Make Sure You Have the Following

What You Need Description and Source v

WebEx Site Administration URL Your unique address for accessing the Cisco WebEx Site
Administration interface where you complete your initial
Cisco WebEx setup configuration and manage and maintain your
account after initial setup. This URL takes you directly to the WebEx
Administration site.
Source—Provided by the Cisco WebEx Account Team.
Example—*“https://example.webex.com/admin”
Detailed Instructions— Integrating Cisco TelePresence with Your
Cisco WebEx Site Administration Account

Cisco WebEx Administrator username Cisco WebEx Site Administrator account username.
Source—Provided by the Cisco WebEx Account Team.
Example—“webexAdmin”
Detailed Instructions— Integrating Cisco TelePresence with Your
Cisco WebEx Site Administration Account

(Optional) Certificate pair, including public |Used to authenticate Cisco TMS to the WebEx cloud for meetings

certificate and private key from TMS. booked by users with WebEx accounts when Single Sign On (SSO) is
enabled on TMS. When SSO is configured and a user schedules a
WebEx-enabled meeting, the WebEx username in their Cisco TMS
user profile is passed to the WebEx site to complete the booking.
Detailed Instructions— Configuring Single Sign On in Cisco TMS

Client/server certificate for VCS Because the call leg between the VCS Expressway and the WebEx

Expressway. cloud must be encrypted, a valid client/server certificate is required
for the SSL handshake to occur so that secure signaling and media can
take place.
Detailed Instructions— Creating a New DNS Zone on VCS
Expressway for WebEx and Configuring Certificates on Cisco VCS
Expressway.
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Configuration Task Checklist 1l

Configuration Task Checklist

Cisco MCU

You can choose the order in which you wish to configure Cisco TelePresence components for Cisco
WebEx Enabled TelePresence; the following order is only a suggestion, though you must complete all
of the configuration steps in this checklist to enable the feature and Cisco TelePresence must be enabled
before you can configure Cisco WebEx Site Administration.

1. Conference bridges:
- Cisco MCU, page 2-3
- Cisco TelePresence Server, page 2-4
2. Call control:
— Cisco Video Communications Server, page 2-4
— Cisco Unified Communications Manager, page 2-4
3. Scheduling:
— Cisco TelePresence Management Suite, page 2-6
— Cisco TelePresence Management Suite Extension for Microsoft Exchange, page 2-7
— Cisco TelePresence Management Suite Provisioning Extension, page 2-8
4. Audio:
— Configure Audio for Cisco WebEx Enabled TelePresence, page 2-9
5. WebEXx site:
— Cisco WebEx Site Administration, page 2-9

Table 2-2 Checklist — Configuring Cisco WebEx Enabled TelePresence on the MCU for the First Time
Go to: Chapter 3, “Configuring Cisco MCU and TelePresence Server”
Task Detailed Instructions v

Step1 |Configure SIP SIP, page 3-2

Step2 |Configure the Content Mode. Content Mode, page 3-2

Step3 |Configure the Video and Audio Codecs. Video and Audio Codecs, page 3-2

Step4 | Configure the Automatic Content Handover. Automatic Content Handover, page 3-3

Step5 |Configure Optional Recommended Settings: Recommended Settings for MCU, page 3-3
¢ Automatically Make Content Channel

Important
¢ Outgoing Transcoded Codec
e Adaptive Gain Control
e Join and Leave Audio Notifications
e Encryption
Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
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Bl Configuration Task Checklist

Cisco TelePresence Server

Table 2-3 Checklist — Configuring Cisco WebEx Enabled TelePresence on the TelePresence Server for the First Time

Go to: Chapter 3, “Configuring Cisco MCU and TelePresence Server”

Task Detailed Instructions v
Step1 |Configure SIP SIP, page 3-6
Step2 |Configure Locally Managed Mode Locally Managed Mode, page 3-6
Step1 |Configure the Automatic Content Handover. Automatic Content Handover, page 3-6
Step2 |Configure Optional Recommended Setting: Display Setting, page 3-7
e Display Setting

Cisco Video Communications Server

Table 2-4 Checklist — Configuring Cisco WebEx Enabled TelePresence on Cisco Unified CM for the First Time

Go to: Chapter 4, “Configuring Call Control”

Task Detailed Instructions v

Step1 |Create a New DNS Zone on VCS Expressway |Creating a New DNS Zone on VCS Expressway for
for WebEx WebEx, page 4-3

e Create a new DNS zone

e Turn on TLS Verify mode and enter TLS
verify subject name.

e Setup a search rule for the WebEx domain

Step2 | Configure a valid Client/Server Certificate Configuring Certificates on Cisco VCS Expressway,
page 5-1,

Step3 | Configuring Traversal Zones for MCUs with | Configuring Traversal Zones for MCUs with Encryption
Encryption Enabled Enabled, page 4-4

Step4 | (If deploying with Unified CM) Configure a SIP |Configuring a SIP Trunk Between Unified CM and VCS
trunk between Unified CM and VCS Control. |Control, page 4-5

Cisco Unified Communications Manager

Table 2-5 Checklist — Configuring Cisco WebEx Enabled TelePresence on Cisco Unified CM for the First Time
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Configuration Task Checklist 1l

Go to: Chapter 4, “Configuring Call Control”

Task Detailed Instructions v
Step1 | Configure a SIP trunk between Unified CM Configuring a SIP Trunk Between Unified CM and VCS
and VCS Control. Control, page 4-5
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Bl Configuration Task Checklist

Cisco TelePresence Management Suite

Table 2-6 Checklist — Configuring Cisco WebEx Enabled TelePresence on Cisco TMS for the First Time

Go to: Chapter 6, “Configuring Cisco TelePresence Management Suite”

Task Detailed Instructions v
Step1 |Enable the WebEx feature in Cisco TMS. Configuring the Cisco WebEx Feature in Cisco TMS,
page 6-2
Step2 |Configure WebEx users in Cisco TMS. Configuring WebEx Users in Cisco TMS, page 6-4

Step3 |Configure Hybrid Content Mode for MCU in Configuring Hybrid Content Mode for MCU in Cisco
Cisco TMS. TMS, page 6-8
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Configuration Task Checklist 1l

Cisco TelePresence Management Suite Extension for Microsoft Exchange

Complete the steps below if you want to deploy the feature of scheduling WebEx Enabled TelePresence
meetings using the Microsoft Outlook. You have the option of configuring one or both of the following
scheduling options:

e WebEx and TelePresence to Outlook
e WebEx Scheduling Mailbox

Table 2-7 Checklist — Configuring Cisco WebEx Enabled TelePresence on Cisco TMISXE for the First Time
Go to: Chapter 7, “Configuring Cisco TelePresence Management Suite Extension for Microsoft Exchange”
Task Detailed Instructions v
Step1 |Configure TMSXE for scheduling with WebEx  |Configuring Cisco TMSXE for the WebEx and
and TelePresence Integration to Microsoft TelePresence Integration to Outlook, page 7-2
Outlook.
Step2 |Configure TMSXE for scheduling with WebEx  |Configuring Cisco TMSXE for the WebEx Scheduling
Scheduling Mailbox. Mailbox, page 7-6

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
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Bl Configuration Task Checklist

Cisco TelePresence Management Suite Provisioning Extension

Complete the steps below if you want to deploy the feature of scheduling Cisco WebEx Enabled
TelePresence meetings using Smart Scheduler.

Table 2-8 Checklist — Configuring Cisco WebEx Enabled TelePresence on Cisco TMSPE for the First Time
Task Detailed Instructions v
Step1 |Install and enable TelePresence Management Cisco TelePresence Management Suite Provisioning

Suite Provisioning Extension (TMSPE) on TMS. |Extension Deployment Guide.

Step2 |Review additional prerequisites, and information |Configuring Cisco TelePresence Management Suite
about TMSPE and Smart Scheduler. Provisioning Extension, page 8-1
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Configure Audio for Cisco WebEx Enabled TelePresence

Table 2-9 Checklist — Configuring Audio for Cisco WebEx Enabled TelePresence

Go to: Chapter 9, “Configuring Audio”

Task Detailed Instructions v
Step1 |Configuring SIP Audio for Cisco WebEx Enabled |Configuring SIP Audio for Cisco WebEx Enabled
TelePresence: TelePresence, page 9-2

e Configure the WebEx Site in Cisco TMS to
Use SIP Audio

¢ Enable Hybrid Mode on the WebEx Site

Step2 |Configuring PSTN Audio for Cisco WebEx Configuring PSTN Audio for Cisco WebEx Enabled
Enabled TelePresence: TelePresence, page 9-3

e Configure the WebEx Site in Cisco TMS to
Use PSTN Audio

e Enable Hybrid Mode on the WebEx Site
(Optional)

e Configure PSTN Calls to Pass Through a
PSTN gateway to WebEx

Step3 | (If applicable) Configuring TSP Audio for Cisco |Configuring TSP Audio for Cisco WebEx Enabled
WebEx Enabled TelePresence: TelePresence, page 9-7

e Configure MACC Domain Index and Open
TSP Meeting Room WebEx Settings

¢ Configure TSP Dial String
¢ Configure How the Conference is Opened

e Configure TSP Audio for the Meeting
Organizer

Cisco WebEx Site Administration

After WebEx provisions your site for WebEx Enabled TelePresence, follow these steps.

Table 2-10 Checklist — Setting up Cisco WebEx Site Administration for the First Time

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
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Bl Configuration Task Checklist

Go to: Chapter 10, “Integrating Cisco TelePresence with Your Cisco WebEx Site Administration Account”

Task

Detailed Instructions v

Step 1

Enable Cisco TelePresence Integration (MC
only).

Step 2

(Recommended) Enable TelePresence options:
e List TelePresence on calendar
e Send invitation email to meeting host

¢ Display toll-free number to attendees

Step 3

Set the Cisco TelePresence VOIP and video
connection.

Integrating Cisco TelePresence with Your Cisco WebEx
Site Administration Account

Step 4

Select the Cisco TelePresence PRO: Meeting
Center TelePresence Session Type.

Assigning the Meeting Center TelePresence Session
Type
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Contents

CHAPTER

Configuring Cisco MCU and TelePresence Server

Revised: July 2014

You must be running MCU software release 4.4 or a later or TelePresence Server 3.0 or later to use Cisco
WebEx Enabled TelePresence features.

This chapter describes how to configure MCU and TelePresence Server for Cisco WebEx Enabled
TelePresence meetings. It contains the following sections:

e Required Settings for MCU, page 3-2
¢ Recommended Settings for MCU, page 3-3
e Required Settings for TelePresence Server, page 3-5

e Recommended Settings for TelePresence Server, page 3-7

Introduction

Note

This chapter describes specific settings on both MCU and TelePresence Server that are required or
recommended for use with Cisco WebEx Enabled TelePresence meetings.

In terms of deployment, both MCU and TelePresence Server must be registered to VCS directly and
cannot be trunked to Unified CM.

In terms of user experience, the active speaker from TelePresence to MCU or TelePresence Server is
shown to WebEx users and the active speaker from WebEx to MCU or TelePresence Server is shown to
TelePresence. TelePresence Server, by default, using a feature called ActivePresence, displays a full
screen view of the active speaker and up to nine additional TelePresence participants in a row at the
bottom of the screen. MCU, by default displays a full screen view of the active speaker. For more
information about the screen layout options available, refer to the TelePresence Server and MCU
documentation.

Only Cisco multiparty bridges, such as the Cisco TelePresence Server and Cisco TelePresence MCU, are
supported for WebEx Enabled TelePresence.

| oL-21352-02
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M Required Settings for MCU

Required Settings for MCU

The following settings on MCU are required for Cisco WebEx Enabled TelePresence:
e SIP, page 3-2
e Content Mode, page 3-2
e Video and Audio Codecs, page 3-2
e Automatic Content Handover, page 3-3
For more information about MCU software, refer to the following link:

http://www.cisco.com/en/US/products/ps12283/prod_release_notes_list.html

SIP

MCU calls to WebEx support SIP only. Make sure SIP is configured correctly on MCU. The call leg
between MCU/TelePresence Server, VCS Control, VCS Expressway and the WebEx cloud cannot be
interworked.

~

Note  Refer to MCU help for more information on how to configure SIP.

Content Mode

In Hybrid mode, the incoming content stream is passed through, giving the best possible quality to HD
endpoints and it is also decoded and used to create a second, lower resolution stream for anyone who
cannot receive the passthrough stream (SD endpoints). This uses up a video port but ensures that users
get the advantages both of transcoding and passthrough.

If content mode is set to Passthrough, a single video stream is sent to everyone in the meeting. If all
participants are HD endpoints, they receive the best possible quality. However, if one or more
participants can only receive SD video, then all participants receive SD video.

Though Content Mode can be set on the MCU, Cisco recommends customers to set it using TMS.
To configure hybrid content mode for MCU in TMS, refer to:
Configuring Hybrid Content Mode for MCU in Cisco TMS, page 6-8.

Video and Audio Codecs

WebEx requires H.264 for video and content and G.711 for audio.

To set video and audio codecs in MCU, do the following:

Step1  Log into the MCU.

Step2  Click Settings.

Step3  The Settings page appears with the Conferences tab displayed.

Step4  In the Advanced Settings section make sure H.264 is checked for the following:
¢ Video codecs from MCU
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Step 5

Step 6

Recommended Settings for MCU

¢ Video codecs to MCU

In the Advanced Settings section make sure G.711 is checked for the following:
e Audio codecs from MCU
e Audio codecs to MCU

At the bottom of the page, click Apply changes.

Automatic Content Handover

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

This feature must be enabled for TelePresence endpoints to share during a Cisco WebEx Enabled
TelePresence meeting.

To enable Automatic Content Handover in MCU, do the following:

Log into the MCU.

Click Settings.

The Settings page appears with the Conferences tab displayed.
Click the Content tab.

For Automatic content handover, select Enabled.

At the bottom of the page, click Apply changes.

Recommended Settings for MCU

For best results with Cisco WebEx Enabled TelePresence, Cisco recommends configuring the following
settings in MCU:

e Automatically Make Content Channel Important, page 3-3
e Outgoing Transcoded Codec, page 3-4

e Adaptive Gain Control, page 3-4

e Join and Leave Audio Notifications, page 3-5

e Encryption, page 3-5

Automatically Make Content Channel Important

Step 1

Cisco recommends setting the conference settings to automatically make the content channel important.
Any new content channel in a conference will be treated as important and displayed prominently to all
participants who see the content channel in their conference layout.

To enable automatically making the content channel important, do the following:

Log into the MCU.

| oL-21352-02
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B Recommended Settings for MCU

Step 2

Step 3
Step 4

Click Settings.
The Settings page appears with the Conferences tab displayed.
In the Advanced Settings section, check Automatically make content channel important.

At the bottom of the page, click Apply changes.

Outgoing Transcoded Codec

Step 1
Step 2

Step 3

Step 4

Step 5
Step 6

Cisco recommends setting the outgoing transcoded codec to H.264. This makes the MCU use the H.264
video codec for outgoing transcoded content channels.

To set the outgoing transcoded codec to H.264, do the following:

Log into the MCU.

Click Conferences at the top of the page.

The Conferences page appears with the Conference list tab displayed.

Click the Templates tab.

The Conference Templates page appears.

Click the link for Top level.

The Top level template configuration page appears.

In the Content section, using the Outgoing transcoded codec menu, select H.264.

At the bottom of the page, click Apply changes.

Adaptive Gain Control

Step 1
Step 2

Step 3

Step 4

Step 5
Step 6

Cisco recommends setting adaptive gain control on join to be enabled. Adaptive Gain Control (AGC)
alters the gain of each participant's audio so that all participants have a consistent volume level.

To set the adaptive gain control on join to be enabled, do the following:

Log into the MCU.

Click Conferences at the top of the page.

The Conferences page appears with the Conference list tab displayed.

Click the Templates tab.

The Conference Templates page appears.

Click the link for Top level.

The Top level template configuration page appears.

In the Parameters section, using the Adaptive Gain Control on join menu, select Enabled.

At the bottom of the page, click Apply changes.
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Required Settings for TelePresence Server W

Join and Leave Audio Notifications

Step 1
Step 2

Step 3
Step 4

Encryption

Step 1
Step 2

Step 3

Step 4

Step 5
Step 6

This setting controls different aspects of sounds that can occur during a meeting. One setting to be aware
of for Cisco WebEx Enabled TelePresence meetings is Join and Leave Notifications, which are audible
messages indicating when other participants join and leave the meeting. By default, these are enabled
(checked).

WebEXx also has join and leave notifications that are independent of those set in MCU. If the notifications
are enabled on both MCU and WebEXx, notifications will be heard for each participant joining and leaving
the meeting on the MCU side and for participants on the WebEx side. As a result, you may want to
disable the join and leaving notifications in MCU and/or WebEx.

To disable the join and leave audio notifications in MCU, do the following:

Log into the MCU.

Click Settings.

The Settings page appears with the Conferences tab displayed.

In the Conference Settings section, for Audio Notifications, uncheck Join and leave indications.

At the bottom of the page, click Apply changes.

Cisco recommends that on MCUs with an encryption key, that the conference settings are configured to
optionally encrypt the media. If encryption is set to require encryption of all media, then the main and
content video sent to WebEx will be merged into a single stream and treated as a participant.

To set encryption to optional, do the following:

Log into the MCU.

Click Conferences at the top of the page.

The Conferences page appears with the Conference list tab displayed.
Click the Templates tab.

The Conference Templates page appears.

Click the link for Top level.

The Top level template configuration page appears.

In the Parameters section, using the Encryption menu, select Optional.

At the bottom of the page, click Apply changes.

Required Settings for TelePresence Server

The following setting in TelePresence Server is required for Cisco WebEx Enabled TelePresence:

e SIP, page 3-6
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M Required Settings for TelePresence Server

e Locally Managed Mode, page 3-6
e Automatic Content Handover, page 3-6
For more information about TelePresence Server software, refer to the following link:

http://www.cisco.com/en/US/products/ps11339/prod_release_notes_list.html

Note  TelePresence Server release 3.1 with a Third-Party Interop key is required for support of TSP audio.

SIP

TelePresence Server calls to WebEx support SIP only. Make sure SIP is configured correctly on
TelePresence Server.

S

Note  Refer to the TelePresence Server help for more information on how to configure SIP.

Locally Managed Mode

For TMS to control the TelePresence Server, the TelePresence Server must be set in locally managed
mode. To set the operation mode, do the following.

To enable locally managed mode in TelePresence Server, do the following:

Step1  Log into the TelePresence Server.
Step2  Go to Configuration > Operation mode.
The Operation mode page appears.
Step3  Using the Operation mode menu, select Locally managed.

Step4 At the bottom of the page, click Apply changes.

Automatic Content Handover

This feature must be enabled for TelePresence endpoints to share during a Cisco WebEx Enabled
TelePresence meeting.

To enable Automatic Content Handover in TelePresence Server, do the following:

Step1  Log into the TelePresence Server.
Step2  Go to Configuration > System Settings.
The System Settings page appears.
Step3  Make sure Automatic content handover is checked.

Step4 At the bottom of the page, click Apply changes.
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Recommended Settings for TelePresence Server

Recommended Settings for TelePresence Server

For best results with Cisco WebEx Enabled TelePresence, Cisco recommends the following settings on
TelePresence Server:

Display Setting
Cisco recommends the display setting in TelePresence Server to be set to full screen, so that Webex video

can be shown full size on a multiscreen endpoint.

To enable full screen display in TelePresence Server, do the following:

Step1  Log into TelePresence Server.
Step2  Go to Configuration > Default Endpoint Settings.
Step3  In the Display section, for Full screen view of single-screen endpoints, select Allowed.

Stepd At the bottom of the page, click Apply changes.

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
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CHAPTER I

Configuring Call Control

Revised: February 2014

Introduction

This chapter describes how to configure call control for Cisco WebEx Enabled TelePresence meetings.

To begin using Cisco WebEx Enabled TelePresence, you must configure the call control product(s) used
in your video network.

There are three possible call control scenarios:
e Cisco TelePresence VCS Control and Expressway
Endpoints are registered to VCS Control and/or Expressway only.
e Cisco Unified CM with VCS Control and Expressway
Endpoints are registered to Unified CM only.
e Cisco TelePresence VCS Control and Expressway with Unified CM
Endpoints are registered to VCS Control/Expressway and Unified CM.

~

Note  Using Unified CM as the call control solution requires VCS Control and Expressway to be deployed in
order to communicate with WebEx, regardless of whether endpoints are registered to VCS Control and
Expressway or not.

Configuring Cisco TelePresence Video Communication
Server Control and Expressway

The following section describes the steps required for configuring Cisco TelePresence Video
Communication Server Control and Expressway for Cisco WebEx Enabled TelePresence.

This section describes the following tasks:
e Prerequisites, page 4-2
e Creating a New DNS Zone on VCS Expressway for WebEx, page 4-3
e Configuring Traversal Zones for MCUs with Encryption Enabled, page 4-4

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
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Bl Configuring Cisco TelePresence Video Communication Server Control and Expressway

Prerequisites

To configure WebEx in Cisco TelePresence VCS, the following are required:

Cisco TelePresence Video Communication Server (VCS) must be running firmware X7.2.2 or a later
release.

Endpoints in the network are registered to VCS Control or Expressway and/or Unified CM

~

Note If endpoints are registered to Unified CM, you must configure a SIP trunk between Unified
CM and VCS Control. For more information, refer to Configuring Cisco Unified
Communications Manager, page 4-4.

Expressway must be assigned a static IP address
Firewall must have port 5061 open to allow access to Expressway
— If this port is not configured correctly, calls will not take place correctly.

Conferencing Bridge(s) to be used (MCU or TelePresence Server) are already operational within the
network

VCS Control is in the private network
VCS Expressway is in the DMZ and has access to the Internet

Set zones and pipes appropriately (according to your network’s requirements) to allow a minimum
of 1.1 Mbps for WebEx calls. For more information about bandwidth controls, please refer to the
Cisco VCS Administrator Guide at:

http://www.cisco.com/en/US/docs/telepresence/infrastructure/ves/admin_guide/Cisco_VCS_Admi
nistrator_Guide_X7-2.pdf

VCS Control is configured as the SIP Registrar/H.323 gatekeeper.

In order for Cisco WebEx Enabled TelePresence to work, it is required to set up a VCS Control as
a SIP registrar, enabling it to register SIP devices and route calls to them. VCS Control has the
capability to be both an H.323 gatekeeper and a SIP registrar.

Configuring VCS as a SIP registrar is done by configuring one or more SIP domains. The VCS will
act as a SIP Registrar and Presence Server for these domains, and will accept registration requests
for any SIP endpoints attempting to register with an alias that includes these domains.

For details on how to configure SIP domains in VCS Control, refer to the “Cisco TelePresence Video
Communication Server Basic Configuration (Control with Expressway) Deployment Guide” at:

https://www.cisco.com/en/US/docs/telepresence/infrastructure/ves/config_guide/Cisco_VCS_Basi
c_Configuration_Cisco_VCS_Control_with_Cisco_VCS_Expressway_Deployment_Guide_X7-2.
pdf

Intercompany TelePresence participants: If you want to allow participants from another company to
be able to join via TelePresence, you must have a valid SIP SRV (secure SIP), non-secure SIP SRV
or multiple SIP and H323 SRV records in place that resolve to the VCS Expressway for your
configured SIP Domain so TelePresence participants can route to your VCS Expressway.
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Creating a New DNS Zone on VCS Expressway for WebEx

Step 1

Step 2

Step 3

A

By default, a VCS solution will handle local domains, and route calls to non-local domains to the VCS
Expressway to route them to the Internet via a DNS zone.

Connection to the WebEx cloud uses a new DNS zone, that needs to be configured on the VCS
Expressway.

To configure the VCS Expressway for Cisco WebEx Enabled TelePresence, do the following:

Create a new DNS zone:

a. Set H.323 to Off.

b. Set SIP Media encryption mode to Force encrypted.

¢. Turn on TLS Verify mode.

d. In the TLS verify subject name field, enter sip.webex.com.
e. Click Create Zone.

Set up a search rule with a higher priority than the search rule for the existing DNS zone (lower number
priority) for the domain of WebEx.

The following configuration is required:
¢ Protocol: SIP
¢ Source: <Admin Defined>, default: Any
e Mode: Alias Pattern Match
e Pattern Type: Regex
e Pattern String: (.*)@(.*)(\.webex\.com).*
e Pattern Behavior: Replace
¢ Replace String: \1@\2\3
e On Successful Match: Stop
e Target: <DNS Zone Created for WebEx>
e State: Enabled

For details on how to create and set up search rules for a DNS zone, refer to the “Cisco TelePresence
Video Communication Server Basic Configuration (Control with Expressway) Deployment Guide” at:
https://www.cisco.com/en/US/docs/telepresence/infrastructure/vcs/config_guide/Cisco_VCS_Basic_C
onfiguration_Cisco_VCS_Control_with_Cisco_VCS_Expressway_Deployment_Guide_X7-1.pdf.

Configure a valid Client/Server Certificate for your company. Typically the CName of the certificate is
the routable domain to your company’s VCS Expressway. It must be a CA-level certificate name issued
by a public CA that is supported by WebEx.

Caution

Self-signed certificates are NOT supported.

For a list of supported certificates and details on how to configure a certificate on VCS Expressway, refer
to: Chapter 5, “Configuring Certificates on Cisco VCS Expressway”.
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Configuring Traversal Zones for MCUs with Encryption Enabled

This section details the configuration necessary in VCS to support MCUs that have encryption enabled
(the default setting).

A

Caution  If you choose not to do the following configuration, MCUs with encryption enabled will deliver the
presentation content in the main video channel, instead of a separate stream.

To support MCUs that have encryption enabled, do the following

Step 1 Set up a new traversal client zone from VCS Control to VCS Expressway

~

Note = Make sure the new zone uses a different port number.

Step2  On VCS Expressway, set up a new traversal server zone that connects to the VCS Control traversal zone
set up in the previous step.

Step3  In this new VCS Expressway traversal server zone, set media encryption to Force unencrypted.

Step4d  On VCS Control set up a search rule (at higher priority than the search rule that uses the default traversal
zone) that matches WebEXx traffic e.g. match = .* @example.webex.com

Note  The above configuration ensures that whether the MCU encryption is enabled or not, that the video and
the presentation stay on separate channels. It also ensures the content from WebEx is not encrypted when
sent to the MCU (even though it is encrypted across the Internet).

Configuring Cisco Unified Communications Manager

The following section describes the steps required for configuring Cisco Unified Communications
Manager (Unified CM) for Cisco WebEx Enabled TelePresence. This configuration also supports a
deployments where endpoints are registered to Unified CM only or both Unified CM and VCS
Control/Expressway.

This section describes the following tasks:
e Prerequisites, page 4-4

e Configuring a SIP Trunk Between Unified CM and VCS Control, page 4-5

Prerequisites

To configure WebEx in Cisco Unified Communications Manager (Unified CM), the following are
required:

e Cisco Unified CM 8.6.2 or 9.1.1.

¢ Endpoints in the network are registered to Unified CM

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
[ 44 | oL-21352-02 |



| Chapter4 Configuring Call Control

Configuring Cisco Unified Communications Manager 1l

e Conferencing Bridge(s) to be used (MCU or TelePresence Server) are already operational within the
network and registered to VCS

e VCS Control is deployed in the private network

e To ensure optimum SIP audio and video connectivity between MCU and TelePresence Server and
the WebEx cloud, it is recommended to set region to permit a minimum of 1.3 Mbps.

e VCS expressway configured with the DNS zone.

Configuring a SIP Trunk Between Unified CM and VCS Control

This section describes how to configure the Cisco TelePresence Video Communication Server (Cisco
VCS) version X7.2.1 or later and Cisco Unified Communications Manager (Unified CM versions 6.1, 7
or 8 to interwork via a SIP trunk.

This is required for endpoints registered to Unified CM to participate in a Cisco WebEx Enabled
TelePresence meeting and to call endpoints registered to VCS Control. In addition, make sure that the
Unified CM neighbor zone in Cisco VCS is configured with BFCP enabled.

The configuration steps are detailed in the Cisco TelePresence Cisco Unified Communications Manager
with Cisco VCS (SIP Trunk) Deployment Guide at the following location:

Cisco VCS and Unified CM Deployment Guide (Unified CM 8.6.x, 9.x and VCS X7.2).

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
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CHAPTER 5

Configuring Certificates on Cisco VCS
Expressway

Revised: April 2014

Introduction

A

This chapter describes the best practices for configuring certificates on Cisco VCS Expressway.
There are three parts to the configuration:

e Generating a certificate signing request (CSR)

e Installing the SSL Server Certificate on the VCS Expressway

e Configuring the Trusted CA List on the VCS Expressway

Both VCS Expressway X7.2.2 and X8.1 are supported. There are important differences in how each are
configured, which are noted in the procedures that follow.

Caution

Customers using Static NAT on VCS Expressway X7.2.2 are highly recommended to not upgrade to
X8.1. If you are using Static NAT with X8.1, refer to the recommended workarounds in VCS Expressway
X8.1 Encryption Issue and Workarounds.

VCS Expressway X8.1 Encryption Issue and Workarounds

There is an issue with the Encrypt on Behalf feature in VCS Expressway X8.1 when using Static NAT.
Because VCS Expressway X8.1 uses the Ethernet 2 IP address for the media part in SDP, the media part
of calls will fail. (Caveat ID: CSCum90139). Customers using Static NAT on their VCS Expressways
running X7.2.2 are urged not to upgrade to X8.1 until a maintenance release fixes this issue.

If you are using Static NAT on VCS Expressway X8.1, Cisco recommends one of the following
workarounds:

¢ Downgrade VCS Expressway to X7.2.2.

e Reconfigure VCS Expressway X8.1 to not use Static NAT.

e Use VCS Control to Encrypt on Behalf instead of VCS Expressway.
To use VCS Control to encrypt on behalf, do the following:

[ oL-21352-02
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B Videos Available

Step1  On MCU, turn Encryption OFF for all conferences.
Step2  On VCS Control, change the dedicated WebEx Traversal zone to Force Encrypted.
Step3  On VCS Expressway, change the dedicated WebEx DNS zone to Encryption Auto.

Videos Available

The entire configuration process for VCS Expressway 7.2.2 is also described and demonstrated in the
following video series:

Configuring Certificates on Cisco VCS Expressway for WebEx Enabled TelePresence

Supported Certificates

Make sure you submit your certificate signing request to a public certificate authority that issues a
certificate that WebEx supports.

Note  Self-signed certificates are NOT supported.

WebEx supports certificates that are issued by specific Root Certificate Authorities. Certificate providers
may have multiple Root Certificate Authorities and not all may be supported by WebEx. Your certificate
must be issued by one of the following Root Certificate Authorities (or one of their Intermediate
Certificate Authorities) or the call from your VCS Expressway will not be authorized by WebEx:

e entrust_ev_ca

e digicert_global_root_ca

e verisign_class_2_public_primary_ca_-_g3
e godaddy_class_2_ca_root_certificate

¢ Go Daddy Root Certification Authority - G2
e verisign_class_3_public_primary_ca_-_g5
e verisign_class_3_public_primary_ca_-_g3
e dst_root_ca_x3

e verisign_class_3_public_primary_ca_-_g2
e equifax_secure_ca

e entrust_2048_ca*

e verisign_class_1_public_primary_ca_-_g3
e ca_cert_signing_authority

e geotrust_global_ca

e globalsign_root_ca

e thawte_primary_root_ca

e geotrust_primary_ca
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Generating a Certificate Signing Request (CSR)

e addtrust_external_ca_root

Note  This list may change over time. For the most current information, contact WebEx.

*To use a certificate generated by entrust_2048_ca with Cisco VCS Expressway, you must replace the
Entrust Root CA certificate in the trusted CA list on the Cisco VCS Expressway with the newest version
available from Entrust.

You can download the newer entrust_2048 ca.cer file from the Root Certificates list on the Entrust web
site at the following URL.:

https://www.entrust.net/downloads/root_index.cfm

A

Caution  Wildcard certificates are not supported on VCS Expressway.

Generating a Certificate Signing Request (CSR)

To generate a certificate signing request, do the following:

Step1  In VCS Expressway:
e X7.2.2, go to Maintenance > Certificate management > Server certificate.
e X8.1, go to Maintenance > Security certificates > Server certificate.

Step2  Click Generate CSR.

Cisco WebEx Enabled TelePresence Configuration Guide
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B Generating a Certificate Signing Request (CSR)

aliarfis
CISCO Cisco TelePresence Video Communication Server Expressway

Status System VCS configuration Applications Maintenance ?)Help o« Logout
Server certificate You are here: Maintenance » Certificate management » Server certificate
Server certificate data !
Server certificate PEM File Show server certificate
Currently loaded certificate expires on Dec 12 2014
Reset to defauit server ceriificate |

Certificate signing request (CSR) |

Certificate request There is no certificate signing request in progress
Generate CSR
Upload new certificate |
Select the server private key file [ Browse... | i

Select the server certificate file | Browse... | i

Upload server certificate data
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Generate CSR

_I Generate Certificate Signing Request

Generating a Certificate Signing Request (CSR)

You are here: Maintenance » Certif|

Common name

Common name as it will appear

Subject alternative names

Additional alternative names (comma separated)
Alternative name as it will appear

Key length (in bits)

Country

State or province

Locality (town name)

Organization (company name)

Organizational unit

[ FRDNofVC5 4| i
xyz-vcse-1.example.com

[ None | 1

I
xyz-vcse-1.exampla.com
[ 2048 3+ i

=|US | (i

# | california

| San Jose

* | Example

i-lm

Generate CSR

Step3  Enter the required information for the CSR and click Generate CSR.

After clicking the Generate CSR button, the Server Certificate page is displayed and a message
indicating that CSR creation was successful.

Note  The private key is automatically generated as part of the CSR creation process. DO NOT click the option
to Discard CSR, this will force you to regenerate the CSR and the auto-generated private key will not
appear on the Server Certificate page.

[ oL-21352-02
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B Generating a Certificate Signing Request (CSR)

Server certificate You are here: Maintenance » Certificate management + Server certificate

i/ CSR creation successful: Certificate Signing Request saved to tandberg/persistent/certs/csr.pem.

Server certificate data |

|
Server certificate PEM File Show server certificate
Currently loaded certificate expires on Dec 12 2014

Reset to default server certificate |

Certificate signing request (CSR) |

Certificate request PEMFile View | Download

Generated on Apr26 2013

Discard CSR

<| Upload new certificate |

I
Select the server private key file System will use the private key file generated at the same time as the CSR.
Select the server certificate file | Browse... | i

Upload server ceriificate data |

Step4  In order to complete the CSR process and receive a signed certificate from a supported public certificate
authority (CA), you must download the CSR by clicking Download.

Most certificate authorities will require the CSR to be provided in a PKCS#10 request format (Shown
below).
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Server certificate You are here: Maintenance » Certifice

w1 . CSR creation successful: Certificate Signing Request saved to /tandberg/persistent/certs/csr.pam.

Server certificate data |

]
Server certificate PEM File Show server certificate
Currently loaded certificate expires on 0606 | ] CSR-10

MIIDLDCCARQCADAWE JERMBECATUEAWYYIRNLMWIMACLEY AN LLTEWYZ LZV28uY20t
MO =wCOYDVONGEWIYUIZE TMEEGATUEC Awk.02F 2ol ZvemBnY TERMABGALLUEBww TLZFu
Reset to default server certificate | TEpyc2llDi AMBEGNVYBAOMBUNpCZNYMRAWDG Y DYOOLDAADVECQRUIZUM I TET jANEQkg
hk i GIWABANEF AADCAQGAMI IBECOKCANEAUGT 3EMAVEYNZy Khak Dhy+ZEXPDH4T QL4
fULpgtbEBd/z143d1b7/1+UnM I SARN3dekat STLhZ7Tvh3VghvRf Gy o3t ZwuaFHy
bk MxBUSZUhnT mPHC W pF ZKoG95h {0 JREEYNE43ZqkeVBUKNIT I 7nkD+ Vv ThHA
3JInzFECEChaKEKER ] T BbRgYweplny ToNIZYEtm3h i thHGhZFEv Xk TqINeEA LDy
Certificate signing request (CSR) I 269Pq jdiBERySHK 7 Gr LORgEUORYUgP JHELUgOHOY 1MW ek 6xvrgEf LACan,/ 1551 T

SybeEbiZfmrMHAF+/Z1rfutph lzh L 1Y 2AYEzax<ECbbn0y sBRNYESw I DAQABOGAW
aw EoZ ThwcNAQKOMY 4wl DAJBONYHRMEA J AAMASGALUADWOE A I F4DAABgHYHSLUE

Certificate request F jAUBQor BOEFBOCDADY TKwYBEQUHAW I wIwYDYRAREEWWGo LYY 3RAL WY mdC 12y 3N L
LTEUYZ LY 28U 2t MABGC S5 T b3D0EEEALALS IBAQBNGUNT4 L DigbSPYy P TI0YH
Generated on hwilxY 20+ 908k gy IbzME 1 5g+GKMORCy B bEEEQE3RYD2 vz thd jshubrpSrgld

mcld 3 IsPIELIEXEgoeaT47abhY xoGaxd?neMUT3pEqG5w fckax IMEZRFE j16MbH
RaBgPMD: Tk zbolt2MdBW 3noBusx: 020 A A sKOMKdwe Lk Y Ep+NoquBshY ToKEAG T
1jgEembeHYxEHwLExnpf v T 132860 1 RzbyLHpMNnW:YOuzF 4800+ 1 JkcMIOYRD

Discard CSR RaWdelz+wuy 0 00RHKELUGMS w4 L foc i [04dMIr D L3mENPE smkvhET Ktz 26HT 4

Upload new certificate

Select the server private key file System will use the private key file generated at the same time as the CSR.

Step5  Submit the CSR to your public CA.

Note  Important: Make sure your public CA provides you with an SSL server certificate that includes both
Server and Client Auth keys.

Once you’ve received the SSL server certificate from your public CA, you are ready to install it on the
VCS Expressway.

Installing the SSL Server Certificate on the VCS Expressway

Note  Before installing the server certificate on the VCS Expressway, make sure it is in the .PEM format. If
the certificate you received is in a .CER format, you can convert it to a .PEM file by simply changing
the file extension to .PEM.

A

Caution  The server certificate must not be stacked along with the root or intermediate CA Certificates.

To Install the SSL server certificate on the VCS Expressway, do the following:

Cisco WebEx Enabled TelePresence Configuration Guide
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Installing the SSL Server Certificate on the VCS Expressway

Step 1

(Recommended) Open the server certificate in a text editing application such as Notepad and verify that

you see a single certificate (Noted by Begin and End Certificate brackets).

B server.cer - Notepad E@@

File Edit Format \Aiew Help

————— BEGIM CERTIFICATE-——-—-

MITE3]CCABAgAWI BAGTKLA/ZRwWAAAAMM /ZANBGK ghk 1 GOwW0BAQUF ADAUMR Y WFAY D
VQOKEWLDaxM] hyBETexnN0ZwWl ZMROWE DY DWVQQDEWE Daxn j hyBTUONEM | AeFwlxMjEy
MTIXODIWMTEaFw)XMDEYMT I x0DMyMTEaMHoxXC 24 ] BQNVEAY TATWTMREMWEQY DVOOT
EwpDwx pZmenylm 1 hMREwWDwY DVOOHEWh T wd gSm9zZTEOMAmMEAL UEChMFQZ 12y 28X
ECAQBQNVBASTBUNURYBFR 10X I TATBYNVEAMTGGNOZYL 1ZN0T dmNZZS0xLMMAC 2 My
LMy B TCCASTwDy JK0Z v CHAGEBBQADGHEPADCCAQDCHOEBAL+TE0 Ui 02+00sd
600 sROddvwHIRZEDGx x 10pvSR1calr TFM7 2N IGH, 0T, 3pg Sk HIKZKADYD ] 2 0w
ZPP h3+YGOyﬁ$KEj2xi?YrXNxNDDUXSLSJNBPO PRGFTIT S pAZUHr =414 wiipUbOE
dIxMGSazZwoPwl 78FOWI et CS7GKOWANTZGCEN2 K ADR 7MM 5 iCM 5 dg2 GHT +w2 Q00
ITIWTw3CQ+PD 28,4 uwy S 1g0 IwRmOTqupzebvvzcC 5,/ OLF97 SoNnuxQz, Hy/ Y 0s ovF
agyohUGITCwWaUbHT ggarxy+8T 3L T pwsx 5 2wk yMygmoylalovnESESTKMOazMFSq
TFCedCsCAwEARADC ADAWNGSMANGAL UHEWER, WO MAAW WY DVROPBAQDAGXOMDS G
ALUHIG00MDIGCCSGAQUFBWMBBNY BYEFBQCLADY I KW BEQUHAWUGCC SGAQUF BwMG
Bygr BUEFBOCDEZA] BONVHREEHDAAORR ] dECTZW2ZOLX2 ] c2UEME5 ] axhi by 5 i b2 Ow
HQ‘FDVROOBBYEFPbtWZXOjYFQmCOONSCOTCSUnB+YMBBGAlUdIWQYMEIEIAFMEWEAEI]V
BBhfHIBKSyPHOOLXXES FMEAGATUHWS SMD Cwh aAzoDGGELZ hOdHABLy S5 d3 cuy2 Tz
Y2EUY2OTLIN] Y 3vyaxRILIBrassjcmwecs NjYTI LY 31sMEQGCCs GADFEWEBBEEW
PZASBOLrBOEFBQCWADY xaHROCDOVLId3dy 5] axNiby5jh20veavidpdHkveGtp
L2N1CnRZLBNZYEEyLmN]CjECBgNVHSAEVTETMFEGC1SGAQQECRUEAQAWQZBEBQ?F
BgeFBQcCARY1aHROCDoVL3d3dySjaxnibysib2ove2vid=dpdHkvcat pL3BvbGT]
awvzL2 TuzEve LmhObwwwDdy IK0ZI hv CHAGEFBOADOEBAL AFCDvziwxBi2ghd ac
ebJOb5t0v2+UlI1dwf9+d4iu0jIDnYDsnﬁdeZIDRYEZC?SsE]%EiSFEx+c20hy1
VHY1eBAB41SSEEDONd X2V MR+ pavhnC Py aey TxvitCdwxor FwoR,MugSrlSay
AWEKC] SNgDxBheapwTGSImimxd Tpzay 0l woojdosw3 s 9161wy Dad qUR+ZK0a0
My pEx sy BXUwH7 Zp0 Tt gHY3M Ove3TnSg7404 ITSCOPUXPFEBEZ Lwz] 1dcINg 5
BmMIgooamsiER7AbbHCOE SQNOKUKRZPrMZM7 eFQpRC34 2k casdraceh UFE39rcdvp
asc=

You may also want to verify that the validity of the server certificate by opening it as a .CER file. Here

you should observe that the Issued to field is that of the VCS Expressway server.

[l Cisco WebEx Enabled TelePresence Configuration Guide
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Certificate

General | Details | Certification Path |

L
Certificate Information

This certificate is intended for the following purpose(s):

* Ensures the identity of a remoke computer
+1.3.6.1.4.1.9.21.1.1.0

* Refer to the certification authority's statement For details,

I Issued to: xyz-voze-1.examplecom I

Issued by: Exarnple S5CA2

valid from 12/12/2012 to 12/12/2014

Install Certiﬁcate...] lIssuer Statement ]

Tip It is worth noting whether the CA that issued the certificate uses an intermediate CA or issues/signs
certificates from a root CA. If an intermediate CA is involved then you’ll need to “stack” or add the
Intermediate CA Certificate to the Trusted CA Certificate.

Cisco WebEx Enabled TelePresence Configuration Guide
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M Installing the SSL Server Certificate on the VCS Expressway

Step 2

Step 3

Note

Step 4

General

Certificate

Certification path

Details | Cettification Path | Root CA Certificate

DST Root CA X3
L [E=] Example SSCA2

—a}— Intermediate Certificate

xample.com

Server Certificate

Cerkificate status:

Wiew Certificate

This certificate is O,

In VCS Expressway:

e X7.2.2, Go to Maintenance > Certificate management > Server certificate.

e X8.1, Go to Maintenance > Security certificates > Server certificate.

Click Browse and select the server certificate that you received from the public CA and click Open.

The server certificate must be loaded on to the Expressway in the .PEM certificate format.

Click Upload server certificate data.

[l Cisco WebEx Enabled TelePresence Configuration Guide
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Server certificate You are here: Maintenance » Certificate management » Server certificate

(i, CSR creation successful: Certificate Signing Request saved to tandberg/persistent/certs/csr.pem.

Server certificate data !
Server certificate PEM File Show server certificate
Currently loaded certificate expires on Dec 12 2014

Reset o default server certificate |

Certificate signing request (CSR)

Certificate request PEM File View | Download

Generated on Apr 26 2013

Discard CSR

Upload new certificate |

Select the server private key file System will use the private key file generated at the same time as the CSR.
Select the server certificate file

Uplaad server ca-tmme data

After uploading the server certificate, you’ll see a message at the top of the page indicating that files
were uploaded.

Cisco WebEx Enabled TelePresence Configuration Guide
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M Configuring the Trusted CA Certificate List on the VCS Expressway

Server certificate You are here: Maintenance » Certificate management» Server certificate

i/ Files uploaded ‘

s oo Certificate info: This certificate expires on Dec 12 2014. ‘

Server certificate data

Server certificate PEM File Show server certificate

Currently loaded certificate expires on Dec 12 2014

Reset to default server certificate

Certificate signing request (CSR) |

Certificate request I There is no certificate signing request in progress I

Generate C5R

Upload new certificate

Select the server private key file |' Browse... '| L

Select the server certificate file |' Browse... '| i

Upload server certificate data

Configuring the Trusted CA Certificate List on the VCS
Expressway

The version of VCS Expressway you are using will determine how you configure the trusted CA
certificate list.

VCS Expressway X7.2.2

The default trusted CA certificate list for VCS Expressway X7.2.2 contains 140 certificates. It is very
likely the public root CA that issued your server certificate is already part of the default trusted CA
certificate list.

For details on how to configure the trusted CA certificate list on VCS Expressway X7.2.2, go to
Configuring the Trusted CA Certificate List on VCS Expressway X7.2.2.

VCS Expressway Upgraded from X7.2.2 to X8.1
If you upgraded your VCS Expressway from X7.2.2 to X8.1, the trusted CA certificate list from X7.2.2
will be retained.
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Configuring the Trusted CA Certificate List on the VCS Expressway ||

For details on how to configure the trusted CA certificate list on VCS Expressway upgraded from X7.2.2
to X8.1, go to Configuring the Trusted CA Certificate List on VCS Expressway Upgraded from X7.2.2
to X8.1.

VCS Expressway X8.1

If you are using a freshly installed VCS Expressway X8.1, you will need to load your own list of trusted
CA certificates, because it does not (by default) contain any certificates in its default trusted CA
certificate list.

In addition, you will need to add the root certificate used by the WebEx cloud to the default trusted CA
certificate list on your VCS Expressway, which is DST Root CA X3.

For details on how to configure the trusted CA certificate list on a freshly installed VCS Expressway
X8.1, go to Configuring the Trusted CA Certificate List on VCS Expressway X8.1.

Configuring the Trusted CA Certificate List on VCS Expressway X7.2.2

If the default trusted CA certificate list is not currently in use, it is recommended that you reset it back
to the default CA Certificate. This will simplify the process of ensuring the required certificates are in
place.

Resetting the Trusted CA Certificate List on VCS Expressway X7.2.2

To reset the trusted CA certificate list on VCS Expressway X7.2.2, do the following:

Step1  Go to Maintenance > Certificate management > Trusted CA certificate and click Reset to default
CA certificate.

Trusted CA certificate You are here: Maintenance » Certificate management+ Trusted CA certificate

1, CA certificate reset: Successfully reset trusted CA certificate list to default.

Upload

Select the file containing trusted CA certificates Browse... 1

CA certificate PEM FiI% Show CA certificate

Upload CA certificate || Reset to default CA certificate

Note  Your VCS Expressway must trust the certificate issuer of the server certificate that’s passed by the server
during the client/server SSL Handshake, in this case the server will be the SIP Proxy in the WebEx
Cloud.

The default trusted CA certificate list on the VCS Expressway already contains the public root CA
Certificate for the server certificate that the cloud will present. The root CA for the WebEx cloud is DST
Root CA X3 with an intermediate CA of Cisco SSCA2.

If the server certificate was issued by the root CA (rather than an intermediate CA), it is likely that the
root certificate is part of the default trusted CA list.

Cisco WebEx Enabled TelePresence Configuration Guide
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W Configuring the Trusted CA Certificate List on the VCS Expressway

Step2 It is best practice to verify that the proper root certificate is present. You may do this by clicking Show
CA certificate.

This will open in a new window displaying the default Trusted CA list that is currently loaded on the
VCS Expressway.

Step3  Search for the root CA that issued the server certificate.

(" https:fictg-eft-vese-1.cisco.com/download?file=CA_CERTIFICATE - Internet Explorer, optimized for Bing and MSN

RDCCRQGngEBRNletA5+Dx5C116tluw/W/az“kRyl13&ezpfgSlexchNXY{wzCkrshlachSR -
BaiRVhECO4+Ar9NuuYS6JEIlrbLger 3VNSVINYyPiBFo3UIMXEuLRYEZ+LOERY / YXIQvLkcAbmXuZ
Vg2vTtKE8R1fjeUlTNIknJITesezpWET4Tt83avkGtrAjFGATvO 1 PubNCAdEGQET jdyAYveVgUSISnFO
YEWe2yMZeVYHDD9iClywarS4+FEyUM1nBOHTE4Y4+L3yvasHTHLO7TADWWuwJKZtkIVvEcupdMSi3y95e
e++U8Rs+yskhwelWYAggiSlt3m/V+11U0HGApwPFC40es/CgecZlUCAWEARaOE] DCEATAPEGNVHRME
CDAGARQH/AgEKMAsGA1UdDWQEAWIBEjAdBgNVHQ4EFgQU4 3Mr 38 20KAze 3b0kynmd j rvoMI kwEQYJ
YIZIAYR4QgEBEBAQDAGEGMDeGALUdHWwWMCAWwLEAqoCiGImhOdHAGLY93d3cu¥2VydHBesdXMuY2 93¢
LONSTC9ibGFzczIuY3JeMAOGCSgGSIb3DQEEBQUAR4 IBAQCAVM+IREnL39R/ANIWMZK191EBKOVD
PAGIROkkHe,/nFLOgtSoBAPStn9ul3NE0YtaleF3nSQRIQWhEyEFCE 2/ N pBHVG —
TtMTZGnkLuPT553ImabglZvOoGtd/v] ZOUIHRFCEPFSOD'JSwlquidDDEB"!EYOJN
TUCmnYROCbncHoUW2ikbhiMAybuJdfmeAi B4vFLQDJIRgybwOaRywwwlbGp0ICcBvg FMd:|DSTHomEAX3 |
F A1 IMwrh3EWBkIJtN3X3nSTLNXMhglfil 903EXNglvnaeGlknPGTZQIv4ISpd4FIUCY —
17+ijrRU [ Mateh whale ward anly [ Hatch case

Highlight all matches

Previous Hext

MIIDSjCCAjKgAWIBAgIQRE4wgNaj JTqIMDmGLvhhazANBgkghkiGOw0BAQUFADA
ExtEaWdpdGFsIFNpZ2 5hdHVyZ5BUcnVzdCBDby4xFzAVBgNVBAMTDKRIVCBSb2 90IENBIFgzMB4X
DTAWMDkzMDIXMT IxOVoXDT IxMDkzMDEOMDEXNVowPzEKMCIGALIUEChMERGInaXRhbCBTaWduYXR1
enUgVHI1le3QgR2 8uMRewFQYDVRRDEWSEUL1QgUmAvdCEDRSBYMzCCASIwDQYJKoZThveNAQEBBQAD
ggEPADCCAQoCggEBAN+veZdQCINXtM=iZ faQguzHO yxrMMpb THnDf cdAwRgUi+DoM3 ZJKuM,/ IUmT
rE40rz5Iy2¥u/NMhD2XSEtkyi4z193ewEnullcCIobme T¥MuegwEHo0i fooUMMOR0OEgQOL1SCIHY
UL2AZd+3UNCDyCKIYepLY YHaUmuSowJLGii £SK0eDNoJ J4XLh TdINbriggy6 ScK3FCxolkHRY
x¥tggzTWMIn/SWgTelRQLyNau7Fgekh4 9ZLOMxt+/ yUFWwTBZy15bsOFUSQ9DE,/RheQPGXE9Wama0d
utolucbY38EVAIQr2mTxPiT1XAicFNaDaeQQmxlkgti1X44+U9ms/wAl 0CAWEARaNCMEAWDwWYDVROT
EQH/BAUWAWER/ zAOBgNVHQEBALfBEBAMCAQYWHYDVROOBEYEFMSn=2aRTLHHG2 4+ FLEHY / 2BVghYkQ
MAOGCSgGSIb3DQEBBRUAR4IBAQCiGiybFWwBogRTUKGY 30r4Dxz 9 LwwmglSBd4 81 ZRNI+DTI6%9ikug
dB/OEIKcdBodfpga3csTSTHgROSREcz8 faXbauX+5v3gTt23ADglcEmvEuNrAvHRAoSZyEQEXKIE
GBSYGVEeAlrwDPGxrancHYalbumRSYbE+rlmMepZWE TipxZzREsrzdmwiNOjP41ZLScE8PDHIvhEbw
RLtTcmlDSS5ZImlJntlir/md2cXibDadWFEBMSIDGFoggCWiBH4d1QBTWCCZARGZRIYJeWvIjJEubS
fZGL4TOyiWWOEXyRV3baxbYoObEVZRzI 9neWaggNdwvYkQsEjgfbEbYKTp2CNTUR

______________ el

If the server certificate is issued by the top-level root CA and NOT by an intermediate CA and the valid
root CA certificate is present in the default trusted CA certificate list, then certificate configuration on
your VCS Expressway is complete.

If the server certificate is issued by an intermediate CA, go to the next section.

Note If the certificate for the top-level root CA that issued your server certificate is not part of the default
trusted CA certificate list, you must add it using the same procedure that is described for stacking the
intermediate CA certificate, detailed in the next section.
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Stacking the Intermediate CA Certificate in the Trusted CA Certificate List on VCS Expressway X7.2.2

In some cases, root CAs will use an intermediate CA to issue certificates.

If the server certificate is issued by an intermediate CA, then you’ll need to add the intermediate CA
certificate to the default Trusted CA list.

Figure 5-1 Server Certificate in .CER File Format

Certificate

General | Details | Certification Path LRoot CA Certificate

Certification path

DST Root C& X3 . ]
[=] Example 55Ca2 —aif— Intermediate Certificate

Example.cam

Server Certificate

‘Wiew Certificate

Certificate status:

This certificate is QK.

Unless the public CA provided you the exact intermediate and root certificates that must be loaded, you
can retrieve them from the server certificate. In some cases this is a better approach to ensure you’re that
you’re stacking the correct intermediate CA certificate.

Step1  Open the server certificate as a .CER file (see Figure 5-1)

Step 2 Click the Certification Path tab, double-click the Intermediate Certificate.
This will open the intermediate CA certificate in a separate certificate viewer.

Step3  Make sure the ‘Issued to’ field displays the name of the Intermediate CA.

Step4  Click the Details tab followed by Copy to File...

Cisco WebEx Enabled TelePresence Configuration Guide
[ oL-21352-02 .m
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Certificate |1||£| Certificate

General | Details | Certification Path GBHEFa'IDetals Certification Path |

_
Certification path
.
03T Rook C4 =3 Certificate Information
Cisco S5CA2
~{=] ctg-eft-vese-1.cisco.com This certificate is intended for the following purpose(s):

* Ensures the identity of a remate computer
* Protects e-mail messages

Double-click +1,3.6.1,4.1,9.21.1,1.0

* Refer ko the certification authority's statement For details,

Issued bo:  Cisco SSCAZ

Yiew Certificate

Certificate skatus:

This certificate is QK.

Issued by: DST Rook CA X3

valid from 10/Z1/2010 ko 10/22{2015

Issuer Stakement

The ‘Welcome to the Certificate Export Wizard’ appears.
Step5  Click Next.

Step 6 Choose Base-64 encoded X.509 (.CER) as the Export File Format and click Next.

Certificate Export Wizard

Export File Format
Certificates can be exported in a wariety of file Formats,

Select the format you want to use:

() DER encoded binary ¥.509 {,CER)

I (3) Base-64 encoded 509 {.CER) I

() Crvptographic Message Syntax Standard - PECS #7 Certificates ( P7E)

Include all certificates in the certification path if possible

Personal Information Exchange - PKCS #12 (PFX)

Include all certificates in the certification path if possible
Enable strong protection (requires IE 5.0, MT 4.0 5P4 or above)

Delete the private key if the export is successful

[ < Back IL Mek = J[

Cancel

Step 7 Name the file, click Next, and Finish.

[l Cisco WebEx Enabled TelePresence Configuration Guide
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[¥]

Certificate Export Wizard

File to Export
Specify the name of the file vou want to export

File name:

C:'p,intermediate.cer | [ Erowse. ..

[ < Back ” Mext = ][ Cancel l

Step8  Copy the default Trusted CA list from the VCS Expressway by going to Maintenance > Certificate
management > Trusted CA certificate and clicking Show CA Certificate. In the window that opens,
select all contents.

Step9  Paste the contents into a text editing application such as Notepad.

Step10  Open the intermediate.cer file within a new window of your text editing application and copy the
contents to your clipboard.

Step11 Do a search for the existing root CA certificate within the text file that contains the contents of the default
Trusted CA list.

Step12 Paste the intermediate CA certificate above the root certificate.

Step13  Save the text file as .PEM file (Example: NewDefaultCA.pem)

Cisco WebEx Enabled TelePresence Configuration Guide
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I ca.txt - Notepad

Eie Edt Format Yiew Help
ADCCAQOCHYEBANK] 1T AS4+DXSCHRET 1 Jww/uz7kRyLl134 ezpfgsil s v cOorKwzCk TsALBCgoSR A
SaiRvhKCO+Ar 9NUUYSEIEILr bLgzAr 3WNSVINYP18F03 UIMXEULRY E2+LOERY 0yl k cabmx<uz b
V2WTTKBR1IFJ e 7NIkNIITes ezpwE 7+ T 9avkGTra] FGATVOT PuchdEgETEdyﬁwquUSI SHFO
¥ FWe2 yMZevr HDDD JClywd S+ F Ty UMLhBOHTES v+ L 3yas HPwLO 7dDwwuw I KZTk IVECupdmMS i 3y35e
e++UBRs+ys khwowvagoi 97t3m/ v+ 1 TuoHGdpwPFC4 Des /CocZ TUCAWEAAR0B] DCBI TAPBONVHRME
COAGAQH/ AGEKMASGAT UdDWOEAWT BB J AdBONVHGA EFGQU4 3MT 3850k AZe3 hokynmd | rvoMIkwEgy ]
¥IZIAYb4QHEBEAQDAGEGMDCGAL UdHwOWMT S wlKAGDC T GIMNOdHABLY O3 d3 CUY 2 vy dHES dxMuy 25T
ILONsrcg bEFzczIuv3IsMADGC SgESIhEDOEBEQUAL] I BAQCNVM+IRBNL3 OR /AN WM K1 OLEBkOVD
POGIROkkxe,/nFLOgt SoBAPSENOUINTOYT AL cF3nSQRI gwhBy TFCR2 3, xxp8HVEIUtIKPidd3i1R
TTMTZGNKLUPTS5s Jmabguvoc;td/vj Z0UrMRFCEPFS00USWTFh1don3BvEY0INLDNYCTEX09] /+
FuCmnyY ROOBNCHOUW2 1k BhiMaybulfmsa] B4 vFLODIK gy bwOaRywwy 1hGp0 ICCBYgOhT 6BQMNWESSW
{,’1}|;1wrh3|<w3k:lt N3x3EN5TLNMhg 1 i1 203E0gIvnsGlknPGTZQIy4 I Spd FTUCYIRbpsda2 ENwT
7+ijrru
—————END CERTIFICATE-———- e — 7
Pasted Intermediate CA
-----BEGIN CERTIFICATE----- 8
MITFEZCCA+ QAWT BAQTQC GFBQOAAASYOOL RNAAAAAT ANBOk ghk 1 GEwOBAQUFADA/ Certificate
MSOWI Y DVQQKEXTEaWdpdGFs I FNpZ 2 SholHvyZSBUChvZoCEDhyd xF ZAVEQNVEAMT
DkRTWCBSh2 90TENBIFgZMBY D TEWMT AyMTESM] UyMT oxDTELMTAYMJ ESM Uyt Tow
LjEWMBOGALUECHMNG2 T2Y 28gU3 1 2aaVE CZEUMBIGATUEAXMLO2 12Y 28gULNDOTIw
QOETMAOGCSYGSI b3 DOEBAQUAAL TEDWAWLHEKADL BAQDRBsNFOERLUveEHkT1ToCD
XGkMOp/6EFGx35TpoQ i gmd Z0P+0IB21HOVYAHWI Y SeGIELYHSZCc80lsdj quaatd
bvShbgviB+aoFkaimFFzIfMt 1 Cugw] itB8d2002 I0VUNGKILI &P SdQELISCs-E%PpZ
CXour FYKZALZ 1Y FBEWNHT 1eAabimc dTnOP 593uxXLHOAESPRp 1t IdnPOsWE Eh(s
3T7n3MesUgxtsUiT59shsuot+CyTsDEENLagFHOKr e6MMOEVNXKr4 Aqt ILvSCEfy
k98n5SyaSEAYCOpSXIpLEGCWrwD] 2 3 xGUNKNoUT yMUdawhomeyDP2 xI07 XY polER
AGMEAAGT ggIOMIIccjAoﬁ;;wnqsmfal;amcmegY DVROTAQH,"EAgwﬁgEB?'WI B
ADBCBOMVYHSAEVTETMFEGC T SGAQQBCRUBAGAWGZBEBOYr BOEFBQCCARYLAHROCDOY
L3d3dy5jaxNibysi b20\.rc2v;d>(:ldekch‘t pL3BvbET] awvzL 2 TuZGva LmhObwerw
HQYDWR 0OBBY EFMawEAGy BBhTH S BK Sy pHOOT <65 TMDk GALUdH DAWLGQASOCGS
KGhOOHAGLY S cmwLi awR. 1 bnRdeNOLmvaSQELU_.RSTOQUQOFYMySi Cwwicl AY TRw'Y B
BOUHAGEEaDBMMCCGCCs GAQUFBZABhNT odHRWO T Bvb2NzcHRZLM EZws0cnvzdc s §
02 Owowy T ow'r BBQUHMAKGL Z2hOdHASLyShcHBZLM T kZwS 0cnvzdc 5 b2 Owem v dHmy
RFENULK OPVENBWDMUY 2yMIGUB gNVHS UE O wwg vk GCCS GAQUF BWMBBgar BQEFBQCD
AQYIKwY BEQUHANMGCCS GAQUFBWMEED O BOEFBQCDBQY I KwY BEBQUHAWYGCCSGAQUF
EWMHEQQrEgEFBQCDCAY I KwYBBQUHAWKGCT sGAQQEBT] CKAWEGC 1 SGAQQEY] ckawks
CisGaq0Bg] cuAgEGCSSGAQOBY] cvB AFBONVHSMEGDAWGBTEPTGK By X x+Tvhs5B1
/BOMY IWIEDANBGK ok 1G9wOBAQUF AAOCAQEAVT BUXDGTAwxvdwhir j +0e]p/8ckyb
OO 5G+ZVO702ZMPTVUYTMET Z2v 3 k 2mxaxrd 6imyyi SxwBNdPaxcip/Q5xdanixTnd 0
YSMWHKXHL CCAF A7 /MOKNICY OFL4BNO pOwBTDt 1 ghl2r maowed ycExwyr=MSHIrch
Fa4NdKr Wi TLAGLZE] GVMUAT 1IPLOGRMAOF ] SNNQASACTB7 oLMx ot e+v i gulfT
3vidodHzvly 3WZUR7orqaweyTaHEW] 240GrHI TmC J1CFfLczs] cksoxbgnfvnasz
SNIBIZIwxFsuxXXDOELhMZ IvLdmugUyxkToohrtLwkTk 5FkizGIIPmezuZg==
--=---END CERTIFICATE-----
DST ROOT CA X3
—————?EGIEJ CERTIFICATE----— i : i s i Existing Root
MIIDS]CCA] KgawI BAGIQRK+HwGNa] 17 gIMbmGLvhaaZaNE: GOwWOBAGUFADA MSQWI Y DVQQK ifi
ExtEawdpdGFsIFNpZ2 ShdHvyZ sBUCnvzdCBDhy4 szngr\rﬂamnkangbz QOIESEIIE z:gilx CA Certificate
DT AWMD K ZMDI XMT I xOWVOXDT I xMDk ZMDEMMDE X NVOWPZEKMCIGATUEChMbRG ThaxRhbCBT awduyxR1
cmUgvHILC3 Q002 SUMRCWFQY DVOODEY SEULGOUM Sy dCEDO SEYMZCCASIwDOY IK0Z Ihy CNAQEEBQAD
QOERADCCAQOC gEEIJleEuZdQCINxtMx12Fanﬁu2H0yxrmpb?NanchngU'l +DOM3Z KU,/ TUmT
re4orziIy2xu/Nmho2=sKktkyj4 2193 ewenul TcCI06mE 7xMuegwaMoc FoomMMORODEQOL] SCiHD
UL2AZd+3 w0 DyOKIYepLYYHs UmuSouILGT 1FSKoebNod ] J4-Lh7dINSbx qKﬁyﬁQcKS FCxalkHRy
KATQEZTWMI N,/ SwgT elalyNau7 Fgck hd SZLOMXT+/yUFw/ B2y lshs0FUSQe08,/RhcapGxatwamd Od
utoTuchy3IBEVATgr2m7xPi7LlxadcPnaDaagomxk gt x4 +U0m5,wa ] OCAwEAfa NCMEAWDWY DVROT
AGH/BAUWAWE B,/ ZA0BgNVHOBSBAT BEBAMCAQYWHOY DVROOBEY EFMSNS AR TLHHGZ2+F LkHX/ xBvghyka
MADGCSOESI b3 DOEBBGUARL TBAQC]GiybFwBCOR 7 UKGY 30r+DxZS0Lwwm 1 SEd4 91 ZRNI+DTE0T kug
de/oEIKcdBodfpga3csTSTMOROSRECZEFaxbaux+5v3 thZEﬂ.DqlcEnNEUXr'A\.rHR.QOSZySQ'EXkE'ml’E’
GBSYGEVBeAl rwDPGxr ancwyaLbumR oy bk+r ImMMEpZWET T pxZ2RBsr 2 Imwi0  P41ZL 3CBPDHI yh Sl
RLTTCMLDOSZIm] IntLlir /md2cxihDaIwFEMS IDGF ogoCw] BHE d1QR 7wCCZAAG2R ] VISWy T ] JEURS
FZEL+T Oy wWwi ey v3bgxby oo h3vZR zI onewagoNdwy Y kQsE ofbkbyk7p2CNTUG
----- END CERTIFICATE-----
DST ACES CA X6
--—---BEGIN CERTIFICATE-=----
MIIECTCCAVGOAWT Bnlt;ﬁqnvﬁzctadt 3is2adwod yv2TANBGk ghk 1 GOwOBAQUFADBBMGS wC Y DVIGGG
EwIWVUZEQMB4 GALUECRMXRG T naxRhbC BT awduy <Rl amugvHILc3axETAPEYNVEAS TCERTVCEBQOWVT o
If the root CA is not part of the default trusted CA list. Follow same procedure of stacking the
intermediate CA certificate.
Click Browse, find your newly created/stacked Trusted CA list and click Open.
Click Upload CA certificate.
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Trusted CA certificate You are here: Maintenance » Certificate management» Trusted CA certificate

i/ File uploaded: CA certificate file uploaded. File contents - Certificates: 141, CRLS: Q. Result

Upload

Select the file containing trusted CA certificates

CA certificate

{Users/johnsmith/Desktop/certificates/Tr| Browse... i

PEMFile Show CA certificate

Upload CA certificate |

Reset to default CA certificate |

Certificate configuration on your VCS Expressway X7.2.2 is complete.

For additional details on how to configure client/server certificates, including information about security
terminology and definitions, refer to the “Cisco VCS Certificate Creation and Use Deployment Guide
(X7.2)” at the following location:

https://www.cisco.com/en/US/docs/telepresence/infrastructure/vcs/config_guide/Cisco_VCS_Certifica
te_Creation_and_Use_Deployment_Guide_X7-2.pdf

Configuring the Trusted CA Certificate List on VCS Expressway Upgraded from

X7.2.2 to X8.1

If the default trusted CA certificate list is not currently in use, it is recommended that you reset it back
to the default CA Certificate. This will simplify the process of ensuring the required certificates are in
place.

Resetting the Trusted CA Certificate List on VCS Expressway Upgraded from X7.2.2. to X8.1

Step 1

Note

Step 2

To reset the trusted CA certificate list on VCS Expressway X8.1, do the following:

Go to Maintenance > Security certificates > Trusted CA certificate and click Reset to default CA
certificate.

Your VCS Expressway must trust the certificate issuer of the server certificate that’s passed by the server
during the client/server SSL Handshake, in this case the server will be the SIP Proxy in the WebEx
Cloud.

The default trusted CA certificate list on the VCS Expressway already contains the public root CA
Certificate for the server certificate that the cloud will present. The root CA for the WebEx cloud is DST
Root CA X3 with an intermediate CA of Cisco SSCA2.

If the server certificate was issued by the root CA (rather than an intermediate CA), it is likely that the
root certificate is part of the default trusted CA list.

It is best practice to verify that the proper root certificate is present. You may do this by clicking Show
all (PEM file).

[ oL-21352-02
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This will open in a new window displaying the default Trusted CA list that is currently loaded on the
VCS Expressway.

Step3  Search for the root CA that issued the server certificate.

(" https:fictg-eft-vese-1.cisco.com/download?file=CA_CERTIFICATE - Internet Explorer, optimized for Bing and MSN

RDCCRQGngEBRNletA5+Dx5C116tluw/W/az“kRyl13&ezpfgSlexchNXY{wzCkrshlachSR -
BaiRVhECO4+Ar9NuuYS6JEIlrbLger 3VNSVINYyPiBFo3UIMXEuLRYEZ+LOERY / YXIQvLkcAbmXuZ
Vg2vTtKE8R1fjeUlTNIknJITesezpWET4Tt8avkGtrAjFGATvO 1 PubNCAEGQET jdyAYveVgUSISnFO
YEFWe2yMZeVYHDDOiClywarS4FEyUM1nBOHTE4Y+L3vasHTWLOTdDWWuwJIJKZtkIvEcupdMSi3y9se
e++U8Rs+yskhwelWYAggiSlt3m/V+11U0HGdpwPFC40es/CgecZlUCAWEARaOE] DCEATAPEGHNVHRME
CDAGAQH/AgEFMA=GA1UdDwQEAWIBE] AdBgNVHQ4EFgQU43Mt 38 a0 Aze 3b0kynmd j rvoMI kwEQYJ
YIZIAYR4QgEBBAQDAGEGMDeGAIUdHWwWMC 4w LK AqoCiGImhOdHAGLY93d3cu¥2VydHBesdXMuY2 3¢
LONSTC9ibGFzczIuY3JeMAOGCSgGSIb3DQEEBQUAR4 IBAQCAVM+IREnL39R/ANIWMZK191EBKOVD
POGIROkkXe,/nFLOgtSoBAPStnOul3NE0YtaleF3nSQRIQWhEyEFCE2x/ XpEHVE —
TtMIZGnkLuPTS55sImabglZvOGtd/v] zOUIHRFCEPFSOD'J.SlebqidonBBVEYOJN
TUCmnYROCbncHoUW2ikbhiMAybuJdfmeAi B4vFLQDJIRgybwOaRywwwlbGp0ICcBvg FMd:|DSTHomEAX3 |
J A1 IMwrh3EWBkIJtN3X3nS 7L Mhglfil 903EXNgIlvnaGlknPGTZQIv4ISp4FTUcY —
17+ijrRU [ Mateh whale ward anly [ Match case

Highlight all matches

Previous Hext

MIIDSjCCAjKgAWIBAGIQRE4wgNaj JTqIMDmGLvhhazANBgkghkiGOw0BAQUFADR
ExtEaWdpdGFsIFNpZ2 5hdHVyZ5BUcnVzdCBDby4xFzAVBgNVBAMTDKRTIVCBSb2 90IENBIFgzMB4X

DTAWMDkzMDIXMT IxOVoXDTIXMDkzMDEOMDEXNVowPzEKMCIGALIUEChMERGInaXRhbCBTaWduYXR1

cnUgVHEJI1lc3QgR2 SuMRewFQYDVQRDEWSEU1QgUmAvdCEDQSBYMzCCASIWwDQYJKoZ ThveHAQEEEQAD
ggEPADCCAQoCggEBAN4+vEeZdQCINXtMxiZ faQguzHOyxrMMpb TNnDf cdAwRgUi+DoM3 Z JEuM/ IUmT
rE40rz5Iy2¥u/NMnD2X5Ktkyj4z193ewEnullcCldoame 7XMuegwGMo0i fooUMMOROOEQOL1SCiHS
UL2AZd+3UNODyCKIYepLY YHaUmuSouJLGii £SKCeDNaJ ) J4XLh7TdINSbxigRgy6 ScK3FCxolkHRY
xXtggzTWMIn/SWoTelQLyNauTFgeckh4 9ZLOMxt+/ vUFWwTBZy15bs0FUSQ9DE/RhecQPGXE9Wam40d
utolucbY38EVAjgr2m7xPi71XAicPNaDaeQQmukgtilX4+U%mS5,/whl 0CAWEARaNCMEAWDWYDVROT

BQH/BAUWAWER/ zAOBgNVHQEBALf BEBAMCAQYwHYDVROOBEYEFMSn=aRTLHHG2 4+ FLEHY / xBVghYkQ =
MAOGCSgGSIb3DQEBBRQUAR4IBAQC GiybFWwBogRTUKGY30r4+Dxz9LwwmylSBd4 21 ZRNI+DI69ikug
dB/CEIKcdBodfpga3csTSTHMgROSRE6cz8fabauX+5v3gTt2 3ADglcEmvBuXrAvHRA0SZy5QE6XKIE
GBESYGVEeAlrwDPGRrancWYaLbumRSYbE+r1mMepZWE TipxZzRE8srzdmwNOjP41ZLScEPDHIvhEDW
BLtTemlD95ZImlJntlir/md2cXibDadWFBMSIDGFoggCWiBH4d1QBTWwCCZARG2R) YTJasWvIjJEubS
fZGL4+TOyiWWOEXyXV3IbgxbYoObEVZRzI9neWaggNdwvYkQsEjgfbEbYKTp2CNTIUR

R R |
If the server certificate is issued by the top-level root CA and NOT by an intermediate CA and the valid
root CA certificate is present in the default trusted CA certificate list, then certificate configuration on
your VCS Expressway is complete.

If the server certificate is issued by an intermediate CA or if the certificate for the top-level root CA that
issued your server certificate is not part of the trusted CA certificate list, you must add it to the trusted
CA certificate list, as detailed in the next section.

Adding the Intermediate CA Certificate to VCS Expressway X8.1

In some cases, root CAs will use an intermediate CA to issue certificates.

If the server certificate is issued by an intermediate CA, then you’ll need to add the intermediate CA
certificate to the default trusted CA certificate list.
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Figure 5-2 Server Certificate in .CER File Format

Certificate

General || Details | Certification Path | Root CA Certificate

Certification path

DST Root CA X3 . .
. [E]Example 55CA2 = Intermediate Certificate

mple.com

Server Certificate

Wiew Certificate

Cerkificate status:

This certificate is O,

Unless the public CA provided you the exact intermediate and root certificates that must be loaded, you
can retrieve them from the server certificate. In some cases this is a better approach to ensure you’re that
you’re stacking the correct intermediate CA certificate.

Step 1 Open the server certificate as a .CER file (see Figure 5-2)
Step2  Click the Certification Path tab.
Step3  Double-click the Intermediate Certificate.

This will open the intermediate CA certificate in a separate certificate viewer.
Step4  Make sure the ‘Issued to’ field displays the name of the Intermediate CA.
Step5  Click the Details tab followed by Copy to File...

Cisco WebEx Enabled TelePresence Configuration Guide
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Configuring the Trusted CA Certificate List on the VCS Expressway

Step 6
Step 7

Step 8

Certificate

General I Details § Certification Path |

| I—

@
Certificate Information

This certificate is intended for the following purpose(s):

» Ensures the identity of a remote computer
* Protects e-mail messages
«1.36.1.415921.1.1.0

* Refer ko the certification autharity's stakement For details.

Issued bo:  Cisco S5CAZ

Issued by: DST Root CA X3

valid from 10§21/2010 to 10/22/2015

Issuer Statement

The ‘Welcome to the Certificate Export Wizard’ appears.
Click Next.

Choose Base-64 encoded X.509 (.CER) as the Export File Format and click Next.

Certificate Export Wizard X

Export File Format
Certificates can be exported in a wariety of file Formats,

Select the format you want to use:

() DER encoded binary ¥.509 {,CER)

I (3) Base-64 encoded 509 {.CER) I

() Crvptographic Message Syntax Standard - PECS #7 Certificates ( P7E)

Include all certificates in the certification path if possible

Personal Information Exchange - PKCS #12 (PFX)

Include all certificates in the certification path if possible
Enable strong protection (requires IE 5.0, MT 4.0 5P4 or above)

Delete the private key if the export is successful

[ < Back “. Mek = J[ Cancel

Name the file, click Next, and Finish.

Cisco WebEx Enabled TelePresence Configuration Guide
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Step 9

Step 10
Step 11
Step 12

Configuring the Trusted CA Certificate List on the VCS Expressway ||

[¥]

Certificate Export Wizard

File to Export
Specify the name of the file vou want to export

File name:

C:'p,intermediate.cer | [ Erowse. ..

[ < Back ” Mext = ][ Cancel l

Change the extension of your intermediate CA certificate from .cer to .pem.

For example: intermediate.pem

In VCS Expressway X8.1, go to Maintenance > Security certificates > Trusted CA certificate.
Click Browse, find your intermediate CA certificate and click Open.

Click Append CA certificate.

Certificate configuration on your VCS Expressway X8.1 is complete.

For additional details on how to configure client/server certificates, including information about security
terminology and definitions, refer to the “Cisco VCS Certificate Creation and Use Deployment Guide
(X8.1)” at the following location:

http://www.cisco.com/en/US/docs/telepresence/infrastructure/ves/config_guide/X8-1/Cisco-VCS-Certi
ficate-Creation-and-Use-Deployment-Guide-X8-1.pdf

Configuring the Trusted CA Certificate List on VCS Expressway X8.1

Because a freshly installed VCS Expressway X8.1, does not have certificates in its trusted CA
certificates list, you must add the following two certificates:

e The DST Root CA certificate (the root CA for the WebEx cloud)

e The CA certificate of the CA that issued your server certificate

[ oL-21352-02
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Adding the DST Root Certificate to VCS Expressway X8.1

Step 1

Step 2
Step 3
Step 4
Step 5
Step 6
Step 7

Your VCS Expressway must trust the certificate issuer of the server certificate that’s passed by the server
during the client/server SSL Handshake, in this case the server will be the SIP Proxy in the WebEx
Cloud, which is DST Root CA.

To add the DST Root certificate to the trusted CA certificate list on VCS Expressway X8.1, do the
following:

Go to: http://www.identrust.com/doc/SSLTrustIDCAAS_DSTCAX3.p7b

A page with the DST Root certificate contents appears with “----- Begin Certificate----- ” at the top.
Select and copy the entire contents of the page.

Open a text editor, such as Notepad, on your computer and paste the contents of the DST Root certificate.
Save the text file with an extension of .PEM. For example: dst_root_ca.pem.

In VCS Expressway X8.1, go to Maintenance > Security certificates > Trusted CA certificate.
Click Browse, select the DST Root certificate you saved in step 4 and click Open.

Click Append CA certificate.

Adding the Root or Intermediate CA Certificate to VCS Expressway X8.1

Step 1
Step 2

For the WebEx cloud to trust your VCS Expressway’s server certificate, you must add the root or
intermediate CA certificate for the CA that issued your server certificate.

Unless the public CA provided you the exact intermediate or root certificates that must be loaded, you
can retrieve them from the server certificate. In some cases this is a better approach to ensure you’re that
you’re stacking the correct intermediate CA certificate.

To add the root or intermediate CA to VCS Expressway X8.1, do the following:

Open the server certificate as a .CER file

Click the Certification Path tab. (see Figure 5-3)
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Figure 5-3 Server Certificate from Intermediate CA in .CER File Format

Certificate

Seneral | Details | Certification Path LRoot CA Certificate

Certification path

DST Root CA X3 . .
. [E]Example 55CA2 = Intermediate Certificate

mple.com

Server Certificate

Wiew Certificate

Cerkificate status:

This certificate is O,

Note  The server certificate example shown here is one issued by an intermediate CA. If your certificate was
issued by a root CA, you would only see 2 certificates (the root and server certificates).

Step3  Open the CA certificate:
e If your certificate was issued by a root CA, double-click the Root CA Certificate.
e If your certificate was issued by an intermediate CA, double-click the Intermediate Certificate.
This will open the CA certificate in a separate certificate viewer.
Step4  Make sure the ‘Issued to’ field displays the name of the root or intermediate CA.

Step5  Click the Details tab followed by Copy to File...

Cisco WebEx Enabled TelePresence Configuration Guide
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Configuring the Trusted CA Certificate List on the VCS Expressway

Step 6
Step 7

Step 8

Certificate

General I Details § Certification Path |

e

®,
Certificate Information

This certificate is intended For the following purpose(s):

* Ensures the identity of a remate computer
* Protects e-mail messages
*1.353.6.1.4.1,9.71.1.1.0

* Refer to the certification authority's statement For details,

Issued to: Cisco 35CAZ

Issued by: DST Root CA X3

valid from 10/21/2010 to 10/22/2015

Issuer Statement

The ‘Welcome to the Certificate Export Wizard’ appears.
Click Next.

Choose Base-64 encoded X.509 (.CER) as the Export File Format and click Next.

Certificate Export Wizard X

Export File Format
Certificates can be exported in a wariety of file Formats,

Select the format you want to use:

() DER encoded binary ¥.509 {,CER)

I (3) Base-64 encoded 509 {.CER) I

() Crvptographic Message Syntax Standard - PECS #7 Certificates ( P7E)

Include all certificates in the certification path if possible

Personal Information Exchange - PKCS #12 (PFX)

Include all certificates in the certification path if possible
Enable strong protection (requires IE 5.0, MT 4.0 5P4 or above)

Delete the private key if the export is successful

[ < Back “. Mek = J[ Cancel

Name the file, click Next, and Finish.

Cisco WebEx Enabled TelePresence Configuration Guide
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[¥]

Certificate Export Wizard

File to Export
Specify the name of the file vou want to export

File name:

C:'p,intermediate.cer | [ Erowse. ..

[ < Back ” Mext = ][ Cancel l

Step9  Change the extension of your root or intermediate CA certificate from .cer to .pem.
For example: root.pem or intermediate.pem
Step10 In VCS Expressway X8.1, go to Maintenance > Security certificates > Trusted CA certificate.
Step11  Click Browse, find your root or intermediate CA certificate and click Open.
Step12 Click Append CA certificate.

Certificate configuration on your VCS Expressway X8.1 is complete.

For additional details on how to configure client/server certificates, including information about security
terminology and definitions, refer to the “Cisco VCS Certificate Creation and Use Deployment Guide
(X8.1)” at the following location:

http://www.cisco.com/en/US/docs/telepresence/infrastructure/ves/config_guide/X8-1/Cisco-VCS-Certi
ficate-Creation-and-Use-Deployment-Guide-X8-1.pdf

Cisco WebEx Enabled TelePresence Configuration Guide
[ oL-21352-02 .m


http://www.cisco.com/en/US/docs/telepresence/infrastructure/vcs/config_guide/X8-1/Cisco-VCS-Certificate-Creation-and-Use-Deployment-Guide-X8-1.pdf

Chapter5  Configuring Certificates on Cisco VCS Expressway |

B Configuring the Trusted CA Certificate List on the VCS Expressway

Cisco WebEx Enabled TelePresence Configuration Guide



CHAPTER

Configuring Cisco TelePresence Management
Suite

Revised: October 2015

Contents

This chapter describes how to configure Cisco TelePresence Management Suite (Cisco TMS) for Cisco
WebEx Enabled TelePresence meetings. It contains the following sections:

e Prerequisites, page 6-1

e Configuring the Cisco WebEx Feature in Cisco TMS, page 6-2

e Configuring WebEx Users in Cisco TMS, page 6-4

e Configuring Hybrid Content Mode for MCU in Cisco TMS, page 6-7

e Configuring Lobby Screen for TelePresence Server in Cisco TMS, page 6-8

¢ Configuring Conference Settings in Cisco TMS, page 6-9

e Configuring Single Sign On in Cisco TMS, page 6-11

e Supported Configurations for TMS to Schedule on Behalf of the WebEx Host, page 6-18

Prerequisites

e Cisco TMS software release 14.3.1 or later is required.

e Cisco TMSXE software release 3.1 or later is required, if using Microsoft Outlook to schedule
meetings.

There are two options for scheduling using Microsoft Outlook:
— Using the WebEx Productivity Tools Plug-In for Microsoft Outlook
- Using WebEx Scheduling Mailbox

e Cisco TMSPE software release 1.1 or later is required, if using Smart Scheduler to schedule
meetings

e The WebEx integration option key must be installed on Cisco TMS before configuring the WebEx
feature.

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
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~

Note Multiple WebEx sites are supported.

e MCU calls to WebEx support SIP only. The following settings must be configured for SIP:

— In Cisco TMS: Allow Incoming and Outgoing SIP URI Dialing must be set to Yes in the Cisco
TMS Scheduling Settings for each MCU used for Cisco WebEx Enabled TelePresence meetings.

— For MCU and TelePresence Server, refer to the Configuring Cisco TelePresence Management
Suite, page 6-1 for more information.

Configuring the Cisco WebEx Feature in Cisco TMS

To configure the Cisco WebEx feature in Cisco TMS, do the following:

Step1  Go to Administrative Tools > Configuration > WebEx Settings.

The WebEx Settings page appears. See Figure 6-1.

Figure 6-1 Enabling WebEx in Cisco TMS

at]nan)ns .
cisco TelePresence Management Suite

f¢ FPoral (4 Booking 3 honitoring I- Systems [ 11 Phone Books 4L Reporting /'-‘:f Adminis!

WebEx Settings “ou are here: + Administr

WiehEx Configuration

Enakle ehEx: ez v
Add WighEx To Al Conferences: e
Get WehEx Username fram Active Directory: Dizatled
Save
WehEx Sites

When there iz more than one site, Cizco TMS will use the default unless a paricular site iz specified inthe user's seftings.

Step2  Click Add Site.
The WebEx Site Configuration page appears. See Figure 6-2.

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
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Step 3
Step 4

Step 5

Step 6

Step 7

Step 8
Step 9

Configuring the Cisco WebEx Feature in Cisco TMS [l

Figure 6-2 Configuring a WebEx Site

aliafe. _
éll'j-'ICc:; TelePresence Management Suite

f¢ Poral . Booking &, Monitaring LE Swstems [T Phone Books 4 Repoding /-":fndminis
WebEx Settings

WiebEx Site Configuration

Site URL: https:flexample webax_ comfexample
Host Name: example.webex.com

Site Name: example

WebEx Participant Bandwidth: 2048 Kbps E|
Default Site: Mo E|

TSP Audio: Yes =]

Use Web Proxy. Mo El
Enable S50« Na E|
Connection Status: Connection OK

In the Host Name field, enter the hostname for the WebEx site.
In the Site Name field, create a name for the WebEXx site.
~

m The Site URL must follow this format: https://[HostName]/[SiteName]. For example:
https://example.webex.com/example.

For “WebEx Participant Bandwidth”, select the maximum bandwidth per meeting to allow from MCU
to WebEx.

a~

Note  Bandwidth can be limited in MCU and VCS.

(Optional) Default Site. If one or more WebEx sites already exist, you can designate the site as the
default WebEXx site, by selecting Yes.

S
Note  New users are automatically set to use the default site the first time they schedule a meeting with
WebEx.

Set “TSP Audio” to Yes if you are going to use TSP or PSTN audio.

~

Note  If Yes is selected for TSP Audio, Cisco TMS will only use TSP audio. SIP audio will not work.

Click Save.

In the WebEx Configuration section, do the following:
a. Set “WebEx Enabled” to Yes.

b. Set “Add WebEx To All Conferences” to Yes.
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Configuring WebEx Users in Cisco TMS

Step 10

Click Save.

Configuring WebEx Users in Cisco TMS

To schedule meetings using Cisco TMS, users must have a username and password that the server is
configured to trust.

Cisco TMS authenticates the following accounts:
e Local accounts on the Windows Server where Cisco TMS is installed
e Accounts the server trusts through domain membership and Active Directory (AD)

For each user that successfully logs into Cisco TMS, a new user profile is created based on their
username and the user is prompted to enter information into their profile. Existing Windows or AD user
passwords are used but they are not stored in Cisco TMS. If a user’s Windows/AD password changes,
they must use that updated password when logging into Cisco TMS.

User Requirements for Scheduling WebEx-enabled Meetings

l_ Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29

To schedule WebEx-enabled meetings using Cisco TMS, Cisco TMS users must have the following
stored in their Cisco TMS user profile:

e WebEx username

e WebEx password (unless single sign on is enabled)

e The WebEx site on which they have an account.
>

Note  This WebEx site must also be added to Cisco TMS, as described in Configuring the
Cisco WebEx Feature in Cisco TMS, page 6-2.

There are three ways to enable a Cisco TMS user’s account for WebEx scheduling:
¢ Administrator edits the Cisco TMS user’s profile.
For details, see Configuring a Cisco WebEx Enabled TelePresence User in Cisco TMS, page 6-6

e The Cisco TMS user edits their profile by logging in to Cisco TMS and clicking their username at
the bottom left corner of the Cisco TMS Web UI.

¢ Administrator enables ‘Lookup User Information from Active Directory, ‘Get WebEx Username
from Active Directory’ and (optionally) Single Sign On (SSO).

The benefits of having the Active Directory lookup features enabled are that the user account
information including WebEx username is automatically added to each new Cisco TMS user. WebEx
password must still be added by the administrator or user, however, if Single Sign On is enabled,
WebEx password is not required. With the Active Directory and Single Sign On features enabled,
only the WebEx site must be selected for the user, if there are multiple WebEx sites configured on
Cisco TMS. If there is only one WebEx site, Cisco TMS will use that site. If there are multiple sites
configured, Cisco TMS will automatically select the WebEx site designated as the ‘Default’, unless
the user’s Cisco TMS profile is edited to specify a different WebEx site.

oL-21352-02 |
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Configuring WebEx Users in Cisco TMS

For details, see Configuring Automatic User Lookup from Active Directory, page 6-5 and
Configuring Single Sign On in Cisco TMS, page 6-11

Configuring Automatic User Lookup from Active Directory

If you are using Active Directory (AD), you can configure Cisco TMS to automatically populate user
profile information. When you enable this feature, details about the user will automatically be imported
when they first access Cisco TMS and synchronized periodically. If you use a field in Active Directory
for WebEx username (e.g. the AD username or email address), you can configure Cisco TMS to import
the WebEx username as well by enabling the 'Get WebEx Username from Active Directory' feature in
the WebEx Settings page.

Configuring Active Directory Lookup in Cisco TMS

Step 1
Step 2
Step 3

Step 1
Step 2

Step 3

Active Directory Lookup imports and updates user information in Cisco TMS automatically. Optionally,
Cisco TMS can also import the WebEx username.

By activating the AD lookup, WebEx and Cisco TMS automatically synchronize user information at
given intervals. By doing this, each user of WebEx will only have to enter their password and not their
username when booking and entering conferences.

If you do not configure AD lookup, the user will have to enter username and password for
communication between Cisco TMS and WebEx.

To configure Active Directory Lookup, do the following:

Go to Administrative Tools > Configuration > Network Settings.
In the Active Directory pane, set “Lookup User Information from Active Directory” to Yes.
Enter information in the remaining fields in the Active Directory pane and click Save.

For information about each field, refer to the Cisco TMS Help.

To configure ‘Get WebEx Username from Active Directory’, do the following:

Go to Administrative Tools > Configuration > WebEx Settings.

In the WebEx Configuration pane, use the “Get WebEx Username from Active Directory” menu to select
the field in AD where you are storing the WebEx username.

Click Save.

For more information, refer to the Cisco TMS Help.

How WebEx Bookings Work

For WebEx booking to work, the booking user must have a WebEx username and password defined as
their WebEx Username and WebEx Password in their Cisco TMS profile. This ensures that the correct
user “owns” the meeting in WebEx and can log in and operate the WebEx conference.

| oL-21352-02
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B Configuring Port Reservations for MCU and TelePresence Server in Cisco TMS

When Single Sign On (SSO) is enabled for the WebEXx site, users with WebEx accounts can book
WebEx-enabled meetings with Cisco TMS without requiring their WebEx password be stored in their
Cisco TMS user profile. When SSO is configured and a user schedules a meeting, their WebEx username
from their Cisco TMS user profile is passed to the WebEx site to complete the booking. For information
about how to configure SSO, see Configuring Single Sign On in Cisco TMS, page 6-11.

The remaining fields are not mandatory, but are used for other Cisco TMS features. Later, if you are
using Active Directory, you can configure Cisco TMS to populate these fields automatically for new
users.

Configuring a Cisco WebEx Enabled TelePresence User in Cisco TMS

Step 1
Step 2

Step 3

Step 4
Step 5
Step 6

Step 7

This configuration is not required if the following three conditions are true:

e ‘Lookup User Information from Active Directory’ and ‘Get WebEx Username from Active
Directory’ are enabled, as described in Configuring Automatic User Lookup from Active Directory,
page 6-5

e Single Sign On is enabled, as detailed in Configuring Single Sign On in Cisco TMS, page 6-11.
e The user will use the default WebEx site for scheduling WebEx meetings
To configure a Cisco WebEx Enabled TelePresence user in Cisco TMS, do the following:

Go to Administrative Tools > User Administration > Users

Click New to add a new user or click the name of an existing user to add WebEx scheduling capabilities
to their profile and click Edit.

Enter Windows/AD Username, First Name, Last Name and Email Address.

~

Note Ifan existing user or AD lookup is enabled, some fields will already contain information.

For WebEx Username, enter the username for the user’s WebEx account.
For WebEx Password, enter the password for the user’s WebEx account.
For WebEx Site, select the WebEx site to which the user is registered.

a~

Note If no WebEx site is selected, the WebEx site configured as the default will be used.

Make any other settings in the Cisco TMS user profile and click Save.

Configuring Port Reservations for MCU and TelePresence
Server in Cisco TMS

Cisco highly recommends configuring MCU and TelePresence Server to reserve ports for each scheduled
meeting.

l_ Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
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Configuring Hybrid Content Mode for MCU in Cisco TMS I

When enabled, the number of ports reserved for the conference is enforced. Therefore if the
TelePresence portion of the meeting has 5 ports and 5 participants have joined on TelePresence, if the
meeting invitation is forwarded to a 6th person, they will not be able to join the meeting on TelePresence.

If port reservations are not enabled, the meeting is booked with 5 TelePresence ports and the invite is
forwarded, additional participants up to the maximum available ports at that time are able to join on
TelePresence. This could cause another scheduled meeting to fail. As a result, Cisco recommend s
always enabling port reservations for MCU and TelePresence Server.

Enabling Port Reservations for MCU

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7

To enable port reservations for MCU, do the following in Cisco TMS:

Go to Systems > Navigator.

Select an MCU.

Click the Settings tab.

Click Extended Settings.

Set “Limit Ports to Number of Scheduled Participants” to On.
Click Save.

Repeat steps 2 through 6 for all other MCUs.

Enabling Port Reservations for TelePresence Server

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7

To enable port reservations for TelePresence Server, do the following in Cisco TMS:

Go to Systems > Navigator.

Select a TelePresence Server.

Click the Settings tab.

Click Extended Settings.

Set “Limit Ports to Number of Scheduled Participants” to On.
Click Save.

Repeat steps 2 through 6 for all other TelePresence Servers.

Configuring Hybrid Content Mode for MCU in Cisco TMS

Configuring any MCUs that will be used for Cisco WebEx Enabled TelePresence meetings with WebEx
to use the hybrid content mode is required. In hybrid mode the incoming content stream is passed
through, giving the best possible quality. It is also decoded and used to create a second, lower resolution
stream for anyone who cannot receive the passthrough stream. This uses up a video port but ensures that
users get the advantages both of transcoding and passthrough.
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To configure hybrid content mode on the MCU in Cisco TMS, do the following:

Step 1 Go to Systems > Navigator.

Step2  Click the MCU name.

Step3  Click the Settings tab and then click Extended settings.
Step4  Set “Content Mode” to Hybrid and click Save.

Configuring Lobby Screen for TelePresence Server in Cisco
TMS

Configuring all TelePresence Servers that will be used for Cisco WebEx Enabled TelePresence meetings
with WebEx to set Lobby Screen to “On” is required.

To configure the Lobby Screen on the TelePresence Server in Cisco TMS, do the following:

Step1  Go to Systems > Navigator.
Step2  Click the TelePresence Server name.
Step3  Click the Settings tab and then click Extended settings.

Step4  Set “Use Lobby Screen for conferences” to On and click Save.

How the Lobby Screen Affects the First TelePresence Participant in a Meeting
if the WebEx Welcome Screen is Disabled

If the WebEx Welcome Screen is disabled, the user experience of the first TelePresence participant in a
meeting that uses TelePresence Server varies depending on how the “Use Lobby Screen for conferences”
setting for TelePresence Server is configured in TMS. Table 6-1 describes what the first TelePresence
participant in a meeting will see in different scenarios. To ensure that the first TelePresence participant
never sees a black screen, make sure you set “Use Lobby Screen for conferences” to Yes for all
TelePresence Servers you will use for WebEx Enabled TelePresence meetings as described in the
previous section.

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
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Configuring Conference Settings in Cisco TMS

Table 6-1 Effect of Lobby Screen on First TelePresence Participant when WebEx Welcome
Screen is Disabled
Webex

TelePresence WebEx Enabled At least one |participant has

Server Lobby TelePresence WebEx camera First TelePresence

Screen Setting meeting? participant? |enabled? participant will see

No No. TelePresence only. |[N/A N/A Black screen (until at
least one other
TelePresence participant
joins)

No Yes No N/A Black screen (until at
least one other
TelePresence or WebEx
participant joins)

No Yes Yes No Silhouette image of
WebEx participant

No Yes Yes Yes Video of WebEx
participant

Yes No. TelePresence only. |[N/A N/A Lobby screen (until at
least one other
TelePresence participant
joins)

Yes Yes No N/A Lobby screen (until at
least one other
TelePresence or WebEx
participant joins)

Yes Yes Yes No Silhouette of WebEx
participant

Yes Yes Yes Yes Video of WebEx
participant

Configuring Conference Settings in Cisco TMS

This section provides information on the recommended and optional conference settings that can be
configured in Cisco TMS for WebEx Enabled TelePresence meetings.

Default Setup and Teardown Buffers

Cisco recommends configuring the default setup and teardown buffers so that the TelePresence portion
of the meeting starts and ends at the scheduled time.

~

Note  Users scheduling a meeting using TMS, can change the setup and teardown buffers for each individual
meeting if they want to.

To configure default setup and teardown buffers Cisco TMS, do the following:

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
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Step 1 Go to Administrative Tools > Configuration > Conference Settings.
Step2  In the Conference Create section, make the following settings:

e For Default Setup Buffer, select 0.

¢ For Default Tear Down Buffer, select 0.
Step3  Click Save.

Default Picture Mode

Cisco recommends configuring Default Picture Mode to Continuous Presence. This allows multiple
participants to be seen on screen at the same time for meetings that use MCU. TelePresence Server is
always set to display multiple participants (called ActivePresence on the TelePresence Server).

To configure Default Picture Mode in Cisco TMS, do the following:

Step 1 Go to Administrative Tools > Configuration > Conference Settings.
Step2  In the Conference Create Options section, set the following option:
e For Default Picture Mode, select Continuous Presence.

Step3  Click Save.

Conference Connection/Ending Options

Cisco recommends configuring the Conference Connection/Ending Options in TMS so that if a meeting
runs beyond the scheduled end time, participants are warned if there are not enough resources to extend
the meeting.

To configure Conference Connection/Ending Options in Cisco TMS, do the following:

Step 1 Go to Administrative Tools > Configuration > Conference Settings.
Step2  In the Conference Connection/Ending Options section, set the following options:
e For Supply Contact Information on Extend Meeting Scheduling Conflict, select Yes.

This enables participants to see contact information when a meeting extension is not possible, due
to a booking conflict.

~

Note  This option is not supported by CTS, Jabber Video, and other endpoints that do not support direct
messaging from TMS.

e For Show In-Video Warnings About Conference Ending, select Yes.

TelePresence participants will receive a text message displayed in the video by the bridge, notifying
them that the meeting will be ending.

This feature is compatible with the following bridges:
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- MCU 42xx, 45xx, 84xx, 85xX, 5XXx

— TelePresence Server 70xx, 87xx

~

Note Because WebEx is a single participant connection to the MCU/TelePresence Server, the

in-video text message will only be visible to WebEx participants when a TelePresence user
is the active speaker.

(Optional) You can configure the length, timing and content of the in-video warnings, by setting the
following options:

— Message Timeout (in seconds): The number of seconds that a warning message will be

displayed. Default setting: 10 seconds.

Show Message X Minutes Before End: The number of minutes before the end of a meeting that
the warning message will appear.

This message can be shown multiple times by separating the minutes with comma. For example
1,5 will display a warning message 1 minute and 5 minutes before the conference ends. Default
setting: 1,5 (1 and 5 minutes).

For TelePresence MPS bridges, only 10, 5 and 1 can be entered here and will be displayed as a
number icon on the screen. All other systems can be configured with any number intervals, and
will show the Meeting End notification followed by the text string entered in Contact
Information to Extend Meetings.

— Contact Information to Extend Meetings: This field allows you to customize what follows the

Meeting End notification. You can enter contact information such as the telephone number or
name of a contact person who can extend the meeting for you.

The text configured here applies to both the In-Video warnings about conference end sent from
bridges to all participants in a conference, and to Meeting End notifications sent to individual
participants by Cisco TMS.

Step3  Click Save.

Configuring Single Sign On in Cisco TMS

Cisco TMS has the option to enable Single Sign On (SSO) for meetings booked by users with WebEx
accounts. When SSO is configured and a user schedules a WebEx-enabled meeting, the WebEx username
in their Cisco TMS user profile is passed to the WebEx site to complete the booking.

With SSO configured, it is only required to store the user’s WebEx username in their Cisco TMS user
profile. The user’s WebEx password is not required.

There are two ways to add a user’s WebEx username to their Cisco TMS user profile:

A TMS Site Administrator manually enters the WebEx Username in a user's profile.

When an organizer schedules a meeting with WebEx using Cisco TMS, Cisco TMS sends the
meeting information to the WebEx site with that WebEx username designated as the WebEx host.

| oL-21352-02
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Prerequisites

~

Note

a~

Note

When a user has selected a WebEx site that has SSO enabled in TMS, Site Administrator
privileges are required to edit the WebEx Username field. Users cannot edit their WebEx
Username.

Enable Cisco TMS to import WebEx usernames from Active Directory (AD)

You can use any field in AD. Email address and username are the most commonly used.

When an organizer schedules a meeting with WebEx using Cisco TMS, Cisco TMS requests AD for
the WebEx username of the meeting organizer using the username and password that the Cisco TMS
administrator filled in on the Network Settings page for AD lookup.

When AD supplies Cisco TMS with the WebEx username of the organizer, Cisco TMS sends the
meeting information to the WebEx site with that WebEx username designated as the WebEx host.

Before configuring SSO in Cisco TMS, you must work with the WebEx Cloud Services team to
determine the following information that needs to be configured in both Cisco TMS and in the WebEx
cloud:

Partner Name

This value must be determined by the WebEx team, because it must be unique among all WebEx
customers. Contact the WebEx account team for this information.

Example: examplesso.webex.com
Partner Issuer (IdP ID)

This is the Identity Provider, which is your TMS. This value must be determined by the WebEx team.
Contact the WebEx account team for this information.

Cisco recommends using a name to indicate your company’s TMS.
Example: exampletms
SAML Issuer (SP ID)

This refers to the Service Provider, which is WebEx. This value must be determined by the WebEx
team. Contact the WebEx account team for this information.

Example: https://examplesso.webex.com/examplesso
AuthnContextClassRef

This is the authentication context. The IdP authenticates the user in different contexts, e.g., X509
cert, Smart card, IWA, username/password).

Use the default value automatically provided by TMS.

Configuring SSO in Cisco TMS

To configure SSO in Cisco TMS, do the following:

1.

Ensure the WebEx site on which you want to enable SSO has been created in Cisco TMS.
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See Configuring the Cisco WebEx Feature in Cisco TMS, page 6-2 for details.
2. Generate a certificate to secure the connection between Cisco TMS and the WebEXx site.

See Generating a Certificate for WebEx, page 6-13 for details.
3. Enable Partner Delegated Authentication on the WebEx site.

See Enabling Partner Delegated Authentication on the WebEXx site, page 6-16 for details.
4. Enable SSO in Cisco TMS.

See Enabling SSO in Cisco TMS, page 6-17 for details.

Generating a Certificate for WebEx

WebEx requires that a certificate pair (public certificate and private key) be used to authenticate Cisco
TMS to the WebEx cloud.

Certificate pair requirements:
e Public certificate must be in .cer or .crt format - to send to the WebEx Cloud Services team
e Certificate and private key bundled in a PKCS12-formatted file - for upload to Cisco TMS

You can generate a new certificate or use an existing one, such as the one used to enable HTTPS on your
Cisco TMS server.

Using an Existing Certificate Signed by a Trusted Authority

If you currently use a certificate signed by a trusted authority, Cisco recommends using the existing
certificate and key pair for your WebEx configuration. How you proceed is determined by if the private
key is exportable, available or unavailable.

If Private Key is Exportable

Step 1

Step 2

Step 3
Step 4

If your private key is exportable, do the following:

Using the Windows Certificate Manager Snap-in, export the existing key/certificate pair as a PKCS#12
file.

Using the Windows Certificate Manager Snap-in, export the existing certificate as a Base64 PEM
encoded .CER file.

Make sure the certificate is in .cer or .crt format and provide this file to the WebEx Cloud Services team.

Use the PKCS#12 file you created in step 2, to upload to TMS in Enabling SSO in Cisco TMS, page 6-17

If Private Key is Not Exportable, but Key/Certificate Pair Available

Step 1
Step 2
Step 3

If your private key is not exportable, but you have the key/certificate pair available elsewhere, do the
following:

Use Windows Certificate Manager Snap-in to export your existing certificate in a Base64 PEM file.
Change the file extension to .cer or .crt and provide this file to the WebEx Cloud Services team.

Create a PKCS#12 key/certificate pair by using the command in step 10 of Using OpenSSL to Generate
a Certificate, page 6-14.
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Step4  Use this PKCS#12 file to upload to TMS in Enabling SSO in Cisco TMS, page 6-17.

If Private Key is Not Exportable or Available

If your private key is not exportable and it is not available elsewhere, you will need to create a new
certificate.

To create a new certificate, follow all the steps in Using OpenSSL to Generate a Certificate, page 6-14.

Creating a Key/Certificate Pair Signed by a Certificate Authority

If you do not have a key and certificate pair, but have a certificate authority you use, do the following:

Step1  Create a new key/certificate pair to use for the WebEx SSO configuration using OpenSSL, following the
steps in Using OpenSSL to Generate a Certificate, page 6-14.

Step2  Create a Base64 PEM encoded version of the signed certificate using step 8 Using OpenSSL to Generate
a Certificate, page 6-14

Step3  Change the file extension of this signed certificate to .cer or .crt and provide this version of the certificate
to the WebEx Cloud Services team.

Step4  Create a PKCS#12 key/cert pair by using the command in step 10 of Using OpenSSL to Generate a
Certificate, page 6-14.

Step5  Use this PKCS#12 file to upload to TMS in Enabling SSO in Cisco TMS, page 6-17.

Creating a Self-signed Key/Certificate Pair
If you do not have a key and certificate pair and do not have a certificate authority to use, you will need
to create a self-signed certificate.

To create a self-signed key, do the following:

Step 1 Follow the steps in Using OpenSSL to Generate a Certificate, page 6-14.
Step2  In step 6, follow the procedure to create a self-signed certificate signing request.

Step3  Follow steps 7 through 9 and provide the base64 PEM file of self-signed certificate to the WebEx Cloud
Services team.

Step4  Follow step 10 to create a PKCS#12 PFX file
Step5  Upload to TMS in Enabling SSO in Cisco TMS, page 6-17.

Using OpenSSL to Generate a Certificate

OpenSSL is an open source project designed to run on Unix and Linux. There is a Windows version
available from Shining Light Productions: http://slproweb.com/products/Win32OpenSSL.html. Before
using OpenSSL to generate a certificate, you must have OpenSSL installed. For more information, go
to: http://www.openssl.org/.
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To generate the TMS certificates required for WebEx and TMS, you must complete the following steps:
1. Generate a private key
Generate a certificate signing request (CSR)

Have a certificate authority sign the CSR

s @« N

Change the file extension of the signed certificate to .cer or .crt and provide it to the WebEx cloud
services team.

5. Convert the signed certificate and private key into a PKCS#12 formatted file
6. Upload the converted certificate and private key to TMS

To use OpenSSL to generate a certificate, do the following:

Step 1 In Windows, open a command prompt.
Step2  Navigate to the openssl\bin installation directory.
Step3  Generate a private key using following command:
openssl genrsa -out tms-privatekey.pem 2048
Step4  Generate a certificate signing request (CSR) using the private key above:
openssl req -new -key tms-privatekey.pem -config openssl.cfg -out tms-certcsr.pem
Step5  Enter the data requested, including:

e Country

e State or province

e Organization name

e Organization unit

e Common name (this is the Cisco TMS FQDN)

¢ (Optional) Email address, password, company name

Step6  Send the Cisco TMS certificate signing request file “tms-certcsr.pem” to be signed by a trusted
certificate authority (CA) or self sign a certificate signing request using OpenSSL or Windows CA.

e For details on how to submit a certificate request to a trusted certificate authority, contact that
certificate authority.

e To self-sign a certificate signing request using OpenSSL, use the following command.
tms-certcsr.pem is your certificate signing request in PEM format. tms-privatekey.pem is your
private key in PEM format. days is the number of days you'd like the certificate to be valid.
openssl x509 -req -days 360 -in tms-certcsr.pem -signkey tms-privatekey.pem -out
tms-cert.pem
The resulting tms-cert.pem is your self-signed certificate.

e To self-sign a certificate signing request using Windows CA, use Windows Certificate Manager
Snap-in. For details on how to submit a certificate request using Windows Certificate Manager
Snap-in, refer to the documentation for Windows Certificate Manager Snap-in.

Step7  When your certificate authority has signed your certificate request, they send a signed certificate to you,
You should receive the signed certificate tms-cert.der back from the CA.
If the certificate is on an email or web page and not in its own file, copy the contents starting with the
----- BEGIN CERTIFICATE----- line and through the -----END CERTIFICATE----- line. Save the
contents to a text file and name the file tms-cert.der.
Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
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Step8  Convert the signed certificate from .der to .pem using the following OpenSSL command:

openssl x509 -inform der -in tms-cert.cer -out tms-cert.pem

~

Note  If the certificate authority provides you the signed certificate in .pem format, you can skip this
step.

Step9  Change the file extension of this signed certificate to .cer or .crt and provide it to the WebEx Cloud
Services team.

Step10 Combine the signed certificate .pem with the private key created in step 3:

openssl pkes12 -export -inkey tms-privatekey.pem -in tms-cert.pem -out tms-cert-key.p12 -name
tms-cert-key

You should now have a Cisco TMS certificate that contains the private key for SSO configuration to
upload to Cisco TMS.

Before uploading this certificate to TMS, you must enable partner delegated authentication on your
WebEx site. For more information, refer to Enabling Partner Delegated Authentication on the WebEx
site in the next section. After enabling delegated authentication, use the combined certificate and private
key you generated in step 10 above to upload to Cisco TMS in step 4 of Enabling SSO in Cisco TMS,
page 6-17 to complete the SSO configuration.

Enabling Partner Delegated Authentication on the WebEXx site

Before you can enable partner delegated authentication on your WebEx site, the WebEx Cloud Services
team must make site provisioning changes to configure your TMS as a delegated partner.

These steps are required for enabling partner delegated authentication on your WebEx site:

1. Request that the WebEx Cloud Services team add a Partner Certificate for your TMS, configured for
SAML 2.0 federation protocol.

2. Provide the public certificate for your TMS to the WebEx Cloud Services team. For details on how
to create a certificate, see Generating a Certificate for WebEx, page 6-13.

3. After the WebEx Cloud Services team notifies you that this step is complete, enable partner
delegated authentication for both Host and Admin accounts in the Site Administration for your
WebEXx site, as described below.

4. Proceed with the section “Enabling SSO in Cisco TMS”.

To enable partner delegated authentication on your WebEx site, do the following:

Step1  Log into your WebEx administrative site and go to Manage Site > Partner Authentication.

The Partner Delegated Authentication page appears.
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Figure 6-3 Partner Delegated Authentication on the WebEx Administrative Site
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In the Partner SAML Authentication Access section, make sure both Host and Site Admin are checked
and click Update.

Enabling SSO in Cisco TMS

Note

Step 1
Step 2

Step 3

Before you begin, make sure you have the following information:
e Certificate Password (if required)
e Partner Name
e Partner Issuer (IdP ID)
e SAML Issuer (SP ID)
¢ AuthnContextClassRef

Before enabling SSO, you must enable Partner Delegated Authentication on your WebEXx site.
For more information, refer to Enabling Partner Delegated Authentication on the WebEx site, page 6-16.

To enable SSO in Cisco TMS, do the following:

Log into Cisco TMS, and go to Administrative Tools > Configuration > WebEx Settings.

In the WebEx Sites pane, click the site name of the WebEx site on which you want to enable SSO.
The WebEx Site Configuration pane appears.

For Enable SSO, select Yes.

The SSO Configuration pane appears.
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Stepd  Click Browse and upload the PKS #12 private key certificate (.PFX) you generated in Generating a
Certificate for WebEx, page 6-13.

Step5  Complete the rest of the SSO configuration fields using the password and other information that you
selected when generating the certificate.

Step6  Click Save.

Figure 6-4 WebEx Settings SSO Configuration in Cisco TMS
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Supported Configurations for TMS to Schedule on Behalf of the WebEx Host

While the focus of the previous section was how to configure SSO on TMS, it is also possible to
configure SSO on the WebEx site itself. As a result, it’s helpful to understand all the supported
configurations for scheduling of WebEx Enabled TelePresence meetings.

There are three possible supported configurations to allow the TMS to schedule on behalf of the WebEx
host:

1. WebEx site does not use SSO and TMS does not have SSO configured (no partner delegated
authentication relationship with the WebEXx site)
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— WebEx host login: The WebEx username and password are stored in WebEx, and the user
authenticates directly to the WebEXx site.

— TMS scheduling: The host's WebEx username and password are also stored in their TMS
personal profile. This must be maintained by the user, if they have access to the TMS, or by the
TMS administrator. The TMS passes both username and password to WebEx at scheduling time.

WebEXx site does not use SSO, but TMS does have SSO configured (partner delegated authentication
relationship with the WebEx site).

— WebEx host login: The WebEx username and password are stored in WebEx, and the user
authenticates directly to the WebEx site.

— TMS scheduling: The host's WebEx username is stored in a TMS personal profile (a TMS admin
task) but the WebEx password is not stored in TMS. TMS is trusted to schedule for that user.

WebEx site uses SSO, and TMS has SSO configured (partner delegated authentication relationship
with the WebEx site).

— WebEx host login: The WebEx user logs in through the SSO identity service provider.

— TMS scheduling: The host's WebEx username is stored in a TMS personal profile (a TMS admin
task) but the WebEx password is not stored in TMS. TMS is trusted to schedule for that user.

| oL-21352-02
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Configuring Cisco TelePresence Management
Suite Extension for Microsoft Exchange

Revised: May 2013

Contents

This chapter describes how to configure Cisco TelePresence Management Suite Extension for Microsoft
Exchange (Cisco TMSXE) for scheduling of Cisco WebEx Enabled TelePresence meetings using the
WebEx and TelePresence Integration to Outlook and WebEx Scheduling Mailbox. It contains the
following sections:

e Prerequisites, page 7-1

e Deployment Best Practices, page 7-2

e Scheduling Options with TMSXE, page 7-2

¢ Configuring Cisco TMSXE for the WebEx and TelePresence Integration to Outlook, page 7-2
e Configuring Cisco TMSXE for the WebEx Scheduling Mailbox, page 7-6

Prerequisites

e Cisco TMSXE software release 3.1 or later is required.
e Cisco TMS software release 14.2 or later is required.

¢ Endpoints that are available as mailboxes for booking in a Cisco WebEx Enabled TelePresence
meeting must be set to AutoAccept in Exchange.

e If a meeting organizer is scheduling a meeting in a different domain than the domain in which the
TMSXE is hosted, The domain in which the TMSXE resides must be added to the list of sites in the
‘Local intranet' zone on the meeting organizer’s computer, so that it trusts the TMSXE server. If the
TMSXE is hosted in a domain that is outside of the domain of many or all users, this can be done
most efficiently by your company’s IT group for all users via a group policy or logon script. If this
is not done, each time a user tries to schedule a meeting, they will be required to enter their TMSXE
username and password.

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
| oL-21352-02 .m



Chapter7  Configuring Cisco TelePresence Management Suite Extension for Microsoft Exchange |

B Deployment Best Practices

e A signed certificate that is trusted in the organization is required for TMSXE. To do this, you must
generate a certificate signing request (CSR) from IIS to provide to the certificate authority (CA).
The certificate can be a self-signed certificate or come from a trusted internal certificate authority
or public certificate authority.

Deployment Best Practices

Cisco recommends installing Cisco TMSXE on a standalone server.

Cisco TMSXE may be co-located with Cisco TMS in smaller deployments, with the following
prerequisites:

e The server must have a minimum of 4GB RAM.

¢ A maximum of 50 telepresence endpoints are available for booking in Cisco TMS and Cisco
TMSXE.

e For details on installation and configuration of TMSXE, refer to the Cisco TelePresence
Management Suite Extension for Microsoft Exchange Installation Guide - Version 3.1.2

Scheduling Options with TMSXE

With TMSXE, there are two options for scheduling:
- Using the WebEx Productivity Tools Plug-In for Microsoft Outlook
You add WebEx to your meeting using WebEx Meeting Options panel in Microsoft Outlook.
— Using WebEx Scheduling Mailbox

You add WebEx to your meeting invitation directly from your email client by including a special
invitee; the WebEx mailbox.

Configuring Cisco TMSXE for the WebEx and TelePresence
Integration to Outlook

To configure Cisco TMSXE for scheduling using the WebEx and TelePresence Integration to Outlook,
you must perform the following tasks:

¢ Install the Cisco TMS Booking Service

e Set up communication between your WebEx site and TMSXE

Installing the Cisco TMS Booking Service

To allow WebEx Productivity Tools with TelePresence to communicate with Cisco TMSXE you must
have Booking Service installed.

If you did not include the proxy during initial installation, do the following:

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
[ 72 | oL-21352-02 |


http://www.cisco.com/en/US/docs/telepresence/infrastructure/tmsxe/install_guide/Cisco_TMSXE_install_guide_3-1-2.pdf
http://www.cisco.com/en/US/docs/telepresence/infrastructure/tmsxe/install_guide/Cisco_TMSXE_install_guide_3-1-2.pdf

| Chapter7

Configuring Cisco TelePresence Management Suite Extension for Microsoft Exchange

Step 1
Step 2

Step 3

Note

Configuring Cisco TMSXE for the WebEx and TelePresence Integration to Outlook 1l

On the Cisco TMSXE server, go to the Control Panel.

Right-click Cisco TelePresence Management Suite Extension for Microsoft Exchange and select
Change.

This starts the installer and allows you to change your installation.

Follow all instructions provided by the installer and opt to include Cisco TMS Booking Service.

Installing the Booking Service forces a restart of IIS.

Configuring IIS for HTTPS

>

Warning

Booking Service requires HTTPS to be configured for DefaultSite in IIS.

If IIS is not present on the server prior to installation of Cisco TMSXE, it will be automatically installed
with Booking Service. HTTPS must then be configured after installation to allow Booking Service to
operate.

For more information, refer to the Microsoft Support article: How To Set Up an HTTPS Service in IIS.

In the IIS configuration detailed in the link above, you must make the following setting for users to
schedule meetings with the WebEx and TelePresence Integration to Outlook plug-in for Microsoft
Outlook: In the “SSL Settings” configuration for “Client certificates”, you must select “Ignore”. If you
do not, users will receive a “hit a glitch” message when scheduling meetings using the WebEx and
TelePresence Integration to Outlook Plug-In for Microsoft Qutlook.

Configure Server Certificate

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6
Step 7
Step 8
Step 9

On the windows server on which TMSXE is running, you must load a server certificate within IIS.

The process involves generating a certificate signing request (CSR), which is sent to a certificate
authority (CA), and then installing the signed certificate you receive from the CA.

Generating a CSR for IIS 7 (Windows Server 2008):

Open the Server Manager console (Start > All Programs > Administrative Tools > Server Manager).
In the Role View, select IIS Manager (Server Manager > Roles > Web Server > IIS Manager).
Double-click Server Certificates.

In the Actions pane on the right, click Create Certificate Request.

(Important) In the “Common Name:” field, enter the Fully Qualified Domain Name (FQDN) of the DNS
name which users will type into the address bar in their browser to reach your website (site.cisco.com
NOT site). If you have a different physical hostname than what users will type into their browsers to get
to your site, make sure to put in the name users will use.

In the “Organization” field, type your organization name.
In the “Organizational Unit” field, type the name of your organization and click Next.
In the “City/locality” field, type the city where the server resides and click Next.

In the “State/province” field, type the state where the server resides.
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Step 10
Step 11
Step 12
Step 13
Step 14

Step 15

Step 1
Step 2
Step 3
Step 4

Step 5

Step 1
Step 2
Step 3
Step 4

Step 5

Step 1

Step 2
Step 3

Step 4
Step 5
Step 6

In the “Country/Region” field, select US (United States) and click Next.

Leave the CSP at the default value.

For the “Bit Length”, select 2048.

Enter (or Browse to) a filename to save the certificate request (CSR), click Finish.
Copy and paste the entire contents of the CSR file you just saved.

The default save location is C:\.

Provide the CSR file to your CA and wait for them to send a signed certificate back to you.

Installing the Public Root Certificate in IIS7 (Windows Server 2008):

Double-click the Root CA certificate file and click Install Certificate.
Click Next, place the radio button in Place all certificates in the following store and then click Browse.
Place a check in Show Physical Stores.

Expand the Trusted Root Certification Authorities folder, select the Local Computer folder, and click
OK.

Click Next and then Finish. You will receive the message: “The import was successful”.

Installing the Intermediate CA certificate (if applicable):

Double-click the Intermediate CA certificate file and click Install Certificate.
Click Next, place the radio button in Place all certificates in the following store and then click Browse.
Place a check in Show Physical Stores.

Expand the Intermediate Certification Authorities folder, select the Local Computer folder, and click
OK.

Click Next and then Finish. You will receive the message: “The import was successful”.

Installing your SSL server certificate:

In the IIS Manager console, go to the Server Certificates action pane, and click Complete Certificate
Request. The Complete Certificate Request Wizard appears.

Browse to the location where you saved your SSL server certificate, select it, then click Open.

Enter a friendly name for your certificate (use the certificate's hostname if you're unsure). Then click
OK.

At this point SSL is available for TMSXE. You will still need to configure the TMSXE or individual
directories to use SSL.Select your IIS Site.

In the action pane on the right, under Edit Site, click Bindings.
Click the Add button.
In the Type menu, select https.
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In the SSL certificate menu, select your SSL certificate.

Click OK.

Step 7
Step 8

Setting Up Communication Between Your WebEx Site and TMSXE

Follow the steps described in Cisco TelePresence Cisco WebEx Integration Options, page 10-1

Configuring the Location Displayed for TelePresence Rooms in Qutlook

When selecting telepresence rooms while scheduling a WebEx Enabled TelePresence meeting in
Outlook, the location of the room is displayed in the both the Select Attendees and Resources Address
Book window (Figure 7-1), which is a standard part of Outlook, and the Select Telepresence Rooms
window (Figure 7-2), which is displayed when using the WebEx and TelePresence Integration to
Outlook.

e To display the Select Attendees and Resources Address Book window, click the To... button in the

Meeting window.

Figure 7-1 Select Attendees and Resources - Address Book
Select Attendees and Resources: Cisco TelePresence Rooms

search: (®)Mame only () Mare columns Address Book

Resources ->

TelePresence Rooms - jsmith@example.corn v

Contacts -~

Greater China

Personal Rooms
U5 & Canada
Conference Rooms
Asia Pacific

Emerging Markets
European Markets
Greater China

To display the Add Telepresence Rooms window, click the Add Telepresence Rooms button the

Meeting Options pane.

Japan
US & Canada
Global Address List

Advanced Find

Suggested Contacts Location D
S— = Global Address List
-onference Room O Al Address Lisks A
L‘J ARG O1-Conference Room C Al Contacts Albugquerque
L‘J SLC0z- Conference Roormn & Al Groups Salt Lake City
[2] DALD4-Conference Roorn D g” 522:25 Dallas
L‘J DEMO7-Conference Room B Cisco Employees Denver
1] BGL10-Conference Room A AMER Emplovees Bangalore
2] KGLO1-Conference Room 2 APAC Employess Kigali
2] My 10-Conference Roorn A EMEA Employees Mew York City
] NYCO8-Confierence Room C Mall Mew Yark City
2 MrC0a-Conferen ce Room B Mew York City
2] SFC05-Conference Room O Emerging Markets San Frandsco ¥
< European Markets 3

Cancel

Public Folders b

| oL-21352-02

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29 g




Chapter7  Configuring Cisco TelePresence Management Suite Extension for Microsoft Exchange |
M Configuring Cisco TMSXE for the WebEx Scheduling Mailbox

Figure 7-2 Select TelePresence Rooms

Select Telepresence Rooms @

Search Location:

All Locations “

m Mame Location
[2lnvcin-Conference ... Mew York City

Location in the “Select Telepresence Rooms” window is read from Active Directory upon startup of
TMSXE for the Active Directory accounts of the enabled mailboxes and is provided to the WebEx
and TelePresence Integration to Outlook. It is a simple text field, and not structured data. The
location information is the same as what is displayed in the “Location” column in the Microsoft
Exchange Address Book, shown in Figure 7-1.

The structure and hierarchy displayed in the drop-down menu in the Exchange Address Book
(Figure 7-1) is manually created by the Exchange administrator. This can be done by creating nodes,
giving them a name and a search filter. A common use (besides geographical) is to structure the list
using departments, groups or business units. For more information, refer to the documentation for
Microsoft Exchange.

Installing the WebEx and TelePresence Integration to Qutlook

Meeting organizers who want to schedule meetings using the WebEx and TelePresence Integration to
Outlook plug-in, must download and install the WebEx Productivity Tools with TelePresence from your
WebEx site. For details, refer to: Installing the WebEx and TelePresence Integration to Outlook,

page 10-6 of Chapter 10, “Integrating Cisco TelePresence with Your Cisco WebEx Site Administration
Account”.

Configuring Cisco TMSXE for the WebEx Scheduling Mailbox

To configure Cisco TMSXE for scheduling using the WebEx Scheduling Mailbox, you must do the
following procedures:

1. Configure the WebEx mailbox in Microsoft Exchange.
2. Add the WebEx mailbox to Cisco TMSXE.

Configuring the WebEx Scheduling Mailbox in Microsoft Exchange

To configure the WebEx mailbox in Microsoft Exchange, use either Exchange Management Console or
Powershell:

Step 1 Create a new user mailbox for your WebEx Scheduling Mailbox (example: webex @example.com).
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Step 2

Step 3

Configuring Cisco TMSXE for the WebEx Scheduling Mailbox

For more information, refer to: Create a Mailbox (Exchange 2010 Help) or How to Create a Mailbox for
a New User (Exchange 2007 Help).

Give the EWS Service Account Full Mailbox Access to this mailbox.

For more information, refer to: Allow Mailbox Access (Exchange 2010 Help) or How to Allow Mailbox
Access (Exchange 2007 Help).

Modify mailbox properties:
a. Turn off the Calendar Attendant for the mailbox.

For more information, refer to: Configure User and Resource Mailbox Properties (Exchange 2010
Help) or How to Disable the Auto-Processing of Meeting Messages (Exchange 2007 Help).

b. Make sure new requests are not automatically marked as tentative by disabling
AddNewRequestsTentatively (Mark new meeting requests as Tentative) if using the Calendar
Settings tab) for the mailbox.

Adding the WebEx Mailbox to Cisco TMSXE

Step 1
Step 2
Step 3

Step 4

Step 5

Step 6

Step 7

To add the WebEx Mailbox to Cisco TMSXE, do the following:

Log in to the server on which TMSXE is installed.
From the Windows task bar, select Start > All Programs > Cisco > TMSXE Configuration.

If Cisco TMSXE is already running, a message appears indicating you must stop the Cisco TMSXE
service to start the configuration tool. Click Stop Service.

The Cisco TMSXE Configuration window appears.
Click the Exchange Web Services tab.

In the WebEx Scheduling Mailbox field at the bottom of the window, enter the email address of the
WebEx mailbox you created in Microsoft Exchange.

Click Save.

TMSXE validates the email address you provided and a message appears indicating your settings have
been saved.

Click Exit.

Additional Recommendations

Cisco also recommends using the following configurations for WebEx Scheduling Mailbox:

e Using Exchange Management Console Mail Flow Settings or Powershell, stricten the message
delivery restrictions as needed.

For example, require senders to be authenticated, only allow from people in a specific group or
similar.

For more information, refer to: Configure Message Delivery Restrictions (Exchange 2010 Help) or
How to Configure Message Delivery Restrictions (Exchange 2007 Help).
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e Using AD Users and computers or Powershell, set the Active Directory user account to disabled.

See Disable or Enable a User Account for instructions.
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CHAPTER

Configuring Cisco TelePresence Management
Suite Provisioning Extension

Revised: November 2013

Contents

This chapter describes how to configure Cisco TelePresence Management Provisioning Extension (Cisco
TMSPE) for scheduling of Cisco WebEx Enabled TelePresence meetings using Smart Scheduler. It
contains the following sections:

Prerequisites

Prerequisites, page 8-1

Introduction, page 8-2

User Access to Cisco TMSPE, page 8-2
How Smart Scheduler Works, page 8-3

Limitations, page 8-4

Cisco TMS software release 14.2 or later must be installed.
Cisco TMSPE software release 1.1 or later must be installed and enabled in TMS.

- For details, refer to the Cisco TelePresence Management Suite Provisioning Extension
Deployment Guide.

WebEx must be configured on TMS.
— Cisco WebEx option key
— One or more WebEx sites
- Single sign-on or specified WebEx credentials for each user.

Cisco highly recommends that Single Sign On is configured for Cisco TMS and WebEx for easy
addition and management of users.

| oL-21352-02

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29 g


http://www.cisco.com/en/US/docs/telepresence/infrastructure/tmspe/install_guide/Cisco_TMSPE_Deployment_Guide_1-1.pdf
http://www.cisco.com/en/US/docs/telepresence/infrastructure/tmspe/install_guide/Cisco_TMSPE_Deployment_Guide_1-1.pdf

Chapter8  Configuring Cisco TelePresence Management Suite Provisioning Extension |

W Introduction

~

Note If Single Sign On is not configured In Cisco TMS, you must manually add a WebEx username
and password for each Cisco TMS Smart Scheduler user that will schedule meetings with
WebEx.

For details on how to configure TMS, refer to Configuring Cisco TelePresence Management
Suite.

e Smart Scheduler requires one of the following browsers:
- Internet Explorer - version 9 or later
— Mozilla Firefox - version 10 or later
— Safari - version 6 or later

— Chrome - version 24 or later

Introduction

Smart Scheduler is a part of the Cisco WebEx and TelePresence solution, allowing users to schedule
telepresence meetings with WebEx.

With Smart Scheduler users can schedule Cisco TelePresence meetings with and without WebEx.

Any bookable system in Cisco TMS can be scheduled directly. Any system that is not supported by Cisco
TMS booking can be scheduled as a call-in participant, including devices provisioned by Cisco TMSPE.

The option to include WebEx in a meeting is available in the Smart Scheduler booking form if Cisco
WebEx has been set up with Cisco TMS.

Note  The default date and time format for a new meeting is dd.mm.yyyy and 24-hour time format. Each user
can change these default settings by clicking their name or the wrench icon in the upper-right portion of
the Smart Scheduler window. This setting is saved as a cookie in the each browser used.

User Access to Cisco TMSPE

Users with the necessary credentials can reach Smart Scheduler using:

http://<Cisco TMS Server Hostname>/tms/booking/

Example: http://example-tms.example.com/tms/booking/

Users who already use Cisco TMS can also click the portal icon in the upper right corner to go to Smart
Scheduler and FindMe.

Figure 8-1 Cisco TMS Portal Icon
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How Smart Scheduler Works

Creating a Redirect to Smart Scheduler

It is also possible to create an HTTP redirect using the following HTML code:
<html>
<head>

<META HTTP-EQUIV="Refresh" CONTENT="0; URL= https://<Cisco TMS Server
Hostname>/tmsagent/tmsportal/#scheduler">

<title>Cisco TelePresence Management Suite Smart Scheduler</title>
</head>
<body>
</body>
</html>

Access Rights and Permissions

Access to Smart Scheduler works the same as access to Cisco TMS.
Users must have one of the following accounts:
¢ A local account on the Cisco TMS Windows Server

¢ A domain account that the server trusts through Active Directory. By making the server a member
of the domain, all trusted domain users can automatically use their existing Windows credentials.

A Cisco TMS user account will be created for them when they access the site if one does not exist
already.

~

Note  The actual booking is not created directly by the individual user, but on their behalf by the Cisco
TMSPE service user added during installation. Booking permissions will therefore be the same
for all users.

Time Zone Display

Bookings are created using the time zone of the user’s web browser (determined by the time zone of the
user’s operating system).

Within the scheduler itself, the time zone of the web browser and operating system is displayed.

How Smart Scheduler Works

1. When a domain user signs into Smart Scheduler and books a meeting, the request is passed to Cisco
TMS.

2. This communication goes through the Cisco TelePresence Management Suite Extension Booking
API (Cisco TMSBA).

3. The Cisco TMS user entered during installation of Cisco TMSPE is the service user for Smart
Scheduler. This user creates the booking in Cisco TMS on behalf of the Cisco TMSPE user.

If the Cisco TMSPE user does not already exist in Cisco TMS, it will be created at the same time as
the booking.
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4. When the booking is complete, Cisco TMS sends an email confirmation to the user who booked the
meeting. The message containing meeting details including route, scheduled systems, WebEx
information, and so on, may then be forwarded to the other meeting participants.

Limitations

Cisco strongly recommends that meetings scheduled in Cisco TMS not be modified using Smart
Scheduler, as this interface and does not support all features and options that may have been chosen for
the meeting in Cisco TMS.

e Exceptions to recurrent meeting series are not supported in Smart Scheduler. Any modification will
be applied to all instances.

e Smart Scheduler will rename call-in participants added from Cisco TMS.

e Smart Scheduler is not compatible with the use of setup and teardown buffers in Cisco TMS
scheduling. This is a limitation of the Cisco TelePresence Management Suite Extension Booking
APIL.
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Contents

This chapter describes how to configure audio for Cisco WebEx Enabled TelePresence.
The following sections describe the audio deployment scenarios:

e Configuring SIP Audio for Cisco WebEx Enabled TelePresence, page 9-2

e Configuring PSTN Audio for Cisco WebEx Enabled TelePresence, page 9-3

e Configuring TSP Audio for Cisco WebEx Enabled TelePresence, page 9-7

Prerequisites

To configure SIP or PSTN Audio, the following are required:
e VCS Control/Expressway must be configured.

For details, refer to: Chapter 4, “Configuring Cisco TelePresence Video Communication Server
Control and Expressway”.

¢  When using Unified CM, make sure:

— SIP trunk is configured between Unified CM and VCS Control.

For details, see Configuring a SIP Trunk Between Unified CM and VCS Control, page 4-5

— Your regions are configured for g.711.
e If configuring PSTN audio, Gateway must be registered to VCS or Unified CM.
e MCUs/TelePresence Servers must be registered to VCS.

— No support for MCUs/TelePresence Servers trunked to Unified CM.
¢ Endpoints registered to VCS and/or Unified CM and able to call into MCUs/TelePresence Servers

e Familiarity with all of required products
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e If configuring TSP audio and the TSP provider offers a waiting room feature, the TSP provider must
configure it to allow multiple hosts to log in to the audio conference, or the human host must be
trained to not log in as a host. If multiple hosts are not enabled, each host that dials in disconnects
the host that dialed in before it. For example, if the MCU dials in first, when the human host dials
in later, they will disconnect the MCU.

The human host still maintains host privileges on the WebEx client and can mute/unmute
participants through that user interface if needed.

a~

Note  Cisco Conductor is not supported at this time.

Configuring SIP Audio for Cisco WebEx Enabled
TelePresence

The following section describes the steps required for configuring SIP audio for Cisco WebEx Enabled
TelePresence.

This section describes the following:
¢ Configuring the WebEx Site in Cisco TMS to Use SIP Audio
¢ Enabling Hybrid Audio on the WebEx Site, page 9-3

~

Note  SIP audio only supports WebEx audio (TSP audio is not supported).

Configuring the WebEx Site in Cisco TMS to Use SIP Audio

To configure Cisco TMS to use SIP for the WebEx site, do the following:

Step1  Log into Cisco TMS.
Step2  Go to Administrative Tools > Configuration > WebEx Settings.
The WebEx Settings page appears.
Step3  Click the name of the WebEx site you want to configure.
The WebEx Site Configuration page appears.
Stepd  If a new site, enter the Site Name, Host Name and other required fields.
Step 5 For TSP Audio, select No.
Step6  Click Save.

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
[ 92 | oL-21352-02 |



| Chapter9 Configuring Audio

Configuring PSTN Audio for Cisco WebEx Enabled TelePresence Il

Enabling Hybrid Audio on the WebEx Site

To use SIP audio, your WebEx site must be enabled for Hybrid Audio. Hybrid Audio is also required to
provide your WebEx participants the option of using their computer to connect to the audio portion of a
meeting.

This configuration must be done by the WebEx team. Contact the WebEx team for assistance, or submit
an online ticket at:

https://support.webex.com/MyAccountWeb/GPLWebForm.do

Figure 9-1 SIP Audio Deployment with Endpoints Registered to Unified CM
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Configuring PSTN Audio for Cisco WebEx Enabled
TelePresence

The following section describes the steps required for configuring PSTN audio for Cisco WebEx Enabled
TelePresence.

This section describes the following:
e Configuring the WebEx Site in Cisco TMS to Use PSTN Audio
e Enabling Hybrid Mode on the WebEx Site, page 9-4
e Configuring PSTN Calls to Pass Through a PSTN Gateway to WebEx, page 9-4

Note  Cisco WebEx Enabled TelePresence always dials a fully qualified E.164 number beginning with the
international escape character (+). For example: +14085551212. Make sure that VCS and/or Unified CM

call routing is set up accordingly.
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Configuring the WebEx Site in Cisco TMS to Use PSTN Audio

To configure Cisco TMS to use PSTN for the WebEx site, do the following:

Step 1 Log into Cisco TMS.
Step2  Go to Administrative Tools > Configuration > WebEx Settings.
The WebEx Settings page appears.
Step3  Click the name of the WebEx site you want to configure.
The WebEx Site Configuration page appears.
Stepd  If a new site, enter the Site Name, Host Name and other required fields.
Step5 For TSP Audio, select Yes.
Step6  Click Save.

A

Caution  If the meeting organizer chooses a TelePresence Server when scheduling the meeting, Cisco TMS will
automatically attempt to schedule the meeting using MCU. If an MCU is not available, the meeting will
not be scheduled successfully.

Enabling Hybrid Mode on the WebEx Site

If you want WebEx participants to have the option of using their computer to join the audio portion of a
meeting, your WebEx site must be set to Hybrid mode. This configuration must be done by the WebEx
team. Contact the WebEx team for assistance.

Configuring PSTN Calls to Pass Through a PSTN Gateway to WebEx

WebEx always provides a fully qualified E.164 number beginning with the international escape character
(+). For example: +14085551212. VCS and/or Unified CM call routing must be properly configured to
ensure PSTN calls are routed correctly.

Two deployments models are supported for routing PSTN calls to pass through a PSTN gateway to
WebEx:

e Configuring PSTN Calls to Pass through a PSTN Gateway Registered to VCS, page 9-4
e Configuring PSTN Calls to Pass through a PSTN Gateway Registered to Unified CM, page 9-6

Configuring PSTN Calls to Pass through a PSTN Gateway Registered to VCS

To configure PSTN calls to pass through a PSTN Gateway registered to VCS, do the following:

Step 1 On VCS, create a transform or search rule that transforms the globally routable number provided by
WebEx (example: +14085551212) to a number with the tech-prefix of the gateway registered to VCS
(example: 9#14085551212).
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This example transforms +14085551212 @example.webex.com to
9#14085551212 @example.webex.com using the Regex pattern type:

e Pattern string:\+(\d+@.%)
e Replace string: 9#\1

For more information about configuring traversal zones, search rules and transforms in VCS, refer to the
“Cisco TelePresence Video Communication Server Basic Configuration (Control with Expressway)
Deployment Guide” at

https://www.cisco.com/en/US/docs/telepresence/infrastructure/ves/config_guide/Cisco_VCS_Basic_C
onfiguration_Cisco_VCS_Control_with_Cisco_VCS_Expressway_Deployment_Guide_X7-2.pdf

Figure 9-2 PSTN Audio Deployment with Gateway Registered to VCS and Endpoints Registered to Unified CM
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Configuring VCS Control for ISDN Gateways

If you are going to use an ISDN gateway to pass PSTN calls through to WebEx, you must configure the
Interworking setting in VCS Control.

~

Note  This step is required only for ISDN gateways.

To configure VCS Control for ISDN Gateways, do the following:

Step1  Login to VCS Control.
Step2  Go to VCS Configuration > Protocols > Interworking.
Step3  For H.323 <-> SIP interworking mode select On and click Save.
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~

Note  An option key is required in order to save this configuration.

Configuring PSTN Calls to Pass through a PSTN Gateway Registered to Unified CM

To configure PSTN calls to pass through a PSTN Gateway registered to Unified CM, do the following:

Step1  On VCS, create a search rule that takes the globally routable number with the international escape
character (+) provided by WebEx (example: +14085551212) and routes it to Unified CM.

Step2  On Unified CM, create a route pattern according to your dial plan to route these types of calls to the
appropriate PSTN gateway registered to Unified CM.

For more information about configuring search rules on VCS, refer to the “Cisco TelePresence Video
Communication Server Basic Configuration (Control with Expressway) Deployment Guide” at

https://www.cisco.com/en/US/docs/telepresence/infrastructure/ves/config_guide/Cisco_VCS_Basic_C
onfiguration_Cisco_VCS_Control_with_Cisco_VCS_Expressway_Deployment_Guide_X7-2.pdf

For more information about configuring route patterns in Unified CM, refer to the documentation for
your Unified CM version:

https://www.cisco.com/en/US/products/sw/voicesw/ps556/prod_maintenance_guides_list.html

Figure 9-3 PSTN Audio Deployment with Gateway and Endpoints Registered to Unified CM
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Configuring VCS Control for ISDN Gateways

If you are going to use an ISDN gateway to pass PSTN calls through to WebEx, you must configure the
Interworking setting in VCS Control.

~

Note  This step is required only for ISDN gateways.

To configure VCS Control for ISDN Gateways, do the following:

Step1  Login to VCS Control.
Step2  Go to VCS Configuration > Protocols > Interworking.
Step3  For H.323 <-> SIP interworking mode select On and click Save.

~

Note  An option key is required in order to save this configuration.

Verifying the Outbound Dialing Configuration for VCS and MCU/TelePresence Server

To verify that outbound dialing is properly configured, do the following:

Step1  Immediately after call is placed, on the VCS Control navigate to Status -> Search history
Step2  Determine if the call appears in the search history:

a. If the call does not appear here, then the MCU never dialed out. Enable SIP/H323 logs on the MCU.
Replace the call, stop SIP/H323 logging, and download the logs.

b. If the call does appear here, click on view for the call under the actions header. This will display the
detailed search history.

Step 3 Within the detailed search history, in the first subsearch it should show transforms. The value listed
below here is the exact URI that you are calling after the transforms take effect. Later on, you should do
a subsearch that points to the Zone for the external dial-out (usually Unified CM). The alias listed here
is exactly as you are presenting the call to the other side. Make sure that the other side is expecting the
call in this formation (ie: no “+” characters or anything the other side might not support).

Step 4 If the search on the other side shows “Found: False” look at the Reason. If the Reason is Not Found, then
the other side is returning a 404. In this case, make sure that the following are taking place:

a. The VCS is passing the URI EXACTLY as the other side is expecting

b. The other side is configured to allow the call.

Configuring TSP Audio for Cisco WebEx Enabled TelePresence

To deploy Telephony Service Provider (TSP) audio, PSTN audio is required. Follow the steps in
Configuring PSTN Audio for Cisco WebEx Enabled TelePresence and then contact WebEx cloud
services to assist you with the TSP configuration.
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>
Note  The TSP provider must support the Call-in User Merge. Call-in User Merge allows TSP partners to pass

the attendee ID via DTMF code, rather than prompting the user via the audio. The WebEx Meeting
Manager prompts the user to enter the DTMF code, followed by the attendee ID.

There are four required parts to TSP audio configuration:
e Configuring MACC Domain Index and Open TSP Meeting Room Webex Settings
e Configuring the TSP Dial String
e Configuring How the Conference is Opened
e Configuring TSP Audio for the Meeting Organizer
For more information, refer to:

e Overview of TSP Audio Configuration and Meetings

Note TSP audio requires that the MCU/TS is able to make an outbound call to establish an audio cascade
between TelePresence and the TSP partner audio bridge. To ensure that the MCU/TS can make the call,
please review the section: Configuring PSTN Calls to Pass through a PSTN Gateway Registered to VCS,
page 9-4.

Configuring MACC Domain Index and Open TSP Meeting Room Webex Settings

WebEx cloud services must configure these settings for you. Contact WebEx cloud services for more
information.

Configuring the TSP Dial String

During a meeting that uses TSP audio, TelePresence equipment dials into the TSP partner's bridge and
navigates the menu hierarchy to connect to the conference. The audio (IVR) prompts for each TSP
provider are different. As a result, a DTMF dial string must be created.

DTMF Dial String

A static DTMF dial string must be created and tested by your TSP audio provider and then provided to
Cisco WebEx cloud services. WebEx cloud services then configures the dial string parameters in the
WebEx cloud for your WebEx site. The following is an example sequence of what needs to be provided:

1. MCU/TelePresence Server dials the phone number

Pause 2 seconds

Enter [participant code] DTMF values (Example: 12345678)
Enter #

Pause 6 seconds

Enter #

Pause 25 seconds

Enter #1

O N o e B~ W N
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9. Pause 1 second
10. Enter [attendee ID] DTMF values (Example: 44356)

For more information, contact Cisco WebEx cloud services.

Variables Available to the Dial String

The following variables are available for use with the DTMF dial string that is created by your TSP audio
provider and configured by WebEx cloud services.

Figure 9-4 WebEx Host Account / TSP Audio Account

Edit Teleconferencing Account

Call-in toll-free numbey: —=TmfEAen Number it areaiclly code) T?;?i”“
[Phone Number] Call-in numbey; =3ctiesien tomber pih srew/oly Telltree
[Subscriber Code] Leader PIN:
[Participant Code] Conference Code: >

[Attendee ID] Recording dial-out number:  Call-in toll-free number ~
Please select the dial-out recording number to use for
network-based recording and audio broadcasts.

(Internally generated 5-digit number)

Configuring How the Conference is Opened

TSP providers typically wait for the WebEx host to call in before opening up the conference.

Until the host dials in (by entering the host key) participants are in a waiting room. If the host is late or
never dials in and unlocks via WebEx, the meeting will never get unlocked.

Contact your TSP provider to determine if they have a waiting room. If they do have a waiting room,
there are two methods for ensuring the conference is opened for a meeting:

e Method 1: Configure the DTMF dial string for the MCU/TelePresence Server to enter the meeting
as the host and unlock the meeting.

— WebEx cloud services works with the TSP partner to create the proper DTMF dial string.

— If the WebEx host has already entered meeting, the DTMF dial string of the MCU/TelePresence
Server will be heard by meeting participants.

>
Note A DTMF dial string is required, whether or not you are configuring the dial string for the

MCU/TelePresence Server to enter the meeting as host. Contact WebEx cloud services for more
information.

e Method 2: The WebEx TSP server sends the W2A_UpdateConference=2 API command to the TSP
partner's bridge to unlock the meeting.
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— The TSP partner may have to recode their TSP adapter in order to recognize and properly
execute the unlock conference command. Contact your TSP provider to determine if they
support this API command.

How TSP Integration Methods Affect Call Scenarios

The following table describes common scenarios and the results depending on which method is used to
open the conference.

Table 9-1 Scenarios and Results for TSP Methods
Scenario Expected Result |If method 1 is used If method 2 is used
MCU/TelePresence | Successful join The The MCU/TelePresence Server will
Server is the first MCU/TelePresence |not have the host role in audio.

caller into the audio

Server will have host

conference role in the TSP audio
conference
One or more Successful join The The MCU/TelePresence Server will
attendees have MCU/TelePresence |not have the host role in audio.
already joined the Server will have host
audio conference role in the TSP audio
(waiting room) conference
before the
MCU/TelePresence
Server dials in.
The host has Successful join Users who have No such extra DTMF tones will be

already joined the
audio conference
before the
MCU/TelePresence
Server dials in.

already joined the
audio conference
may hear the “extra”
DTMEF tones
broadcast into the
audio conference,
which is the
MCU/TelePresence
Server following the
DTMF sequence as
though it were the
host.

heard.

The host (who had
already joined the
audio conference
before the
MCU/TelePresence
Server dials in),
hangs up while the
conference is still
underway.

Varies

Audio conference
may terminate.
Depends on TSP
implementation -
some may not
terminate. Depends
on host's selection in
WebEx GUI upon
leaving conference
(option to keep
conference running)

Since method 2 is being used, the
partner should keep the conference
running until either:

a. all attendees have left the
conference or

b. TSP API sends
W2A_CloseConference
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Scenario Expected Result |If method 1 is used If method 2 is used

DTMF failure Fail to join

The host joins via Fail to join MCU should fail to |MCU/TelePresence Server should
WebEx before the join fail to join

MCU/TelePresence

Server dials in, and
the host uses the
WebEx GUI to lock
the conference.

(WebEx has
decided to respect
the hosts' locking of
the conference in
this case.)

Configuring TSP Audio for the Meeting Organizer

Each meeting organizer who needs to schedule WebEx Enabled TelePresence meetings that use TSP
audio, must log in to the WebEx site and configure their account to use TSP audio. This is a one-time
configuration.

Prerequisites
The meeting organizer must have the following information, provided by the TSP audio service provider:
e (Call-in toll-free number
e Call-in number
e Host access code
e Attendee access code
Configuring TSP Audio
To configure TSP audio, do the following:
Step1  Open a browser and go to your WebEx site. (Example: http://example.webex.com)
Step2  In the upper part of the page, click My WebEx. [,
Step3  Enter the Username and Password for your WebEx account and click Log In.
Step4  In the left-hand side of the page, click My Audio. & My Audio
Step5  In the Teleconferencing Service Accounts section, click Add account.
Step6  In the Add Teleconferencing Account window, enter the appropriate phone numbers and access codes
for the host and attendees, as provided by the TSP audio service provider.
Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
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Figure 9-5 Add Teleconferencing Account window

Add Teleconferencing Account

SountnymEgion Mumber fwith amaliciy code) Tollfree
Call-in tollfree number: 7
500-555-4343
SountnymEgion Mumber fwith amaliciy code) Tollfree

Call-in number:
408-555-1885

Host acoess code: 1234

Attendee acoess code: 5678

| ok | |cancel |

Step7  Click OK.

Overview of TSP Audio Configuration and Meetings

The following diagram provides an overview of which components are configured for TSP audio, as well
as what takes place when a meeting is scheduled and starts.
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Figure 9-6 TSP Audio Configuration, Scheduling and Meeting Start Flow
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How a TSP Meeting Works

A meeting that uses TSP Audio takes place the following way:

1. The meeting is scheduled.

A dial string is passed back to the MCU/TelePresence Server.

At the scheduled start time, the MCU/TelePresence Server starts the meeting.
TelePresence connects into WebEx via SIP.

The TSP partner starts the audio conference on their bridge and they open up the conference.

U

At the same time as TelePresence connects to WebEx via SIP, it also dials via PSTN into the TSP
partner bridge using the DTMF dial string.
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Behavior of TSP Audio Meetings When the MCU or TelePresence Server Dials in as Host

The MCU/TelePresence Server will attempt to redial the connection for any reason up to a maximum
number of retries. In the case where the MCU/TelePresence Server joins as host, it is important to note
that if the MCU/TelePresence Server is the host and this call is disconnected for any reason, the TSP
partner may tear down the audio conference (all participants may be disconnected). The
MCU/TelePresence Server will immediately dial back in and re-establish the audio conference, but the
participants may need to call back in again. The word “may” is used here because we understand this to
be configurable on the TSP and/or the behavior may differ from one TSP provider to another.
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Contents

This chapter describes how to configure your WebEx site for Cisco WebEx Enabled TelePresence. It
contains the following sections:

¢ Integrating Cisco TelePresence with Your Cisco WebEx Site Administration Account, page 10-1
e Assigning the Meeting Center TelePresence Session Type, page 10-3

e Network-Based Recording of WebEx Enabled TelePresence Meetings, page 10-6

¢ Installing the WebEx and TelePresence Integration to Outlook, page 10-6

e Setting the Time Zone and Language Preferences for a User’s WebEx Account, page 10-8

e Configuring TSP Audio for a User’s WebEx Account, page 10-9

Integrating Cisco TelePresence with Your Cisco WebEx Site Administration
Account

You have access to the Cisco WebEx Site Administration interface through your WebEx Account Team
using a unique WebEx Site Administration URL and password. As a site administrator, you must log in
to integrate and provision your account during first time setup. After you have completed the first-time
setup, you can manage your account and access WebEx user and administration guides for the services
and features that have been configured on your Cisco TelePresence system.

Proceed to the following sections to complete first-time setup:
e Cisco TelePresence Cisco WebEx Integration Options, page 10-1

¢ Assigning the Meeting Center TelePresence Session Type, page 10-3

Cisco TelePresence Cisco WebEx Integration Options

To integrate Cisco TelePresence to Cisco WebEx:
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Step 1
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Step 3

Home

Manage Site
Site Settings
Tracking Codes
Company Addresses
Ernail Ternplates
Meetings in Progress
Partner Authentication
Manage Users
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Edit Privileges
Send Ernail to All
Session Types
Add Custorn Type
Session Tvpe List
Assistance

Help

Log out

Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Step 10

Log in to the WebEx Site Administration interface using your WebEx Site Administration URL
username and password.

This is the URL for your WebEx site, followed by a forward slash (/) and the word “admin”.
Example—https://example.webex.com/admin
On the left navigation bar under Manage Site, choose Site Settings. The Site Settings screen appears.

Scroll down to OneTouch TelePresence Options, as shown in Figure 10-1.

Figure 10-1 Configuring Cisco WebEx Connection Settings

Site Administratio

E| Select Cormman for settings that apply to maore than one serice

Cornrmon Select a service for settings that are spacific to one senice

Site Settings for:

OneTouch TelePresence Options

V] Allow Cisco WWebEx OneTouch meetings (MC anly)
Enter the Cisco TWS (Cisco TelePresence Management Suite) booking service URL to connect your WebEx site to the TelePresence scheduling system.
Cisco TMS booking service URL: https://ctg-alpha-scheduler! . cisco. com (Example: https:#tmsbookinghost. dormain. corn)

V| List TelePresence meetings on calendar
| Send invitation email to meeting host

[¥] Display toll-free number to participants

[¥] Enable TelePresence bandwidth contral

|| Display TelePresence welcome screen

WebEx VolP and video connection:
@ Automatically encrypted UDP/TCP S50
O TCP S5L

[T] Disable Hybrid valP

Click to select Allow Cisco WebEx OneTouch meetings (MC only). If not checked, Cisco WebEx will
be disabled on this site and the rest of the Cisco TelePresence integration options will be grayed out.

If you are deploying the Cisco WebEx Enabled TelePresence solution with the option to schedule
meetings using the WebEx and TelePresence Integration to Microsoft Outlook, you must enter the host
address for the TelePresence Management Suite Extension for Microsoft Exchange (TMSXE) in the
Cisco TMS booking service URL field. For more information about configuring TMSXE, see
Chapter 6, “Configuring Cisco TelePresence Management Suite.”

Click to select List Cisco TelePresence meetings on calendar so that scheduled meetings appear on the
Cisco WebEx calendar.

Click to select Send invitation email to meeting host. This allows the meeting information email to be
sent to the Cisco WebEx host after the meeting is scheduled.

Click to select Display toll-free number to attendees. This enables the system to show the toll-free
number that attendees can call to join the meeting.

(Optional) If you want to display the TelePresence welcome screen, click to select Display TelePresence
welcome screen. The welcome screen displays the participants that are currently connected to the
meeting as well as other meeting information. It is displayed when no content is being shared by
participants. The welcome screen is off by default.

In the WebEx VOIP and video connection field, click one of the following:

e Automatically encrypted UDP/TCP SSL—(Recommended) Allows the TelePresence Server or
MCU to connect over UDP with the Cisco TelePresence Gateway. If the UDP connection is not
allowed, TelePresence Server or MCU will fall back to TCP.
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Step 11

Step 12
Step 13
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e TCP SSL—Connects over TCP over a SSL connection.

This selects the connection method between the Cisco WebEx client and the multimedia server (VOIP
and video).

(Optional) If you do not want users to use VoIP audio on this WebEXx site, check the box Disable Hybrid
VOIP.

This disables VoIP for all meetings on the site, not only WebEx-enabled TelePresence meetings.
Scroll to the bottom of the page and click Save to save your settings.

Proceed to Assigning the Meeting Center TelePresence Session Type to complete your setup.

Assigning the Meeting Center TelePresence Session Type

You must assign the Meeting Center TelePresence session type to host accounts in the WebEx Site
Administration interface to complete your setup. You can do so by either opening the Edit User screens
for an individual user, or by selecting the appropriate session type for each user from the Edit User List
screen. When you add a new user, this session type is assigned by default. Check for or configure this
session type using the steps in the following sections:

e Adding the Cisco TelePresence Session Type in the List of Users, page 10-3
¢ Adding the Cisco TelePresence Session Type in the Edit User Screen, page 10-5

Support for Custom Session Types

Custom session types can now be created which allow customers to restrict WebEx features for a specific
group of users. For example, you could create a custom session type to disable recording, chat or
annotation for a certain group of users.

The Default TelePresence Session Type (which can be set to a custom session type) is used by default
when a meeting organizer schedules a meeting. If the meeting organizer is scheduling the meeting using
the WebEx and TelePresence Integration to Outlook plug-in, they will be able to select a different custom
session type, if it has been configured at the Site Administration level. The WebEXx site administrator can
selectively decide which users have access to specific custom session types. When a meeting organizer
schedules using TMS, Smart Scheduler or the WebEx Scheduling Mailbox, the Default TelePresence
Session Type is always used.

To enable custom session types for your WebEx site, contact WebEx cloud services. Once enabled, you
can create a custom session type by going to the left navigation bar under Session Types, and choosing
Add Custom Type. For details on how to create a custom session type, refer to the WebEx Site
Administration help.

Adding the Cisco TelePresence Session Type in the List of Users

Step 1

In the left navigation bar under Manage Users, choose Edit User List. The Edit User List screen
appears, as shown in Figure 10-2.

| oL-21352-02

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29 g



Chapter 10 Integrating Cisco TelePresence with Your Cisco WebEx Site Administration Account |

W Contents

Figure 10-2 WebEx Site Administration - Edit User List
ex Site Administntioi
Home Edit User List
Manago Sita User name: | Ermail: | Search
ite Settings
Trad ades
¥ Show active accounts only  View: [All Accounts - Sort list by: [UserName =] [As
Index ABCDEESHIJELMNOPRAQRSTIUY WX XYZ#AI
Session Type
Active Name Email User Name Create Time PRO AUO
e Hame A namea@yourcompany.com  namea 2/19/10 11:55 am =2 2
3 Hame B nameb@yourcompany.com  nameb 2018410 10:38 am 1= v
cd Marme C namec@yourcampany Com - Namec 2/18/10 10:561 am =2 2 ©
Log out I Hame D named@yourcompany.com  namee 2/18/10 10:42 am = v &
I Hame E names@yourcompany com  named 48710 4:07 pm =2 2 122 5

Step2  Identify which PRO column represents the Meeting Center TelePresence session type.

Each Cisco WebEx user account has a corresponding set of Session Type check boxes that indicate which
Cisco WebEx session types have been enabled for that user; “Meeting Center TelePresence” is one of
the “PRO” sessions types. (Other session types, such as Meeting Center Pro meeting, can also have a
“PRO” headline, as shown in Figure 10-2.)

To determine which column represents the Meeting Center Telepresence session type, click any of the
“PRO” Session Type headers. A separate window opens that describes that session type, as shown in
Figure 10-3. Locate the column that brings up the session type feature list titled “Supported Features in
TelePresence”; this is the Meeting Center TelePresence session type.

a~

Note  The number of session type columns is determined by how many session types the WebEx site
supports.

Step3  To verify that a user is assigned the Meeting Center TelePresence session type, locate the user entry on
the Edit User list and select the check box for the appropriate PRO session type identified in Step 2.

Step4  Scroll to the bottom of the page and click Submit.
If you do not find the Meeting Center TelePresence session type, or if there is no “Supported Features

in TelePresence” window present after you have clicked all “PRO” Session Types, the site is not properly
configured for WebEx Enabled TelePresence.
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Figure 10-3 Supported Features in TelePresence
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This session type will be assigned by default when you create new host accounts by using the Add User
link on a TelePresence-enabled WebEx site. The user must have this session type assigned in order to
schedule OneTouch meetings. If this site is an existing site updated to WebEx Enabled TelePresence, you
must add the Meeting Center TelePresence session type to existing users.

Adding the Cisco TelePresence Session Type in the Edit User Screen

Step 1
Step 2

You can also set the Meeting Center TelePresence session type in the account settings for each individual
user. Do the following while still on the Manage Users > Edit User List page:

Locate the user entry and click on it to open the Edit User window for that account.

Scroll down to the Privileges section. The assigned session types are shown in the Session Type Allowed
box, as shown in Figure 10-4.
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Figure 10-4 Session Types Allowed
Privileges:
Service Session Type Allowed
Select All | Clear All
Meeting Center PRO: Meeting Center Pro meeting
[¥] AUO: WebEx Personal Conference
[C] PRO: Meeting Center Pro Eval 4x20
[¥] PRO: Meeting Center TelePresence
Step3  Required. Check the box for PRO: Meeting Center TelePresence, as shown circled in red in
Figure 10-4.
Step4  Click the Update button at the bottom of the window to save your PRO: Meeting Center TelePresence

Tip

Session Type setting.

This completes setting meeting center Cisco TelePresence Session Type privileges in the Cisco WebEx
Site Administration. Your Cisco WebEx account is now fully integrated and provisioned.

To upgrade any features, notify your Cisco WebEx business contact.

Network-Based Recording of WebEx Enabled TelePresence Meetings

With release T29 of WebEx, meeting organizers can now record WebEx Enabled TelePresence meetings.

e The WebEx and TelePresence Integration to Outlook and WebEx Meeting Center client
automatically discover if recording is enabled and display the appropriate message.

¢ Playback of a recorded meeting displays both WebEx and TelePresence video with content share,
chat and polling (if enabled)

e User can navigate through recording via playback controls or clicking thumbnails of the video
e User can see a visual representation in the recording of when participants are talking.

Network-based recording is enabled by WebEx Cloud Services.

Installing the WebEx and TelePresence Integration to Qutlook

Meeting organizers who want to schedule meetings using the WebEx and TelePresence Integration to
Outlook plug-in, must download and install the WebEx Productivity Tools with TelePresence from your
WebEcx site.

Before you install, make sure you have the following information for your WebEx site and TMSXE:
e WebEx Site URL
e WebEx User Name

l_ Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29

oL-21352-02 |



| Chapter10 Integrating Cisco TelePresence with Your Cisco WebEx Site Administration Account

Step 1
Step 2
Step 3
Step 4

Step 5
Step 6
Step 7

Step 8

Step 9

Contents W

e WebEx Password
e TMSXE User Name
e TMSXE Password

~

Note  Contact your WebEx or IT administrator for this information.

To install the WebEx Productivity Tools, users must do the following:

Open a browser and go your WebEx site.
Click My WebEx.

Log in to your account.

If your site is enabled to automatically prompt you to download the WebEx Productivity Tools, you will
be presented with that option. If, so click Yes to begin the download and then skip to step 7. If not, go
to the next step.

In the left-hand navigation bar, click Productivity Tools Setup.
The ptools.msi file is downloaded to your computer.

After the download is complete, open ptools.msi and follow the on-screen instructions to install the
WebEx Productivity Tools.

During the installation you must log in to your WebEXx site.

Figure 10-5 WebEx Productivity Tools Login

("™ WebEx Productivity Tools

Please enter your WebEx accounk information:

Sike URL: | hitps:/fexample webex.com

Example: meetingcenter webex.com

User Mame: | Jjsrnith

Pegsnaih | [——

Remember my password

Forgot your password?

Login Cancel

Enter your WebEx Site URL, User Name, Password and click Login.

After logging in, the WebEx Productivity Tools communicates with the server and then your are asked
to log into TMSXE.
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Figure 10-6 TMSXE Login

|
Connect to example-tmsxe. example.com E E

=
k| \

Connecking to example-trsxe.example.com

|ﬂ Jjsmnith j

User name:

Password:

Enter your TMSXE User name and Password and click OK.
When the message “WebEx Productivity Tools are installed” appears, click OK.
Close the Productivity Tools window.

You can now open Microsoft Outlook and schedule WebEx Enabled TelePresence meetings using the
WebEx and TelePresence Integration to Outlook.

Setting the Time Zone and Language Preferences for a User's WebEx Account

Step 1
Step 2
Step 3

Step 4

For best results, meeting organizers using Outlook for scheduling, should do the following:
e Set their WebEx and Outlook time zones to the same time zone.

If a meeting organizer’s WebEx and Outlook time zones do not match, meetings will not be
scheduled at the same time in both WebEx and Outlook.

e Make sure their preferred language is selected in their WebEx account.
The selected language is the language that all invitees will see in the meeting invitation.

To set the WebEx time zone and preferred language for a WebEx account, users must do the following:

Open a browser and go to your WebEX site.
Click My WebEx.
Enter your WebEx username and password and click Log In.

If you are presented with an option to download the WebEx Productivity Tools and you have already
downloaded them, click Later. If you wish download and install them now, refer to step 4 of Installing
the WebEx and TelePresence Integration to Outlook, page 10-6

The My WebEx Meetings page appears.
In the right corner of the page, the current language and time zone settings are displayed.

To change the language and time zone, click on the link that displays either the current language or time
zone.

The Preferences page appears.
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Step5  Using the Time zone and Language menus, select the time zone and language you wish to use for your
WebEx Enabled TelePresence meetings.

Step6  Click OK.

Configuring TSP Audio for a User's WebEx Account

Meeting organizers who need to schedule WebEx Enabled TelePresence meetings that use TSP audio,
must add TSP audio provider information to their account.

For details, refer to Configuring TSP Audio for the Meeting Organizer, page 9-11.

Where to Go Next

For complete information about managing your Cisco WebEx Administration Site account, refer to the
Help on your WebEXx site.
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Scheduling Cisco WebEx Enabled TelePresence
Meetings
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Contents

This chapter provides a background on how to schedule Cisco WebEx Enabled TelePresence meetings,
with tips and known issues. It contains the following sections:

¢ Introduction, page 11-2
e Scheduling WebEx Enabled TelePresence Meetings in Cisco TMS, page 11-3
e Information, Tips and Known Issues About WebEx Enabled TelePresence Meetings, page 11-5
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Introduction

This chapter provides an overview of how to schedule WebEx Enabled TelePresence meetings using
TMS and useful information, tips and known issues about WebEx Enabled TelePresence meetings.

In addition to scheduling using TMS, there are up to 3 additional ways to schedule a WebEx Enabled
TelePresence meeting:

Using the Cisco WebEx and TelePresence Integration to Outlook

With the WebEx and TelePresence Integration to Outlook, users can schedule WebEx Enabled
TelePresence meetings directly from Microsoft Outlook for Windows. Advanced options like adding
external video and audio dial-in participants are also available.

For scheduling information, refer to the WebEx and TelePresence Integration to Outlook Quick
Reference Guide

For additional information, including how to schedule a meeting on behalf of another person or to
assign a delegate to schedule meetings for you, refer to the WebEx and TelePresence Integration to
Outlook help available in Outlook or the user guide, available on your WebEx site.

Using the Cisco Smart Scheduler

With Cisco Smart Scheduler, Macintosh, mobile and other non-Windows users can schedule WebEx
Enabled TelePresence meetings using a simple web-based interface which is touch-screen friendly.

For scheduling information, refer to the Cisco Smart Scheduler and WebEx Scheduling Mailbox
Quick Reference Guide

For additional information, including supported browsers and mobile platforms, refer to the Cisco
TelePresence Management Suite Provisioning Extension (TMSPE) release notes.

Using the Cisco WebEx Scheduling Mailbox

With the Cisco WebEx Scheduling Mailbox, users without the WebEx and TelePresence Integration
to Outlook can create a TelePresence Enabled WebEx meeting in Outlook by inviting TelePresence
rooms and then adding WebEx to the meeting by including a special invitee; the WebEx Scheduling
Mailbox.

The mailbox may be called simply “webex” or something different. It as configured by the
administrator and provided to users.

For additional information, refer to the Cisco TelePresence Management Suite Extension for
Microsoft Outlook (TMSXE) Installation Guide and release notes.

For scheduling information, refer to the Cisco Smart Scheduler and WebEx Scheduling Mailbox
Quick Reference Guide
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Scheduling WebEx Enabled TelePresence Meetings in Cisco

TMS

Step 1
Step 2

Step 3

Step 4

Step 5
Step 6
Step 7

Note

When scheduling conferences with Cisco TMS, it is not necessary for the user to worry about network
protocols, MCUs, or gateways. Cisco TMS handles infrastructure choices and compatibility checking of
all these things automatically. Advanced users may still tune and tweak the selected methods for the

conference as needed.

To schedule a Cisco WebEx Enabled TelePresence Meeting:

Log in to Cisco TMS.

Go to Booking > New Conference.

Figure 11-1 Cisco TMS New Conference page

atf e
cisco TelePresence Management Suite
Pt Pottal (75 Booking

New Conference

Basic Settings
Title: Example Mesting Start Tine: 104 202012
Type: Automatic Connect hd

End Time: {001 202012

Cwyner: Plummer, kzrk

Duration: 0:30
Includs ¥ehEx Conference
WighEx Meeting Pazsword 1234

Agvanced Settings

Picture Macle:

Enhanced CP Billing Code:

IP* Banduwidth: 2043 kbps v PassworciPik:

1D Bandwict: | g r 384 kbps [1isDn Restrict

Secure: Extend Mode: | aytomatic Best Effort

Parlicipanis | Conference Information
Mo participants added to the conference.

Add Participarts..

Save Conference

“You are here: » Booking » M

- - Recurrence: None
AL

= - Recurrence Settings...
[RETE

Setup Butfer: o Minutes

Tear Down Bufter: | o Minutes

For Title, enter a conference title. It will be displayed in all Cisco TMS interfaces, and in email

notifications about the meeting.

For Type, select either Automatic Connect or One Button to Push.

e Automatic Connect: Cisco TMS automatically connects all participants at the meeting start time.

¢ One Button to Push: Meeting dial-in information is automatically displayed on endpoints that
support One Button to Push. Participants on those endpoints join the meeting by pressing a button.
For endpoints that do not support One Button to Push, the meeting organizer adds a video dial-in

number.

~

For information about additional types, refer to the TMS help.

Make sure Include WebEx Conference is checked.

Optionally, enter a WebEx Meeting Password.

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
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Step 8

Step 9

Step 10

Step 11

Step 12

Step 13

Step 14

~

Note If you do not enter a password, WebEx will automatically generate one. It will be displayed on
the Confirmation page, after you successfully schedule the meeting.

Optionally, click Recurrence Settings to create a series of meetings that are tied together, such as a
weekly or daily meeting.

>
Note  Advanced settings are optional. Most settings will take their default values from the Conference

Default values configured under Administrative Tools. Refer to the help for an overview of all
available settings. For details on the Advanced Settings, click the Help button in Cisco TMS.

~

Note  If Secure is set to Yes, Cisco TMS will only allow systems that support encryption to participate
in the conference.

Optionally, add notes about the meeting in Conference Information, which will appear in the meeting
invitation.

In the Participant tab, click Add Participant and a new window will appear.

e Available participants and a planner view with their availability is displayed based on existing
scheduled and ad hoc meetings. The colored vertical lines represent your current requested time for
the scheduled meeting.

¢ Click the tabs to have participants listed by type. If you have used scheduling before, the default tab
is Last Used with quick access to the systems you have used recently.

e Hover over any system, or the blocks in the planner view, for additional detail about the system or
scheduled meeting.

Add participants to the meeting by selecting their checkbox and clicking the > button to add them to the
list of selected participants on the right side of the window. Adding network infrastructure components
like MCUs and Gateways is optional as Cisco TMS will handle this for you automatically.

Use the External tab to add systems not managed by Cisco TMS, for example endpoints in other
organizations, or telephone participants.

¢ For dial-out participants, enter their contact information, and Cisco TMS will automatically connect
them to the conference at the scheduled time.

e For dial-in participants (including endpoints that do not support One-Button-to-Push), Cisco TMS
will reserve the capacity needed to host the site in the conference and will provide you with precise
dial-in information to forward to the participant.

When all participants have been added, click OK.

You are returned to the conference page, with the participant section of the page now showing your
selected participants, and some additional tabs. These additional tabs allow advanced scheduling tasks
such as altering how calls are connected, or setting specific MCU conference settings for the meeting.

Use the Video Conference Master drop-down list to determine which system should be considered the
meeting organizer. Not all telepresence systems support the necessary features for this functionality, and
only systems that are eligible will be displayed in this list. This is the system that will be prompted:

e to connect the conference if it is not scheduled for automated call launch.

¢ to extend the conference when it is about to expire.
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Step15 Click Save Conference. When the conference is saved, Cisco TMS will do all the routing calculations
to determine the best way to connect your selected participants.

e If Cisco TMS is able to complete your request:

- You are presented with a confirmation page indicating that your conference has been saved and
showing the details of your meeting, including the participant list and listing how each of those
participants are scheduled to connect to the conference and the exact dial string any participants
must dial.

— You will also receive an email confirmation from Cisco TMS with all meeting information,
including WebEx and video dial-in information, and an ICS attachment for saving the event in
your Outlook (or a compatible) calendar. Open the ICS attachment and save it to your calendar.

— If your WebEx site is set up to send email confirmations, you will receive two additional emails
from WebEx: 1. An email with the subject line “Meeting Scheduled” which contains the host
key and the WebEx information for the meeting 2. An email with the subject line “(Forward to
attendees) Meeting Invitation” which contains only the WebEx information for attendees.

e If Cisco TMS is unable to complete your booking request:

— You are returned to the New Conference page. A message banner states why it was not possible
to save the meeting. This may be due to lack of availability, lack of network resources, or no
known route to connect the participants together.

- Edit the conference settings to try to resolve the issue and try saving the conference again.

Step16  After successfully scheduling your meeting, invite people to the meeting using your calendar
application.

For information about the Cisco WebEx Enabled TelePresence meeting experience, see Cisco WebEx
Enabled TelePresence Experience, page 1-1.

Information, Tips and Known Issues About WebEx Enabled
TelePresence Meetings

The following section contains useful information, including tips and known issues relating to Cisco
WebEx Enabled TelePresence meetings. The information is divided into sections corresponding to each
product that is part of the Cisco WebEx Enabled TelePresence Solution.

Cisco TMS

e Cisco TMS can be configured so that meetings must be approved by the Cisco TMS administrator
before getting booked. This feature can be used to regulate port usage at companies that want to limit
/ regulate usage.

e Cisco TMS limits the number of ports to the number selected under the external tab of the Cisco
TMS meeting when it is scheduled.

e Starting a meeting early is supported for both TelePresence and WebEx using the Default Setup
Buffer setting when scheduling the meeting.

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
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~

Note Setup (and teardown) buffers are not supported when using Smart Scheduler, the WebEx and
TelePresence Integration to Outlook, or any other client that uses the TMS booking API.

e Extending a meeting is supported for both TelePresence and WebEx using the Extend Mode setting
when scheduling a meeting. Meeting extension is not guaranteed. If resources (ports) are fully
booked at the scheduled end time of the meeting, the meeting will end.

e A meeting organizer scheduling a meeting using the WebEx and TelePresence Integration to
Outlook, should never modify that meeting later in TMS.

If the original meeting is modified later in TMS, the meeting information in TMS will fall out of
sync with the meeting organizer’s Outlook calendar. The reason for this is that TMSXE does not
have write access to the meeting organizer's calendar and, as a result, can’t make any changes to it.

MCU and TelePresence Server

e At the start of the meeting, the MCU/TelePresence Server calls into WebEx, even if there are no
TelePresence or WebEx participants.

e The MCU/TelePresence Server’s role is different from a regular WebEx participant. When joining
the meeting, if there is no meeting host currently in the meeting, the MCU becomes the default host
and starts the meeting.

- If there is already a WebEx host, MCU/TelePresence Server will not become the host.

— If WebEx host leaves the meeting, the MCU/TelePresence Server becomes the host and the
meeting continues.

e If MCU/TelePresence Server leaves the meeting before the WebEx host leaves, the meeting
continues.

e If MCU/TelePresence Server leaves the meeting after the WebEx host leaves, the meeting ends.
e If WebEx host leaves the meeting after the MCU/TelePresence Server leaves, the meeting ends.

e If WebEx host stays in the meeting after the MCU/TelePresence Server leaves, the WebEx meeting
continues.

e TelePresence Server by default, sends video in the ActivePresence screen layout, which displays the
active speaker in a full screen pane with additional participants appearing in up to six equally sized
overlaid panes at the bottom of the screen (up to four panes for 2 and 4 screen endpoints). In
full-screen mode in WebEx, WebEXx participants appear in equally sized panes below the
TelePresence video at the bottom of the window. MCU by default, sends video in a full-screen
layout.

Endpoints

¢ Participants joining the meeting from any TelePresence endpoint may not see the presentation from
WebEXx if they are using their endpoint as a computer monitor.

¢ Content presented from an EX60 can take a long time to appear. If the endpoint is registered to
Unified CM, this can be resolved by enabling User-Agent passthrough in Unified CM.
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TMSXE

WebEx

Information, Tips and Known Issues About WebEx Enabled TelePresence Meetings

When booking a meeting using Web Scheduling Mailbox, if TMSXE detects an error condition (ex: not
able to connect with WebEXx server), the error email is sent in plain text format to the meeting organizer.

A black silhouette is shown for a WebEx user when they do not have their camera on or when they
do not have enough bandwidth to send video using their WebEx client.

In the WebEx Meeting Center, all TelePresence endpoints are displayed as one WebEx participant
called “TelePresence systems” both in the Participant list and when a TelePresence user is the active
speaker.

— In the Meeting Center full screen view, the “TelePresence systems” participant appears as a
black silhouette, as shown in Figure 2.

Figure 2 “TelePresence systems” in Full Screen View

TelePresence systems

The WebEx host can mute all or individual participants after they join the meeting. It is not possible
to mute TelePresence participants through the WebEx client. TelePresence participants must mute
themselves.

To mute WebEXx participants, you have to be the WebEx host.
— To reclaim the host role, you have to get the WebEx host key.

Audio quality can be bad for WebEx participants using Computer Audio when attending using the
WebEx Meeting Center client on Windows or Mac. Cisco recommends users to call in with a phone
using the audio conference number for the meeting.

The meeting is started by the first participant who joins the meeting (host or other WebEx
participant). The rest of the participants “join” the meeting.

A non-host user can start the meeting only if the “Join Before Host” feature is enabled on the site,
and its start time could be 5/10/15 minutes (set a time of scheduling) before the scheduled time.
Otherwise, a non-Host has to wait for the meeting to be started by the host before they can join.

If a WebEx audio only participant is talking, the last video participant to talk is displayed until the
next video participant speaks.

The user's Outlook time zone and WebEx account time zone must be the same for the meeting to be
scheduled at the correct time in both Outlook and WebEx.

When the WebEx portion of the meeting ends, the audio will end too.
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e The link bandwidth between MCU and WebEx is set by the WebEx client with the lowest bandwidth.
The bandwidth of the link can go up as soon as the WebEx client with the poorest bandwidth leaves
the meeting. For example, if a WebEx client that joins the meeting is only capable of 360p, the
maximum bandwidth for all participants will be 360p. When that participant leaves the meeting, if
all other participants are capable of a higher bandwidth, like 720p, the bandwidth will go up for all
participants.

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29



cunrren 12

Troubleshooting

Revised: October 2013

Contents

e Verifying and Testing, page 12-1
¢ Troubleshooting Tips, page 12-1
e Managing System Behavior, page 12-10

Verifying and Testing

e Cisco WebEx Site Administration Online Help, page 12-1

Cisco WebEx Site Administration Online Help

For complete information about using Cisco WebEx Site Administration, go to the Cisco WebEx Site
Administration Help:

Step1  Login to Site Administration for your WebEx site.
This is the URL for your WebEx site, followed by a forward slash (/) and the word “admin”.
Example—https://example.webex.com/admin

Step2  In the left-hand side of page under Assistance, click the Help link.

Troubleshooting Tips

This section provides troubleshooting tips for problems with the following aspects of a
Cisco WebEx Enabled TelePresence meeting:

e Problems with Scheduling a Meeting, page 12-2
e Problems with Starting or Joining a Meeting, page 12-3

Cisco WebEx Enabled TelePresence Configuration Guide - TMS 14.3.1 - WebEx Meeting Center WBS29
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e Problems During a Meeting, page 12-4

e Problems with a TSP Audio Meeting, page 12-7

e Managing System Behavior, page 12-10

Problems with Scheduling a Meeting

This section describes possible issues the meeting organizer may experience when scheduling a meeting

using Cisco TMS.

Refer to troubleshooting information in Table 12-1 to solve common problems that prevent meetings
from being scheduled correctly.

Table 12-1

Problems with Scheduling Meetings

Problem or Message

Possible Causes

Recommended Action

The meeting organizer receives no email
from Cisco TMS to confirm the meeting
is scheduled.

Cisco TMS configure to send
confirmation email.

Check Cisco TMS configuration.

If Cisco TMS configuration is correct,
check antivirus/firewall program(s) to

see if they are blocking the Cisco TMS
from sending.

After meeting organizer schedules a
meeting using TMS, the following error
is displayed: “An unexpected error
occurred while communicating with
WebEx.” The meeting is created, but
there are problems with the WebEx
configuration. They receive a meeting
confirmation email that contains no
WebEx information.

Meeting organizer’s WebEx host
account is not provisioned with the
Meeting Center TelePresence session

type.

Log into WebEx Site Administration for
your WebEx site and make sure the
meeting organizer’s host account has the
Meeting Center TelePresence session
type enabled. For more information,
refer to: Assigning the Meeting Center
TelePresence Session Type, page 10-3.

Meeting is not listed on the endpoint
display.

More than one scheduling server is
managing the endpoint (Example: Cisco
TMS and CTS-Manager and at the same
time).

Other causes:

¢ Scheduled meeting type is not
One-Button-to-Push (OBTP). Only
OBTP meetings appear on an
endpoint.

e Network connection failure
between endpoint and Cisco TMS.

If pushed to all but one endpoint, then
check the network connection.

If not pushed to any endpoints, check to
see if Cisco TMS is down.

In Administrative Tools > Configuration
> WebEXx Settings, select the WebEx site
and make sure Connection Status is
“Connection OK”.
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Table 12-1

Problems with Scheduling Meetings (continued)

Troubleshooting Tips

Problem or Message

Possible Causes

Recommended Action

WebEx scheduling error in Cisco TMS
(when clicking Save)

Symptom: Cisco TMS displays 'Unable
to include WebEx conference. Incorrect
WebEx username or password.'

Network problems with WebEx site.

WebEx user doesn’t exist on WebEx
site.

Cause: WebEx site configured for this
organizer does not recognize the WebEx
username/password configure for the
meeting organizer.

Check WebEx account user profile.

Recommended Action: Check the
WebEx Username/Password for the
WebEX site in the user personal
information page. Or the WebEx site
user credential information may have
changed. In this case, check with WebEx
site administrator.

Refer to Cisco TMS Troubleshooting
information. This issue is not limited to
Cisco WebEx Enabled TelePresence.

No confirmation emails from WebEx

Email is not enabled on the WebEx site

Check the WebEx site administrator.

Meeting is booked on the TMS but the
WebEx does not exist.

Endpoints booked for the meeting are
configured as mailboxes in Exchange
but are not set to AutoAccept

Ensure that all endpoints that are
available as mailboxes for booking in a
Cisco WebEx Enabled TelePresence

invitations. meeting are set to AutoAccept in
Exchange.
“We’ve hit a glitch in connecting to the |[TMSXE Contact the TMSXE administrator.

telepresence scheduling system. Try
again later.”

I don't see the WebEx option when
scheduling a meeting in TMS.

Your WebEx Username and Password
have not been added to your TMS user
profile.

Edit your TMS user and enter your
WebEx username and password and then
save. The WebEx option should now
appear in the TMS scheduling UI.

Problems with Starting or Joining a Meeting

This section describes possible issues meeting participants may experience when starting or joining a

meeting.

Refer to troubleshooting information in Table 12-2 to solve common problems that prevent participants
from starting or joining meetings.

Table 12-2

Problems with Starting or Joining Meetings

Problem or Message

Possible Causes

Recommended Action

Can’t join the WebEx meeting

Meeting hasn’t started yet

wait for meeting to start

No endpoint can join the TelePresence
meeting.

TelePresence meeting doesn’t exist.

Call failed to be routed correctly.

1. Check MCU/TelePresence Server to
make sure conference was created.

2. Check MCU/TelePresence Server
event log.

3. Check VCS search history.

TelePresence meeting didn’t start early
(Early Meeting Start) didn’t work

Cisco TMS scheduled meeting doesn't
support early start. Endpoint must wait
until meeting has started to dial in.

Check Setup Buffer and Tear Down
Buffer settings
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Table 12-2

Problems with Starting or Joining Meetings (continued)

Problem or Message

Possible Causes

Recommended Action

Single TelePresence participant can’t
join the meeting

Not enough video and audio ports.

Call routing issue for the endpoint to
MCU or TelePresence Server

Check event log for the meeting. Also
check meetings in TelePresence Server
or MCU.

Administrator can lift the limit by
changing the port value from the
TelePresence Server Conferences page.

TelePresence participant can only join
via audio only.

Not enough video ports are available.

Increase the video ports in Cisco TMS,
TelePresence Server or MCU.

No TelePresence participants can join
the meeting

Meeting hasn't started yet. Cisco TMS
scheduled meeting doesn't support early
start. Endpoint must wait until meeting
has started to dial in.

Total audio and video ports for the
MCU/TelePresence Server have been
used up. Another cause is that the port
video/audio limit for the meeting has
been reached.

If total port capacity of
MCU/TelePresence Server has been
reached, no action is required.

For the case of the meeting limit being
reached, the administrator can lift the
limit from the TelePresence Server
Conferences page.

MCU/TelePresence server disconnects
after WebEx host joins the meeting.

WebEx host is currently joined to
another meeting of which they are also
the host.

e Do not use the same WebEx host ID
to join multiple meetings at the
same time.

Only one WebEx Enabled TelePresence
meeting can be run per host at a time.

Problems During a Meeting

This section describes possible issues meeting participants may experience during a meeting.

Refer to troubleshooting information in Table 12-3 to solve common problems during the meeting.
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Table 12-3

Problems During the Meeting

Troubleshooting Tips

Problem or Message

Possible Causes

Recommended Action

No WebEx welcome screen

Content disabled on MCU.

Video call from MCU/TelePresence
Server to WebEx failed. Call failure
occurs for several reasons:

- WebEx SIP dialing fails to reach
destination due to unresolvable SIP URI

- WebEx server(s) down
- Issues with search rules in VCS

- Media Encryption setting in VCS

e Check MCU configuration and
conference status.

e Verify search rules to ensure that
SIP URI being routed correctly to
WebEcx site.

e Verify encryption setting in VCS for
this zone.

e Iffailure persists after above actions
are taken, contact WebEx site
administrator.

TelePresence is not linked to WebEx

Video call from MCU/TelePresence
Server to WebEx failed. Call failure
occurs for several reasons:

- WebEx SIP dialing fails to reach
destination due to unresolvable SIP URI

- WebEx server(s) down
- Issues with search rules in VCS

- Media Encryption setting in VCS

Don’t see video on WebEx

WebEx participant does not enable
video.

WebEx participant has a problem with
their camera.

e Make sure TelePresence and WebEx
calls are connected.

e Check to see if participants who
joined TelePresence are sending
video.

Don’t see video on TelePresence

e Check to see if WebEx users have
joined and are sending video.

Don’t hear audio on WebEx

e Check TelePresence call statistics
and make sure TelePresence
endpoint is not muted.

e Check to see if WebEx users can
hear each other.

Don’t hear audio on TelePresence

e Check TelePresence statistics to see
if audio is being received from the
WebEx side. In PSTN/TSP audio
case check that the audio call is
connected.

Don’t see presentation shared from
WebEx side on TelePresence side

e Check TelePresence statistic for
content channel status.

e Check to see if WebEX users can see
content from each other.
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Table 12-3

Problems During the Meeting (continued)

Problem or Message

Possible Causes

Recommended Action

Don’t see presentation from
TelePresence side on WebEx side

e Check TelePresence statistic for
content channel status.

e Check to see if WebEx users can see
content from each other.

Don’t see presentation from WebEx on
WebEx side

¢ Contact the WebEx administrator
for assistance.

Don’t see presentation from
TelePresence side on TelePresence side

e Check TelePresence call statistics to
see if content channel is established.

e Try to stop the restart sending
content.

Presentation is displayed in main video

e Check current call statistics for
content channel.

¢ Check to see if the SIP call
encrypted.

Poor quality video from WebEx
participants on TelePresence side

e Check network bandwidth for
possible poor network connection.

Poor quality video from TelePresence
participants on WebEx side

Poor network connection

e Check call statistics for
TelePresence participants.

Audio skewed from video (lip sync
issues)

In the case of PSTN/TSP audio, lip sync
cannot be guaranteed

Active speaker does not switch in

e Make sure audio and video calls are
linked in PSTN/TSP case.

Video for active speaker call-in
participant does not switch in when they
speak and no phone icon associated with
them.

1. WebEx site administrator not
configured properly.

2. Audio call failed.

3. If the MCU sends the wrong
participant ID.

e Check in Cisco TMS CCC or on
MCU to see if audio call failed.

e (Call-in user merge requires the site
to have '"TSP identity code' enabled
in WebEx site administrator. If
disabled, call-in merge will not
work even if you dial the correct
value, and #1 is correct for intercall.

Poor quality presentation from
TelePresence participants on WebEx
side

Possible network issue.

e Check the bandwidth between
TelePresence and WebEx.

Video from a WebEx participant frozen

Possible network issue.

e Check the bandwidth between
TelePresence and WebEx.

Meeting ends unexpectedly

¢ Check TelePresence log to see any
cause for the call drop.

Meeting didn’t automatically extend

TelePresence is booked for another
meeting starting at the end of the current
one.

e Check Cisco TMS booking list to
confirm.
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Problems with a TSP Audio Meeting

Troubleshooting Tips

This section describes possible issues with a meeting that uses TSP audio.

Refer to troubleshooting information in Table 12-4 to solve common problems with TSP audio meetings.

Table 12-4

Problems with a TSP Meeting

Problem or Message

Possible Causes

Recommended Action

TelePresence joins audio of host’s
previously scheduled meeting that had
run beyond the scheduled end time.

The TelePresence system will dial into
the hosts audio conference at the
scheduled time. It is possible that the
host is in a previous audio conference
that is running overtime.

Example:

The host account used by TelePresence
is that of a real WebEx host. If that host
account has scheduled two back to back
meetings (first one is WebEx meeting
and the second one is TP+WebEXx). Host
starts first meeting and it runs overtime.
But at the start time of the
TelePresence+WebEx meeting,
TelePresence dials into the TSP
conference using the dumb-dial string,
and may get into the conference. Result:
TelePresence attendees hear the audio of
the previous meeting.

This may be a pretty well understood
circumstance for customers due to the
way TSP Audio works.

e Have TelePresence recite audio
prompt after joining the TSP audio.
“Cisco Telepresence is now in the
audio conference” (or similar)

Note  Using API method does not

resolve this.

TelePresence joins audio of host’s
previously scheduled meeting where the
host had exited with the “keep audio
conference running” option.

Similar to the above scenario - the host
may have left the first meeting but used
the “keep audio conference open”
choice. Thus, as the audio conference of
the first meeting continues,
TelePresence eventually dials in.

This may be a pretty well understood
circumstance for customers due to the
way TSP Audio works.

e Have TelePresence recite audio
prompt after joining the TSP audio.
“Cisco Telepresence is now in the
audio conference” (or similar).

Note  Using API method does not

resolve this.
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Table 12-4

Problems with a TSP Meeting (continued)

Problem or Message

Possible Causes

Recommended Action

“Host private conference code” can
break DTMF dumb dial entry method in
some cases (dial in as host + host has
already dialed in).

If the TSP has implemented a “host
private conference code” (where the
host uses a conference code that is not
the same as the one used by the
attendees, thus avoiding the need for the
host to enter a PIN number), the audio
prompt call flow might break the
dumb-dial of the MCU if the host has
already dialed into the conference. (in
our testing, this is when we heard all the
foreign language prompts from the TSP
bridge - it was the bridge barking about
the fact that the host conf code is already
in use).

e Use API method....or...

e Advice to TSP partners: If using a
“hosts' private conference code”,
then consider allowing the TSP
audio bridge to tolerate a second
user dialing in using the host private
conference code.

MCU/TelePresence server is unable to
dial out.

PSTN calls may not be configured to

pass through a PSTN gateway to WebEx.

Outbound dialing from VCS may not be
properly configured.

e Configure calls to pass through a
PSTN Gateway to WebEx.

e Verify the outbound dialing
configuration for VCS and
MCU/TelePresence Server.
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Table 12-4

Problems with a TSP Meeting (continued)

Troubleshooting Tips

Problem or Message

Possible Causes

Recommended Action

Dial sequence cannot be issued on the
fly via TSP API (unlike NBR).

The dial sequence for OT 2.0 integration
with TSPs is only statically configurable
in the Telephony Domain of site. This
restricts a TSP somewhat, in case they
might have different audio bridge
infrastructures, different dial in
numbers, etc.

NBR, by contrast, allows for the static
configuration as well as a dynamic
configuration. The dynamic
configuration is done by having the
partner TSP Adapter send WebEx the
NBR dial string at the time of meeting
start via
A2W_RspCreateConference[ NBRPhon
eNumber].

e Change the MCU logic, so that it
starts the WebEx meeting and then
collects the dial in string from
WebEx at that time. The sequence
will allow for WebEx to collect the
dial string dynamically from the
TSP as follows:

1. TelePresence starts
TelePresence meeting.

2. TelePresence starts WebEx
meeting.

3. WebEx sends
W2A_CreateConference to
TSP.

4. TSP sends
A2W_RspCreateConference to
WebEx (this would contain the
TP dial string).

5. WebEx sends dial string to
MCU.

6. MCU dials into the TSP bridge.

The TSP API and TSP Server would
need to change (among other
components, of course).

The TSP Audio account info, used by
the MCU dial string, is obsolete.

Since the MCU collects and stores the
TSP dial string at the time of meeting
schedule, to be used at the time of
meeting start (which can be many weeks
later), there is a possibility that the dial
string will be obsolete and hence the call
into the TSP conference will fail. This
will happen if the default (first) TSP
Audio account is changed during the
time between TelePresence meeting
schedule and TelePresence meeting
start.

e The above suggestion will solve this
problem (making the TelePresence
equipment collect the TelePresence
dial string from WebEx at the time
of meeting start, instead of at the
time of meeting schedule.

Problems with TelePresence Server and MCU

This section describes possible issues with a meeting caused by TelePresence Server and MCU.

Refer to troubleshooting information in Table 12-5 to solve common problems with TelePresence Server

and MCU.
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Table 12-5 Problems with TelePresence Server and MCU

Problem or Message Possible Causes Recommended Action

MCU/TelePresence Server disconnects |WebEXx host joins a meeting while e Do not use the same WebEx host ID

shortly after connecting to WebEx. A already joined to a meeting of which to join multiple meetings at the

SIP Bye message is received from the  |they are also the host. same time.

WebEx cloud. Note  Only one WebEx Enabled
TelePresence meeting can be run
per host at a time.

Managing System Behavior

e Managing the Cisco WebEx Video View Window, page 12-10

Managing the Cisco WebEx Video View Window

A window cascading effect can occur if you plug in the presentation cable while you have your
Cisco WebEx video view panel open. To prevent this issue, close the Cisco WebEx video view
application before connecting your presentation cable to your laptop to present. If you receive a
cascading screen, simply close the video view window, as shown in Figure 12-1.

Figure 12-1 Cascading Cisco WebEx Video View Window
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I
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